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1 Product overview

This chapter presents an overview of the hardware components of the HP xw8600 Workstation,
including the following topics:

● Product features on page 1

● Workstation specifications on page 7

● ENERGY STAR Qualification on page 10

● Dual- and quad-core processors on page 11

● HP Cool Tools on page 12

Product features
The following sections describe the HP xw8600 Workstation system board architecture and
components.
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System board architecture
The following figure shows the HP xw8600 Workstation system board block diagram.

Figure 1-1  System board block diagram

Workstation components
The following figure shows the components of a typical HP xw8600 Workstation. Drive configurations
can vary.
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For information about supported spare parts, see http://partsurfer.hp.com.

Figure 1-2  Typcal workstation components view

Table 1-1  Component view

Item Description Item Description

1 PCI card support 10 Memory modules

2 Power supply 11 Card guide/front fan (fan optional)

3 Processor heatsinks 12 Graphics card

4 Processors 13 Optical drive*

5 System and memory fans 14 PCI Express card

6 Side access panel 15 Diskette drive

7 System board 16 PCI card

8 Chassis 17 Hard drive

9 Front bezel

* A DVD is an example of an optical drive.
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Front panel components
The following figure shows the front panel components of a typical HP xw8600 Workstation. Drive
configurations can vary.

Figure 1-3  Front panel components

Table 1-2  Front panel components

Item Symbol Description Item Symbol Description

1  Optical drive 8 Headphone

2  Secondary drive bays (3 total) 9 USB 2.0 (2)

3  Diskette drive (optional) 10 Hard drive activity light

4  Diskette drive activity light 11 Power button

5  Diskette drive eject button 12  Power on light

6 IEEE-1394a connector 13  Optical drive activity light

7 Microphone 14  Optical drive eject button
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Rear panel components
The following figure shows the rear panel components of a typical HP xw8600 Workstation.

Figure 1-4  Rear panel components

NOTE: The rear panel connectors are labeled with industry-standard icons and colors to assist you in
connecting your peripheral devices.

Table 1-3  Rear panel components

Item Symbol Description Item Symbol Description

1  Power cord connector 11  Graphics connector

2  Power supply Built-In Self Test (BIST)
LED

12 Audio line-in connector (blue)*

3 PS/2 keyboard connector 13 RJ-45 network connector

4 USB 2.0 14 RJ-45 network connector

5 Serial connector (blue-green) 15 PS/2 mouse connector (green)

6 IEEE-1394 16  Cable lock slot

7 USB 2.0 (4) 17  Padlock loop

8 Microphone connector (pink) 18  Universal chassis clamp lock opening

9 Audio line-out connector (green)* 19  Access panel key loop
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Item Symbol Description Item Symbol Description

10  MiniSAS 4–port connector (optional)    

* HP does not support external audio cables that are longer than three meters.

Serial number and COA label location
As shown in the following figure, each workstation has two serial number labels (1 and 2) and a
Certificate of Authentication (COA) label (2) for Microsoft® Windows® preinstalled systems only. The
serial number labels can usually be found on the top panel or on the side or rear of the workstation.
Keep this number available when contacting customer service for assistance.

Figure 1-5  Location of serial number and COA label

Maximizing airflow
● Keep your workstation in an area where airflow is not obstructed.

● Keep the workstation off from surfaces where dust can gather.

Table 1-3  Rear panel components (continued)
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● Remove dust on the front panel (vent area) and the rear fans with a small vacuum, compressed
air, or dust rag.

● Keep the front and back of the workstation at least 0.15 m (6 in.) away from a wall or other
obstruction as shown in the following figure.

Figure 1-6  Maintain proper clearance

Workstation specifications
The following table lists the physical characteristics of the HP xw8600 Workstation.

Weight (Typical configuration) 14.4-19.4 kg (31.7-42.7 lb.)

Chassis Dimensions Height: 441 mm (17.4 in.) Width: 165 mm (6.5 in.)  Depth: 440 mm (17.3 in.)

80 Plus power supplies
Two 80 Plus® power supplies—800W and 1050W—are available in the HP xw8600 Workstation. Both
are compatible with ENERGY STAR requirements. This section describes the power supplies and lists
their specifications.

Table 1-4  Power supply source voltages

Source voltage Description

+3.3V PCI, PCIe, audio, clocks, chipset, super I/O, BIOS ROM, IEEE1394, SAS
controller, and onboard logic

+5V Storage (hard drive, optical drive, diskette drive), PCI, PCIe, chipset, audio,
keyboard/mouse, USB, and IEEE1395

+12 V-CPU0 Input to onboard regulator that supplies power to CPU0 and CPU0 fan

+12 V-CPU1 Input to onboard regulator that supplies power to CPU1 and CPU1 fan

+V12 V-M Input to onboard regulator that supplies power to memory and system fans

+12 V-B PCI, PCIe, and system fans

+12 V-D Storage (hard drive, optical drive, diskette drive), and input to onboard
regulator that supplies power to riser memory (1050W only)
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Source voltage Description

+12 V-G/G1 PCI Express auxillary connector on 800W and 1050w power supplies

+12 V-G2 Second PCI Express auxilliary connector on 1050W power supply

+12 V-R Input to onboard regulator that supplies power to Riser Memory (1050W
power supply only)

+12 V-N PCI and serial ports

+5 V-SB Sleep circuitry

Table 1-5  Maximum current per rail

Voltage rail 800W maximum
continuous current

1050W maximum
continuous current

+3.3V 22.0A 22.0A

+5V 18.0A 18.0A

+12 V-CPU0 18.0A 18.0A

+12 V-CPU1 18.0A 18.0A

+V12 V-M 18.6A 18.0A

+12 V-B 18.0A 18.0A

+12 V-D 18.0A 18.0A

+12 V-G/G1 18.0A 18.0A

+12 V-G2 N/A 18.0A

+12 V-R N/A 18.0A

+12 V-N 0.30A 0.30A

+5 V-SB 3.0A 9.0A

CAUTION: For 800W and 1050W power supplies, do not exceed 150 watts of 3.3V and 5V power
combination.

For the 800W power supply, do not exceed 64.0 amps (768 watts) of 12-volt (CPU0/CPU1/M/B/D/G)
power combination.

For the 1050W power supply, do not exceed 84.0 amps (1008W) of 12V (CPU0/CPU1/M/B/D/G1/G2/
R) power combination.

Do not exceed 800 watts (for the 800W power supply) or 1050 watts (for 1050W power supply) of total
continuous output power.

Power supply specifications
Table 1-6  Power supply specifications

Item Description

Power supply 800W

Wide Ranging, Active PFC

1050W

Wide Ranging, Active PFC

Table 1-4  Power supply source voltages (continued)
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Item Description

Operating voltage range 90 – 269 VAC 90 – 269 VAC

Rated voltage range 100–240 VAC 118 VAC 100–240 VAC 118 VAC

Rated line frequency 50–60 Hz 400 Hz 50–60 Hz 400 Hz

Operating line frequency range 47–66 Hz 393–407 Hz 47–66 Hz 393–407 Hz

Rated input current 10A @ 100-127 VAC

6A @ 200–240 VAC

9.5A @ 118 VAC 13.2A @ 100-127 VAC

6.6A @ 200–240 VAC

12.0A @ 118 VAC

Heat dissipation

(Configuration and software
dependent)

Typical 1530 BTU/hr = (386 kg-cal/hr)

Maximum 2027 BTU/hr = (511 kg-cal/hr)

Typical 3136 BTU/hr = 791kg-cal/hr)

Maximum 4480 BTU/hr = 1129 kg-cal/hr)

Power supply fan 92x32 mm variable speed 92x32 mm variable speed

80 Plus compliant 80 Plus compliant and compatible with ENERGY STAR qualified configurations.

FEMP Standby Power compliant
@115V (<2W in S5 – Power Off)

Yes No

Power Consumption in sleep
mode (as defined by ENERGY
STAR) - Suspend to RAM (S3)
(Instantly Available PC)

<20 watts <25 watts

Power consumption and heat dissipation
Power consumption and heat dissipation specifications are available for multiple 800W and 1050W
power supply configurations. To review available specifications, see http://www.hp.com/go/
quickspecs.

To reach zero power consumption, unplug the workstation from the power outlet or use a power strip
with an on/off switch. For additional information about power-saving features, see your operating system
documentation.

This product is in compliance with U.S. Executive Order 13221.

System fans
This workstation includes:

● one rear system fan

● one processor heatsink fan

● one power supply fan

● one memory fan

● one memory controller heatsink fan

In addition, an optional front system fan is available for special environments, and some graphics cards
include onboard fans.

There is one fan per processor heatsink for a standard CPU heatsink, and two fans per processor for a
high performance CPU heatsink.

Table 1-6  Power supply specifications (continued)
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Resetting the power supply
If an overload triggers the power supply overload protection, power is immediately disconnected. To
reset the power supply:

1. Disconnect the power cord from the workstation.

2. Determine what caused the overload and fix the problem. For troubleshooting information, see
System diagnostics and troubleshooting on page 113.

3. Reconnect the power cord and reboot the workstation.

When you power off the workstation through the operating system, power consumption falls below what
is considered low power consumption but does not reach zero. This low power consumption feature
extends the life of the power supply.

Environmental specifications
The following table lists the environmental specifications of your workstation.

Temperature

Operating: 5 to 35°C (40 to 95°F)

Non-operating: -40 to 60°C (-40 to 140°F)

NOTE: Derate by one degree C (1.4 degrees F) for every 305m (1,000 ft.)
altitude over 1,524m (5,000 ft.).

Humidity
Operating: 8 to 85% RH, non-condensing

Non-operating: 8 to 90% RH, non-condensing

Altitude
Operating: 0 to 3,048m (10,000 ft.)

Non-operating: 0 to 9,144m (30,000 ft.)

Shock

Operating: ½-sine: 40g, 2-3ms

Non-operating:

● ½-sine: 160 cm/s, 2-3ms (~100g)

● square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive
shock events.

Vibration

Operating random: 0.5g (rms), 5-300 Hz

Non-operating random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.

ENERGY STAR Qualification
HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S.
Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA
ENERGY STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, Hewlett-
Packard Company has determined the products marked with the ENERGY STAR logo are ENERGY
STAR qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo
appears on all ENERGY STAR qualified computers.
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The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way
products achieve this energy efficiency is by reducing power consumption when not being used through
the Microsoft Windows Power Management feature.

The Power Management feature enables the workstation to enter a low-power (or “sleep”) mode after
a period of inactivity. When used with an external monitor that is ENERGY STAR qualified, this feature
also supports the similar power management features of the external monitor.

To take advantage of this energy savings:

● The Power Management feature has been preset to suspend the workstation to a sleep state after
30 minutes of inactivity.

● The Power Management feature has been preset to suspend the monitor to a sleep state after 15
minutes of inactivity.

Both the computer and monitor can be woken from sleep mode through user interaction with any of the
computer input devices (mouse, keyboard, and so on). when configured with Wake On LAN (WOL)
enabled, the workstation can also be woken by a network signal.

See the EPA ENERGY STAR Power Management Web site for more information about the energy and
financial savings potential of the Power Management Feature: http://www.energystar.gov/
powermanagement.

See the EPA ENERGY STAR Web site for more information about the ENERGY STAR program and
its environmental benefits: http://www.energystar.gov.

CAUTION:  Using the Energy Save Monitor feature with monitors that are not ENERGY STAR qualified
can cause video distortion when an Energy Save timeout occurs.

NOTE:  ENERGY STAR is not supported on Linux workstations.

If it is necessary to restore the operating system, you must also reset the ENERGY STAR settings (if
applicable) after the restore.

To verify the factory default power settings for your workstation, select Start>Control Panel, and then
double-click Power Options.

Dual- and quad-core processors
This HP Workstation supports dual- and quad-core processors that provide two or four true processors
in a single socket. Dual- and quad-core processors are better at handling the load of multithreaded
applications (such as rendering images in Digital Content Creation) and highly multitasked environments
(such as running several productivity applications while listening to music).

ENWW Dual- and quad-core processors 11
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HP Cool Tools
An HP Workstation with Windows XP includes additional software that is not installed when you first
boot your system. Additionally, a number of preinstalled tools on your workstation can enhance your
workstation experience. To access or learn more about these applications:

1. Open the HP Cool Tools folder by selecting Start>All Programs>HP Cool Tools.

2. Select the HP Cool Tools icon on the desktop.

3. To learn more about these applications, select HP Cool Tools—Learn More.

4. To install or launch the applications, select the appropriate application.

NOTE:  In preinstalled Vista, there is no icon, shortcut, or folder, but several of the tool programs are
included, such as Performance Tuning Framework.
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2 Configuring and restoring the operating
system

This chapter describes how to install and restore the operating system and includes the following topics.

● Setting up Microsoft Windows Vista Business software on page 13

● Setting up Microsoft Windows XP Professional on page 16

● Protecting your software on page 20

● HP software on your workstation on page 20

● Setting up Red Hat Linux on page 20

If your workstation includes a preinstalled operating system, it is configured the first time you power on
the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is installed. Adding hardware might cause errors and prevent the operating system
from installing correctly.

Setting up Microsoft Windows Vista Business software
This section describes how to install and restore Microsoft Windows Vista® Business on your
workstation.

Configuring the Windows Vista Business operating system
This section describes how to configure the Windows Vista Business operating system on your HP
workstation.

Configuring the software
When you power on the workstation, the operating system is configured. Configuration takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the
configuration.

CAUTION: After configuration begins, do not power off your workstation until the process is complete.
Powering off your workstation can damage the software that runs the system.

If it is necessary to reinstall the operating system, see the operating system documentation included
with your workstation. Additional information is available from the online help tool after you configure
the operating system.

Selecting a language
When the preinstalled operating system is first booted, you might be prompted to select a language for
the operating system. After selecting the language, read and follow the instructions on the screen
to complete the installation. This process might take a while, depending on the system hardware
configuration and language choice. During the process, do not power off your workstation unless you
are prompted to do so.
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After you select a language during the initial boot of the operating system, the language is locked on
the hard drive. If you restore the system using HP Backup and Recovery, only the previously selected
language can be installed. If you use RestorePlus!, the DVD searches for the language stored on the
hard drive and restores only the original preinstalled language. If a new hard drive is installed or no
language is found on the disk, RestorePlus! installs any language requested.

Creating recovery disks
For details about creating recovery disks using the HP Backup and Recovery process, see Restoring
the Windows Vista Business operating system on page 14.

Installing or upgrading device drivers
To install hardware devices after the operating system is installed, you must install the appropriate
device drivers before you install the devices. In addition, for optimum performance, your operating
system must have the most recent updates, patches, and software fixes. For additional driver and
software update information, consider the following resources:

● The Microsoft Web site provides updates for your operating system, including current patches and
software fixes.

● Device drivers are provided on CDs supplied with peripheral devices.

● Some peripheral device drivers developed for Windows XP or Vista might not be included with your
workstation. Current device drivers are available at http://www.hp.com/support/
workstation_swdrivers.

● Driver installation and workstation operation documentation is available at http://www.hp.com/
support/workstation_manuals/.

Restoring the Windows Vista Business operating system
There are several methods to restore the Windows Vista Business operating system on your workstation
to a near-factory state, or to the state of the system at a predefined restore point. Your workstation has
a recovery partition on the system hard drive that contains the software and data required for the restore
process described in the following sections.

If you must restore the operating system with Windows Vista Business Original Equipment Manufacturer
(OEM) DVDs (that is, if you install without using Restore Plus!), you must activate Vista after it is installed.

For activation, you need a 25-character PID (Product ID)—the one on the Microsoft COA sticker does
not work. To obtain a valid PID, you must call Microsoft and provide your Stock Keeping Unit (SKU)
number.

The SKU information is listed on the service tag. It appears as the OS product number in the lower right
hand portion of the tag in this format: “OS: XXXXXXX,” where “XXXXXXX” is the OS product number.

Using the HP Backup and Restore process
You can reinstall the Windows operating system and device drivers (for devices included with the
system) using the HP Backup and Restore (HPBR) process, from either a DVD or from the recovery
partition on your system hard drive.

To launch the HPBR, slect Start>All Programs>HP Backup & Recovery>HP Backup and Recovery
Manager.

14 Chapter 2   Configuring and restoring the operating system ENWW

http://www.hp.com/support/workstation_swdrivers
http://www.hp.com/support/workstation_swdrivers
http://www.hp.com/support/workstation_manuals/
http://www.hp.com/support/workstation_manuals/


Creating system recovery DVDs or CDs

You can create a set of system recovery DVDs or CDs if you have a writable optical drive. After launching
the HP Backup and Restore Manager, you can create International Standards Organization (ISO)
images of the factory image, or you can write them directly to CD or DVD. You can also create a
supplemental HP Backup and Recovery Manager CD. (You might need to create additional CDs
depending on the options you purchased.) You can also move CD images to another location, such as
a network share, or to be copied to a DVD or CD at a later time or from another system.

Restoring from HPBR DVDs or CDs

To start the system recovery process, boot from the DVD or CD you created, then carefully follow the
online instructions.

Restoring from the recovery partition

To start the HPBR system restore process from the Recovery Manager, follow these steps:

1. Boot the workstation.

2. When prompted on the boot splash screen to enter the Recovery Manager, press F11.

3. Follow the prompts to restore the system to factory-like condition.

Reclaiming hard drive space from the recovery partition
To free up hard drive space, you can remove only the recovery partition, or you can completely uninstall
the HP Backup and Recovery Manager application.

CAUTION: If you remove the recovery partition:

– The F11 Emergency Recovery function becomes unavailable.

– The ability to recover the system is lost.

– Recovery images in the recovery partition are deleted.

– The ability to create a recovery media set is lost.

CAUTION: If you uninstall the HP Backup and Recovery Manager application, emergency recovery
and data backup and recovery can no longer be performed.

● Removing only the recovery partition—You can remove the recovery partition by selecting
Remove HP Recovery Partition from the HP Backup and Recovery program folder. When the
HP Recovery Partition is removed, the recovery partition is deleted, the user partition is extended
to reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

● Uninstalling the HP Backup and Recovery Manager application—You can uninstall the HP
Backup and Recovery Manager application using the Programs and Features utility under Windows
Control Panel>Programs and Features. When the application is uninstalled, the recovery partition
is deleted, the user partition is extended to reclaim the unused space, and the F11 boot prompt is
removed. After the application is uninstalled, emergency recovery and data backup and recovery
can no longer be performed.

CAUTION: Deleting the recovery partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

Ordering backup software
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If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from the HP
support center. To obtain the support center telephone number for your region:

1. Before calling HP to order the software, have your workstation serial number available.

2. Go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

3. Select your region.

4. Under the Call HP heading, select Technical support after you buy.

Transferring files and settings using Windows Easy Transfer
Windows Easy Transfer, a Microsoft data migration tool, provides a guide that helps you choose the
files and data to transfer from another Windows computer to your Windows Vista Business workstation
and explains how to transfer it. You can use one of the following methods to migrate data:

● Network—Use when the source computer and your workstation are connected to the same
network.

● Easy Transfer cable—Use this specially designed USB cable to connect the source computer to
your workstation. Although an Easy Transfer cable is not a standard USB cable, it is commonly
available from local electronics suppliers.

● DVDs or CDs—Use if you have writeable DVD or CD drives on the source computer and your
workstation.

● USB flash drive or an external hard drive—Use to access the source computer and your
workstation.

To use the Windows Easy Transfer tool, select Start>All Programs>Accessories>System
Tools>Windows Easy Transfer.

For more information about using Windows Easy Transfer, see http://www.microsoft.com/windows/
products/windowsvista/features/details/easytransfer.mspx.

Setting up Microsoft Windows XP Professional
This section describes how to configure and restore Microsoft® Windows XP™ Professional on your
workstation.

Configuring Windows XP Professional
This section describes how to configure Windows XP on your workstation.

When you first power on the workstation, the operating system is configured. Configuration takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the
configuration.

CAUTION: After configuration begins, do not power off your workstation until the process is complete.
Powering off your workstation can damage the software that runs the system.

If it is necessary to reinstall the operating system, see the operating system documentation included
with your workstation. Additional information is available from the online help tool after you configure
the operating system.
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Selecting a language
When the preinstalled operating system is first booted, you might be prompted to select a language for
the operating system. After selecting the language, read and follow the instructions on the screen
to complete the installation. This process might take quite a while, depending on the system hardware
configuration and the language choice. During the process, do not power off your workstation unless
you are prompted to do so.

After you select a language during the initial boot of the operating system, the language is locked on
the hard drive. If you restore the system using HP Backup and Recovery, only the previously selected
language can be installed. If you use RestorePlus!, the DVD searches for the language stored on the
hard drive and restores only the original preinstalled language. If a new hard drive is installed, or no
language is found on the disk, RestorePlus! installs any language requested.

Creating recovery disks
For details about creating recovery disks using the HP Backup and Recovery process, see Restoring
the Windows XP Professional operating system on page 17.

Installing or upgrading device drivers
To install hardware devices after the operating system is installed, you must install the appropriate
device drivers before you install the devices. In addition, for optimum performance, your operating
system must have the most recent updates, patches, and software fixes. For additional driver and
software update information, consider the following resources:

● The Microsoft Web site provides updates for your operating system, including current patches and
software fixes.

● Device drivers are provided on CD supplied with peripheral devices.

● Some peripheral device drivers developed for Windows XP or Vista might not be included with your
workstation. Current device drivers are available at: http://www.hp.com/support/.

● For documentation on installing drivers and workstation operation, see http://www.hp.com/support/
workstation_manuals/.

Restoring the Windows XP Professional operating system
There are several methods to restore the Windows XP operating system on your workstation to a near-
factory state, or to the state of the system at a predefined snapshot in time. Your workstation has a
recovery partition on the system hard drive that contains the software and data required for the restore
process as described in the following sections.

The RestorePlus! process
You can reinstall the Windows operating system and device drivers (for devices included with the
system) using the RestorePlus! process. Some application software might not be restored using this
process. If software is not restored, install it from the appropriate application DVD. You can use the
RestorePlus! process from a DVD or the recovery partition on your system hard drive.

CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive,
including all partitions. If you run RestorePlus! from the recovery partition, only the root (C:) partition is
affected.
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Creating a RestorePlus! DVD

You can create a set of the system recovery DVDs if you have a writable optical drive. When you first
boot the workstation, you are prompted to create DVDs for RestorePlus!, the Windows operating system,
and a supplemental HP Backup and Recovery Manager. (There might be additional DVDs you can
create depending on the options.) You can also move DVD images to another location, such as a
network share, to be copied to DVD at a later time, or from another system.

Restoring from RestorePlus! DVDs

Boot from the RestorePlus! DVD to start the RestorePlus! process.

Restoring from RestorePlus! on the recovery partition

To start the RestorePlus! process from the Emergency Recovery menu, follow these steps :

1. Boot the workstation.

2. When prompted to select the Emergency Recovery menu, press F11 . The F11 prompt appears
briefly during the boot process.

If you have a recovery partition but the F11 prompt is not visible:

a. To access the setup menu, press F10. (For details, see Using the Computer Setup (F10)
Utility on page 24.)

b. From the dropdown menu, select Advanced.

c. Select Power-On Options.

d. Verify that the F11 prompt is set to Displayed.

e. Verify that Factory Recovery Boot Support is set to Enabled.

f. Reboot the workstation and press F11 when prompted.

3. Ffrom the Emergency Recovery menu select Recover PC’s factory installed operating system,
drivers, utilities, and applications.

Some applications might not be restored using this method.

Reclaiming hard drive space from the recovery partition

To reclaim hard drive space, you can remove the recovery partition.

CAUTION: If you remove the recovery partition:

- The F11 Emergency Recovery function becomes unavailable.

- The ability to recover the system from data on the recovery partition is lost.

- Recovery images in the recovery partition are deleted.

- The ability to create a recovery media set is lost.

To free up hard drive space, you can uninstall the HP Backup and Recovery Manager application.
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CAUTION: If you uninstall the HP Backup and Recovery Manager application, Emergency Recovery
and data backup and recovery can noadditional software islonger be performed.

● Removing only the recovery partition—You can remove the recovery partition by selecting Remove
HP Recovery Partition from the HP Backup and Recovery program folder. When the HP Recovery
Partition is removed, the recovery partition is deleted, the user partition is extended to reclaim the
unused hard drive space, and the F11 boot prompt is removed. The HP Backup and Recovery
Manager application remains, and can be used for data backup and restore.

● Uninstalling the HP Backup and Recovery Manager application—Use Control Panel >Add or
Remove Programs for XP to uninstall the HP Backup and Recovery Manager application. When
the application is uninstalled, the recovery partition is deleted, the user partition is extended to
reclaim the unused space, and the F11 boot prompt is removed. After the application is uninstalled,
emergency recovery and data backup and recovery can no longer be performed.

CAUTION: Deleting the recovery partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

Using the HP Backup and Restore process
You can reinstall the Windows operating system and device drivers (for devices included with the
system) using the HP Backup and Restore (HPBR) process, from a DVD, CD, or the recovery partition
on your system hard drive.

To launch the HPBR, slect Start>All Programs>HP Backup & Recovery>HP Backup and Recovery
Manager.

CAUTION: Before you restore the operating system, back up your data. Data on the Windows partition
is deleted when you perform a system restore using the HPBR process. However, the recovery partition
on the system drive and other partitions are not affected.

Creating system recovery DVDs or CDs

You can create a set of system recovery DVDs or CDs if you have a writable optical drive. After launching
the HP Backup and Restore Manager, you can create International Standards Organization (ISO)
images of the factory image, or you an write them to CD or DVD. You can also create a supplemental
HP Backup and Recovery Manager CD. (You might need to create additional CDs depending on the
options you purchased.) You can also move CD images to another location, such as a network share,
or to be copied to a DVD or CD at a later time or from another system.

Restoring from HPBR DVDs or CDs

To start the system recovery process, boot from the DVD or CD you created, then follow the online
instructions.

Restoring directly from the recovery partition

To start the HPBR system restore process from the Recovery Manager, follow these steps:

1. Boot the workstation.

2. When prompted on the boot splash screen to enter the Recovery Manager, press F11.

3. Follow the prompts to restore the system to factory-like condition.

Ordering backup software
If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from the HP
support center. To obtain the support center telephone number for your region:
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1. Have your workstation serial number available before calling HP to order the software.

2. Go to http://www.hp.com/support/contactHP.

3. Select your region.

4. Under the Call HP heading, select Technical support after you buy.

Protecting your software
To protect your software from loss or damage, keep a backup copy of system software and related files.
For instructions on making backup copies of data files, see the operating system or backup utility
documentation.

HP software on your workstation
The following HP software might be installed on your workstation, depending on the operating system
and options purchased:

● Computer Setup (F10) Utility and diagnostics

● HP support software, including device drivers

● Security management tools (optional)

● Software support management tools

Additional software is available for download:

● HP Client Manager Software is available at .

● System Software Manager is available at .

In some situations, additional HP software might be required

Setting up Red Hat Linux
This section describes how to install and restore the Red Hat Linux operating system on your
workstation.

Linux preinstalled workstations
With Linux preinstalled, follow the instructions in this section to set up your operating system and
software.

After the boot process is complete, you can view additional HP Linux documentation by opening your
browser. The browser is set to use the local HP documentation page as its default. You can also access
Linux links for Red Hat by using your browser.

For additional information about setting up Linux-preinstalled or Linux-enabled workstations, see the
HP User Manual for Linux at http://www.hp.com/support/linux_user_manual.

For more information about HP and Linux, see http://www.hp.com/linux.

Starting the Linux operating system
The first time you boot your workstation, the Red Hat First Boot utility appears. This program enables
you to enter your password, network, graphics, time, and keyboard settings for your workstation.
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CAUTION: After the automatic installation begins, do not power down your workstation until the
process is complete. Powering down your workstation during the installation might damage the software
that runs your workstation or prevent its proper installation.

When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you might get a blank
screen for 15–30 seconds after you select and save your settings and exit the utility. This behavior is
expected. The boot process continues its execution after the screen returns.

Restoring the Linux operating system on preloaded workstations
The HP Driver CD and Red Hat Enterprise Linux (RHEL) restore media are required to restore the Linux
operating system. Download the most recent HP Driver CD to obtain enhancements.

NOTE: Linux does not support mixed drive types in a manufacturing preload. When you restore the
operating system, mixed drive types can be handled with the restoration media.

Creating restore media

HP Red Hat Enterprise Linux includes a Red Hat ISO icon on the desktop. You can click this icon to go
to the /iso directory. The /iso directory contains all iso images used to preload your workstation.

To recover or restore the original image, follow the instructions in the readme file in the /iso directory to
copy the ISO image file onto CDs.

NOTE: Make copies of the ISO recovery images on CD as backup files in case your workstation
experiences a hard drive failure.

The /iso directory also contains an ISO image of the HP Driver CD used to create your preloaded system.
You can use this version or download the latest version from the HP Website.

Downloading the latest HP driver CD contents

To download the latest HP Driver CD:

1. Go to http://www.hp.com and select Software and Drive Downloads.

2. Locate your workstation and operating system.

3. Select your driver CD and then follow the directions under the Release Notes.

Reinstalling the factory Linux image with the HP driver CD

1. Boot your workstation from the Red Hat box set, Binary CD 1.

2. When prompted, insert the Linux operating system restore media CDs.

3. Continue following the prompts until the operating system is installed.

4. Configure the X server to start on reboot.

5. Reboot your workstation.

6. Follow the onscreen prompts to set up your system with the Red Hat First Boot utility.

7. When prompted by First Boot to add CDs, insert the HP Driver CD into the drive on your workstation.

8. Select Install next to Additional CDs.

The HP Driver CD window opens.

9. To begin the installation, select Press to continue.
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When installation is complete, you are given two options: Reboot now... (on the left side), and
Press to continue, reboot later... (on the right side).

10. Select Reboot now...

Upgrading device drivers
To upgrade a Linux device driver, see http://www.hp.com/support/workstation_swdrivers.

Linux-enabled workstations
Linux-enabled workstations do not have Linux preinstalled, nor do they include installation media for a
Linux distribution. To install Linux, you must have the installation binary set for a Linux distribution (CD
or DVD media, or a version on your network), and the HP Installer Kit for Linux.

The installer kit includes the HP CDs necessary to complete the installation of all versions of the
distribution box set that are supported by HP workstation hardware.

To determine which versions are supported on your workstation, see the Linux hardware support matrix
at http://www.hp.com/support/linux_hardware_matrix.

To use the drivers in the HP Installer kit for Linux other than RHEL, you must manually extract the drivers
from the HP Driver CD and install them. HP does not test the installation of these drivers on other Linux
distributions, nor does HP support this operation.

Verifying hardware compatibility
To determine which Linux versions are supported on your HP workstation hardware:

1. See http://www.hp.com/support/linux_hardware_matrix.

2. Select your HP workstation model.
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3 System management

This section describes the tools and utilities that provide system management for your workstation and
includes the following topics:

● The Computer Setup (F10) Utility on page 23

● Workstation management on page 31

The Computer Setup (F10) Utility
The Computer Setup (F10) Utility enables you to:

● Change factory default settings and set or change the system configuration, which might be
necessary when you add or remove hardware.

● Determine if all devices installed on the workstation are recognized by the system and functioning.

● Determine information about the operating environment of the workstation.

● Solve system configuration errors that are detected but not fixed during the Power-On Self-Test
(POST).

● Establish and manage passwords and other security features.

● Establish and manage energy-saving time-outs (not supported on Linux platforms).

● Modify or restore factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Set PCIe lane allocation between Slot four and Slot five.

● Modify the boot order of installed mass storage devices such as SATA, SAS, diskette drives, optical
drives, network drives, and LS-120 drives.

● Configure the boot priority of SATA and SAS hard-drive controllers.

● Enable or disable Network Server Mode, which enables the workstation to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the system, the keyboard and mouse remain locked until the power-on password
is entered.

● Enable or disable POST Messages to change the display status of POST messages. POST
Messages suppresses most POST messages, such as memory count, product name, and other
nonerror text messages. If a POST error occurs, the error is displayed regardless of the mode
selected. To manually switch to POST Messages Enabled during POST, press any key except
F1 through F12.

● Specify an Ownership Tag, which appears when the system is powered on or restarted.

● Specify the Asset Tag or property identification number assigned by your company to this
workstation.
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● Enable power-on password prompts during system restarts (warm-boots) and power on.

● Hide or show the integrated I/O functionality, including serial, USB, or parallel ports, audio, or
embedded NIC. Hidden devices are inaccessible, which increases system security.

● Enable or disable removable media boot ability.

● Enable or disable removable media write ability (if supported by hardware).

● Replicate your system setup by saving system configuration information on CD or diskette and
restoring it on workstations.

● Execute self-tests on specified SATA and SAS hard drives (if supported by the drive).

BIOS ROM
The BIOS ROM is a collection of machine language programs stored as firmware in ROM. It includes
functions such as POST, PCI device initialization, Plug and Play support, power management, and the
Computer Setup (F10) Utility. The BIOS ROM is a 1-MB Serial Peripheral Interface (SPI) port. The
firmware in the BIOS ROM supports the following systems and specifications:

● Advanced Configuration and Power Management Interface, Version 2.0

● Alert Standard Format Specification, Version 2.0

● AT Attachment 6 with Packet Interface (ATA/ATAPI – 6), Revision 3b

● ATAPI Removable Media Device BIOS Specification Version 1.0

● BIOS Boot Specification V1.01

● Standard BIOS 32-bit Service Directory Proposal

● "El Torito" Bootable CD-ROM Format Specification Version 1.0

● Enhanced Disk Drive Specification Version 1.1

● BIOS Enhanced Disk Drive Specification Version 3.0

● Enhanced Host Controller Interface Specification for Universal Serial Bus, Revision 1.0

● PCI Local Bus Specification, Revision 2.3

● PCI Power Management Specification, Revision 1.1

● PCI Express Base Specification, Revision 2.0

● Serial ATA Specification, Revision 1.0a

● Serial ATA II: Extensions to Serial ATA 1.0, Revision 1.0

● System Management BIOS Reference Specification, Version 2.5

● PC SDRAM Serial Presence Detect (SPD) Specification, Revision 1.2B

● TCG TPM Specification Version 1.2

● Universal Host Controller Interface Design Guide, Revision 1.1

● Universal Serial Bus Revision 1.1 Specification

● Universal Serial Bus Revision 2.0 Specification

Using the Computer Setup (F10) Utility
You can only open the Computer Setup (F10) Utility by powering on or restarting the workstation.
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To access the Computer Setup (F10) Utility menu:

1. Power on or restart the workstation.

2. As soon as your display is active and F10=Setup appears in the lower right corner of the screen,
press F10.

If you do not press F10 at the appropriate time, try again. Turn the workstation off, then on, and
press F10 again to access the utility. You can also press the Ctrl + Alt + Delete keys before boot
if you miss the opportunity to press F10.

3. Select your language from the list and press the Enter key.

In the Computer Setup (F10) Utility menu, five headings are displayed: File, Storage, Security,
Power, and Advanced.

4. Use the left and right arrow keys to select the appropriate heading, use the up and down arrow
keys to select an option, and then press Enter.

5. Choose from the following:

● To apply and save changes, select File>Save Changes, and then select F10=YES.

● To remove changes you have made, select Ignore Changes and then select F10=YES.

● To reset to factory settings, select  File>Default setup>Restore Factory Settings as
Default. Press F10 to accept the changes, and then select Apply Defaults and Exit. This
restores the original factory system defaults.

CAUTION: Do not power off the workstation while the ROM is saving your Computer Setup (F10)
Utility changes because the Complementary Metal-Oxide Semiconductor (CMOS) could become
corrupted. After you exit the F10 Setup screen, you can disconnect power from the workstation.

The Computer Setup (F10) Utility menu
NOTE: With new BIOS releases, the following content is subject to change so your menu might be
different than shown.

Table 3-1  Computer Setup (F10) Utility menu descriptions

Heading Option Description

File System
Information

Displays the following system characteristics:

● Product Name

● SKU Number

● Processor Type/Speed/Stepping

● Cache Size (L1/L2)

● Installed Memory Size

● Integrated MAC 1 and 2

● System BIOS

● Boot block date

● Chassis Serial Number

● Asset Tracking Number

 About Displays copyright information.
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Heading Option Description

System
Temperatures

Displays system temperatures for CPU0 and CPU1, and fan speeds for processors, memory,
chipsets, chassis, and PCI cards.

 Set Time and
Date

Enables you to set system time and date.

 Flash System
ROM

Enables you to upgrade the BIOS from a ROM image on diskette, CD, or USB.

 Replicated
Setup

Provides these options:

● Save to Removable Media—Saves the system configuration, including CMOS, in the
qsetup.txt file. This file can be saved to a formatted, blank 1.44-MB diskette, or to a USB
device.

● Restore from Removable Media—Restores the system configuration from a diskette or a USB
device.

 Default Setup Provides these options:

● Save Current Settings as Default—Saves the current settings as default settings for the next
operation.

Restore Factory Settings as Default—Restores the factory settings as the default settings for
the next operation.

 Apply Defaults
and Exit

Restores the default settings defined in Default Setup.

 Ignore Changes
and Exit

Exits computer setup without applying or saving changes.

 Save Changes
and Exit

Saves changes to system configuration and exits the computer setup.

Storage Device
Configuration

Lists installed non-SCSI storage devices (except SATA devices) and provides options for obtaining
specific information about each device:

● Hard Disk—Provides information about the hard drives in the system.

● CD-ROM—Provides information about the optical drives in the system.

● Diskette Type (for legacy diskette drives only)—Identifies the highest capacity media type
accepted by the diskette drive. Options are 3.5" (1.44 MB), 5.25" (1.2 MB), and Not Installed.

● Default Values—Resets devices to their default configuration (SATA is the default).

◦ Multisector Transfers—Defines the transfer of data per interrupt. Options are 8, 16, and
Disable (16 is the default).

◦ Transfer Mode—Specifies the active data transfer mode. Options (subject to device
capabilities) are Max UDMA, PIO 0, Max PIO, Enhanced DMA, and Ultra DMA0. (Max
UDMA is the default).

◦ Translation Mode—Enables the BIOS to determine the translation mode used to
configure a formatted SATA or USB mass storage device. This prevents you from
needing to know how the mass storage device was formatted. Options are Automatic,
Bit Shift, LBA Assisted, Use (Cylinders, Heads, Sectors), and Off. Automatic is the
default.

Ordinarily, you should not change the translation mode selected by the BIOS. If the
selected translation mode is not compatible with the translation mode that was active
when the drive was partitioned and formatted, the data on the disk is inaccessible.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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 Storage Options Provides these options:

● Removable Media Boot—Enables and disables the ability to boot the system from removable
media.

● Legacy Diskette Write—Enables and disables the ability to write data to removable media.

● BIOS DMA Data Transfers—Enables and disables DMA data transfers.

● SATA Emulation—Sets the SATA emulation mode with the following options:

◦ RAID + AHCI–both the RAID and AHCI OPROMs execute. This emulation mode is the
default and offers the best performance and most functionality.

◦ Separate IDE Controller–offers standard SATA supports (four ports only).

◦ Combined IDE Controller–makes the SATA controller look like an IDE controller and
offers best IDE compatibility (two ports only).

● SATA PORT0–5—enables and disables SATA ports 0–5.

● SATA/eSATA SPEED PORT4 Setup—Enables you to set the following port speeds:

◦ GEN2/3.0 Gbps (Internal Only)

◦ GEN1/1.5 Gbps (eSATA Only)

● SATA/eSATA PORT5 Setup—Enables you to set the following port speeds:

◦ GEN2/3.0 Gbps (Internal Only)

◦ GEN1/1.5 Gbps (eSATA Only)

 DPS Self-test Select a drive—Enables you to select a drive to test.

The DPS Self-test tells an IDE hard disk to go run its own internal self-test and report the results.
If the SATA controller is not in IDE emulation mode–either Separate IDE Controller or Combined
IDE Controller–the DPS Self-test option is not displayed in the Setup menu.

NOTE: This selection only appears when at least one drive capable of performing the IDE DPS
self-test is attached to the system. By default, the SATA controller is in RAID+AHCI mode, so this
option is not displayed.

 Boot Order Enables you to configure the boot, diskette drive, and hard drive orders by physically reordering
the menu entries. The following is the default boot order presented in the menu:

● Optical Drive

● Diskette Drive

● USB Device

● Hard Drive

● Broadcom Ethernet controller 1

● Broadcom Ethernet controller 2

To drag a device to a preferred place, press Enter. To remove the device from consideration as a
bootable device, press F5.

MS-DOS drive lettering assignments might not apply after an operating system other than MS-
DOS has started.

Boot devices can be disabled in the boot order process. These order changes are stored in the
physical ROM when the F10 Setup changes are confirmed with File>Save Changes and Exit.

You can temporarily override the boot order. To boot one time from a device other than the default
device specified in Boot Order, restart the workstation and press F9 when the F9=Boot Menu
message appears on the screen. After POST completes, a list of bootable devices is displayed.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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Use the arrow keys to select the preferred bootable device and press Enter. The workstation then
boots from the selected nondefault device for this one time.

Security Setup Password Enables you to set and enable a setup password for the administrator.

If you create a setup password, you must use it to change computer setup options, to flash the
ROM, and to make changes to certain Plug and Play settings under Windows.

 Power-On
Password

Enables you to set and enable the power-on password.

 Password
Options

This option becomes available when you create a setup or power-on password. It provides these
options:

● Lock Legacy Resources—Prevents the operating system from changing resources to serial,
parallel, or diskette controller.

● Network Server Mode—Enables network server mode.

● Password Prompt on Warm Boot—Enables a password prompt on a warm boot.

 Smart Cover Allows you to enable and disable the cover removal sensor, or to notify you if the sensor is activated.

 Device Security Makes the following devices available or hidden to the system:

● Serial Port

● All USB Ports

● Front USB Port

● System Audio

● IDE Controller Security

● SATA Controller Security

● IEEE 1394 Controller

● Network Controller 1

● Network Controller 2

● SAS Controller

● Embedded Security Device

 Embedded
Security Device

This option becomes available if Embedded Device is set to Available.

Embedded Security Device (Hidden or Available) turns the Trusted Platform Mechanism (TPM) on
and off. Device Hidden is the default. If this option is made available, the following options become
available:

● Power-On Authentication Support—Enables and disables an authentication feature that
requires you to enter a TPM user key password to boot the system. This feature uses the
TPM to generate and store the authentication password.

● Reset Authentication Credential—Resets the authentication functionality and clears
authentication credentials.

To enable the Embedded Security Device and to access any security features associated with the
device, you must enter a setup password.

Setting a device to Available enables the operating system to access the device. Hidden makes
the device unavailable. It is disabled by the BIOS and cannot be enabled by the operating system.

 Network Service
Boot

Enables or disables the ability to boot to the network using the F12 key or the boot order.

 System IDs Provides these options:

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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● Asset Tag—A 16–byte string identifying the system.

● Ownership Tag—An 80–byte string identifying ownership of the system. This tag appears on
the screen during POST.

● Universal Unique Identifier (UUID)—Can only be updated if the current chassis serial number
is invalid. (These ID numbers are normally set in the factory and are used to uniquely identify
the system.)

● Keyboard—Enables you to set the keyboard locale for System ID entry.

 OS Security Provides these options:

● Data Execution Prevention—Enables or disables Data Execution Prevention mode in the
processors. This mode prohibits code from running in pages that were set up as data pages,
and prevents attacks such as buffer overflows. Operating system support is required for this
feature.

● Intel Virtualization Technology (VTx)—Enables or disables Intel Virtualization Technology to
increase workstation performance.

● Intel IO Virtualization—Enables or disables Virtualization Technology to increase workstation
I/O performance.

● OS Management of Embedded Security Device—Enables or disables the ability of the
operating system to control the TPM device, including turning it on and off, initializing it, and
resetting it.

● Reset of Embedded Security Device through OS—Enables or disables the ability of the
operating system to reset the TPM.

Power OS Power
Management

Enables or disables:

● Runtime Power Management

● Idle Power Savings

● Idle Power Savings (C2 Extended)

● ACPI S3 Hard Disk Reset

● ACPI S3 PS 2 Mouse Wakeup

● USB Wake on Device Insertion

 Hardware Power
Management

Enables or disables SATA Power Management

 Thermal Enables you to set the rate of the system fan when the processor is in idle.

Advanced** Power-On
Options

Enables you to set the following:

● POST Messages—Enables or disables the splash screen during POST.

● F1 Prompt on Recoverable Errors—Enables or disables the presentation of the F1 prompt on
recoverable errors.

● F9 Prompt (Displayed or Hidden)—Selecting Displayed displays the F9=Boot Menu during
POST. Selecting Hidden prevents the text from being displayed. However, pressing F9 still
accesses the boot menu.

● F10 Prompt (Displayed or Hidden)—Selecting Displayed displays F10=Setup during POST.
Selecting Hidden prevents the text from being displayed, but pressing F10 still accesses the
Setup screen.

● F11 Prompt (Displayed or Hidden)—Selecting Displayed makes the Factory Recovery option
visible during POST. Selecting Hidden prevents the text from being displayed, but pressing
F10 still accesses the Setup screen. Factory Recovery Boot Support must be enabled to use
this option.
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● F12 Prompt (Displayed or Hidden)—Selecting Displayed displays F12=Network Service
Boot during POST. Selecting Hidden prevents the text from being displayed but pressing
F12 still forces the system to attempt booting from the network.

● Factory Recovery Boot Support (Enable or Disable)—Recovery partition hard disk drive
(HDD) option available. The Vista factory setting has this support enabled.

● Option ROM prompt* (Enable or Disable)—Enabling this feature causes the system to display
a message before loading options ROMs.

● Remote Wakeup Boot Source—Enables you to set the remote wakeup boot source as:

◦ Local Hard Drive

◦ Remote Server

● After Power Loss (On, Off, Previous State)—Enabling this option directs the previous state
to be the default.

● POST Delay (in seconds) (5, 10, 15, 20, None)—Adds a specified delay to the POST process.
This delay is sometimes needed for hard drives on some PCI cards that spin up slowly (so
slowly that they are not ready to boot by the time POST is finished). The POST delay also
gives you time to select F10 to enter the Computer Setup (F10) Utility.

● Setup Browse Mode (Enable/Disable)—Enables or disables browse mode setup.

 BIOS Power-On Enables you to disable or specify a weekday and time for BIOS power-on.

 Processors Provides these options:

● Multi Core Support (Enable or Disable)—Select a single core or multiple cores per socket.

● Limit CPUID Maximum Value to 3 (Enable or Disable)—Sets the number of allowable CPU
IDs.

 Onboard
Devices

Enables you to set resources for or disable onboard system devices such as serial ports, parallel
ports, and diskette controllers. Operating system parameters generally override Onboard Devices
settings.

 Chipset/
Memory

Provides these options:

● PCI SERR# Generation (Enable or Disable)—Controls PCI SERR# generation for ill-behaved
PCI add-in cards (that can generate SERR# spuriously).

● PCI VGA Palette Snooping (Enable or Disable)—Controls PCI VGA Palette Snooping for
compatibility purposes.

● MCH Error Handling—Sets the following signals to use on serious MCH (North Bridge) errors:

◦ SMI, which is handled by the BIOS and causes a reboot.

◦ NMI and Machne-Check Error, which are handled by the operating system and cause a
crash.

◦ Ignore.

● Memory Write Combining (Enable or Disable)—Implements special caching for rapid I/O.

● PCIe Lane Allocation (SLOT4:SOT5)—Defines the number of lanes assigned to a slot:

◦ Auto

◦ x16:x1

◦ x8:x8

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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 Device Options Enables you to set the following device options:

● Num Lock State at Power-On (On or Off)

● S5 Wake-on-LAN (Enable or Disable)

● Unique Sleep State Blink Rates (Enable or Disable)

● Monitor Tracking (Enable or Disable)

● NIC PXE Option ROM* Download (Enable or Disable)

● SAS Option ROM* Download (Enable or Disable)

● SATA RAID Option ROM* Download (Enable or Disable)

● PCIX Secondary Latency Timer:

◦ Default

◦ # PCI Clocks

● SAS Latency Timer:

◦ Default

◦ # PCI Clocks

● Peer-to-Peer Reads

● Fast Delayed Transaction Timer

 Slot 1 - PCI Slot 1 option ROM download (Enable or Disable), and latency timer.

 Slot 2 - PCIe x16 Slot 2 option ROM download (Enable or Disable).

 Slot 3 - PCIe x8
(4)

Slot 3 option ROM download (Enable or Disable).

 Slot 4 - PCIe x16
(8)***

Slot 4 option ROM download (Enable or Disable).

 Slot 5 - PCIe
x8***

Slot 5 option ROM download (Enable or Disable).

 Slot 6 - PCIe x8
(4)

Slot 6 option ROM download (Enable or Disable).

 Slot 7 - PCI-X
133

Slot 7 option ROM download (Enable or Disable), and latency timer and speed.

* Available on selected models.

** These options should be used by advanced users only.

*** For information about specifying lane allocation, see PCI Lane Allocation under the Advanced, Chipset/Memory description above.

Workstation management
The HP Client Management Solutions (CMS), available for download from http://www.hp.com/go/
easydeploy, are standards-based solutions for managing and controlling workstations in a networked

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)

ENWW Workstation management 31

http://www.hp.com/go/easydeploy
http://www.hp.com/go/easydeploy


environment. This section summarizes capabilities, features, and key components of workstation
management, including:

● Initial workstation configuration and deployment on page 32

● Installing a remote system on page 32

● Replicating the setup on page 33

● Updating and managing software on page 34

● ROM Flash on page 36

● F10 setup instruction in the BIOS SoftPaq on page 36

● Asset tracking and security on page 37

● Fault notification and recovery on page 44

● Dual-state power button on page 45

Support for specific features described in this guide can vary by model and software version.

Initial workstation configuration and deployment
Your workstation includes a preinstalled system software image. After a brief software unbundling
process, the workstation is ready to use.

If you prefer to replace the preinstalled software image with a customized set of system and application
software, several methods are available for deploying a customized software image, including:

● Installing additional software applications after unbundling the preinstalled software image

● Using a disk cloning process to copy the contents from one hard drive to another

The best deployment method depends on your information technology environment and processes. To
help you select the best deployment method, see the PC Deployment section of the HP Lifecycle
Solutions Web site (http://www.hp.com/support/HPLS).

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery
of system software, configuration management and troubleshooting, and power management.

Installing a remote system
Remote system installation enables you to start and set up your system using software and configuration
information on a network server. This feature is usually used as a system setup and configuration tool
and can be used for the following tasks:

● Deploying a software image on new PCs

● Formatting a hard drive

● Installing application software or drivers

● Updating the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the
lower right corner of the HP logo screen. Follow the onscreen instructions to continue the installation
process. The default boot order is a BIOS configuration setting that can be changed to always attempt
a PXE boot.
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Replicating the setup
The following procedures enable you to copy one setup configuration to other workstations of the same
model for faster, more consistent configuration of multiple workstations. Procedures require a diskette
drive or a USB device such as an HP Drive Key.

Copying a setup configuration to a single workstation
CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target workstations are not the same model. For example, do not copy the setup configuration from an
HP xw4200 Workstation to an HP xw8600 Workstation.

1. Select a setup configuration to copy, and then reboot the workstation.

2. As soon as the workstation powers on, press and hold F10 until you enter the Computer Setup
(F10) Utility. If necessary, press Enter to bypass the title screen.

NOTE: If you do not press F10 at the appropriate time, you must restart the workstation, and then
press and hold F10 again to access the utility.

If you are using a PS 2 keyboard, you might see a keyboard error message. Disregard it.

3. If you are using a diskette or other storage device, insert it now.

4. Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB media device.

5. Power off the workstation you are configuring and insert the configuration diskette into the diskette
drive or USB media device.

6. Power on the workstation you are configuring.

7. Press and hold the F10 key until you enter the Computer Setup (F10) Utility. If necessary, press
Enter to bypass the title screen.

8. Select File>Replicated Setup>Restore from Removable Media, and then follow the instructions
on the screen.

9. Restart the workstation when the configuration is complete.

Copying a setup configuration to multiple workstations
CAUTION: A setup configuration is model-specific. If source and target workstations are not the same
model, file system corruption can result. For example, do not copy the setup configuration from an HP
xw4200 Workstation to an HP xw8600 Workstation.

This method takes longer to prepare the configuration diskette, but copying the configuration to target
workstations is fast.

A bootable diskette is required for this procedure. If Windows XP is not available to create a bootable
diskette, use the method for copying to a single workstation instead (see Copying a setup configuration
to a single workstation on page 33.)

1. Create a bootable diskette or USB media device.

2. Select a setup configuration to copy.

3. Restart the workstation.

4. As soon as the workstation powers on, press and hold F10 until you enter the Computer Setup
(F10) Utility. If necessary, press Enter to bypass the title screen.
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NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.

If you are using a PS 2 keyboard, you might see a keyboard error message. Disregard it.

5. If you are using a diskette or other storage device, insert it now.

6. Select File>Replicated Setup>Save to Removable Media, and follow the instructions on the
screen to create the configuration diskette or USB media device.

7. Download a BIOS utility for replicating setup (repset.exe), and copy it to the configuration diskette
or USB media.device. To obtain this utility, see http://www.hp.com/support/files.

8. Enter the model number of the workstation.

9. On the configuration diskette, create an autoexec.bat file containing repset.exe and 
cpqsetup.txt.

10. Power off the workstation you are configuring, insert the configuration diskette, and then power on
the workstation. The configuration utility runs automatically.

11. When the configuration is complete, restart the workstation.

Updating and managing software
HP provides several tools for managing and updating software on desktops and workstations:

● HP Client Manager Software

● System Software Manager

● Altiris Client Management Solutions

● Proactive Change Notification

● Subscriber’s Choice

HP Client Manager Software
HP Client Manager Software (HP CMS) assists customers in managing workstation hardware. It offers:

● Detailed views of hardware inventory for asset management

● PC health-check monitoring and diagnostics

● Proactive notification of changes in the hardware environment

● Web-accessible reporting of business-critical details such as thermal warnings and memory alerts

● Remote updating of system software such as device drivers and ROM BIOS

● Remote changing of boot order

● Configuration of system BIOS settings

For more information about the HP Client Manager, see http://www.hp.com/go/ssm.
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Altiris Client Management Solutions
Altiris and HP have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs. The HP CMS is the foundation for additional Altiris
Client Management Solutions that address:

● Inventory and asset management

● Deployment and migration

● Help desk and problem resolution

● Software and operations management

For more information about the following topics, go to http://www.hp.com/go/ssm:

● How HP CMS works

● Which solutions are compatible with your operating system

● How to download a fully functional, 30-day evaluation version of Altiris solutions

System Software Manager
System Software Manager (SSM) is a utility that enables you to update system-level software on multiple
systems simultaneously. When executed on a PC client system, SSM detects hardware and software
versions and then updates the software from a central repository, known as a file store. Driver versions
supported by SSM are noted with a special icon on the software, the driver download Web site, and on
the Support Software CD. To download the utility or to obtain more information about SSM, see
http://www.hp.com/go/ssm.

Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice Web site to:

● Send Proactive Change Notification (PCN) e-mail informing you up to 60 days in advance of
hardware and software changes to most commercial workstations and servers

● Send you e-mail containing customer bulletins, customer advisories, customer notes, and driver
alerts for most commercial workstations and servers

You can create your own profile to ensure that you only receive the information relevant to your specific
IT environment.

To learn more about the PCN program and to create a custom profile, see Subscriber’s Choice
on page 35.

Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP that supplies you with personalized product tips,
feature articles, and driver and support alerts and notifications based on your profile.

Subscriber’s Choice Driver and Support Alerts and Notifications delivers e-mail notifying you that the
information you subscribed to in your profile is available for review and retrieval.

To learn more about Subscriber’s Choice and create a custom profile, see http://www.hp.com/
subscriberschoice.
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ROM Flash
Your HP workstation comes with a programmable flash ROM. By establishing a setup password in the
Computer Setup (F10) Utility, you can protect the ROM from being inadvertently updated or overwritten.
This function is important to ensure the operating integrity of the workstation.

To upgrade the ROM, download the latest SoftPaq images from http://www.hp.com//support/files.

For maximum ROM protection, establish a setup password. The setup password prevents unauthorized
ROM upgrades. SSM enables you to create the setup password on several workstations simultaneously.
For more information, see http://www.hp.com/go/ssm.

Remote ROM Flash
Remote ROM Flash allows system administrators to safely upgrade the ROM on remote HP
workstations from a centralized network management console, resulting in a consistent deployment of,
and greater control over, HP PC ROM images over the network.

To use Remote ROM Flash, the workstation must be powered on, or turned on using Remote Wakeup.

For more information about Remote ROM Flash, see the HP Client Manager Software or System
Software Manager sections at http://www.hp.com/go/ssm.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on PCs using a Windows
operating system.

For more information about HPQFlash, see http://www.hp.com/go/ssm, and enter the name of your
workstation.

F10 setup instruction in the BIOS SoftPaq

FailSafe Boot Block ROM
The FailSafe Boot Block ROM enables system recovery in the unlikely event of a ROM flash failure. For
example, if a power failure occurs during a ROM upgrade, the Boot Block uses a flash-protected section
of the ROM to verify a valid system ROM flash when power is restored to the system.

If the system ROM is valid, the system starts normally.

If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support to
start the system from a BIOS image CD created from a SoftPaq. The BIOS image CD programs the
system ROM with a valid image.

When Boot Block detects an invalid system ROM, the workstation power LED blinks red eight times and
the workstation beeps eight times; then the workstation pauses for two seconds. On some models, a
Boot Block recovery mode message appears.

In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image
CD.

To recover the system after it enters Boot Block recovery mode:

1. If there is media in the diskette or optical drives, remove it.

2. Insert a BIOS image CD into the CD drive.

You can also use USB media such as an HP DriveKey.
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3. Power off, then power on the workstation.

If no BIOS image CD or USB is found, you are prompted to insert one and restart the workstation.

If a setup password has been established, the Caps Lock light illuminates and you are prompted
for the password.

4. Enter the setup password.

If the system starts from the CD or USB and successfully reprograms the ROM, three keyboard
lights illuminate. A rising-tone series of beeps also signals successful recovery.

5. Remove the CD or USB media and power off the workstation.

6. Restart the workstation.

Asset tracking and security
Asset tracking features incorporated into your workstation provide asset tracking data that can be
managed using HP Systems Insight Manager (HP SIM), HP CMS, or other systems-management
applications.

Seamless, automatic integration between asset tracking features and these products enables you to
choose the management tool that is best suited to your environment and to leverage investments in
existing tools.

HP also offers several solutions for controlling access to valuable components and information:

● HP ProtectTools Embedded Security prevents unauthorized access to data, checks system
integrity, and authenticates third-party users attempting system access.

● Security features such as ProtectTools and the Hood Sensor (Smart Cover Sensor) help prevent
unauthorized access to your data and to the internal components of the workstation.

● By disabling parallel, serial, or USB ports, or by disabling removable-media boot capability, you
can protect valuable data assets.

● Memory Change and Hood Sensor (Smart Cover Sensor) alerts can be forwarded to system
management applications to deliver proactive notification of tampering with a workstation’s internal
components.

ProtectTools, the Hood Sensor (Smart Cover Sensor), and the (Smart Cover Lock) are available as
options on select systems.

Use the following utilities to manage security settings on the HP workstation:

● Locally, using the Computer Setup (F10) Utility

● Remotely, using the HP CMS or System SSM, which enables the secure, consistent deployment
and control of security settings from a simple command line utility

The following table and sections refer to the management of workstation security through the Computer
Setup (F10) Utility

Table 3-2   Security features overview

Feature Purpose How it is established

Removable Media Boot Control Prevents booting from removable media
drives

From the Computer Setup (F10)
Utility menu

Serial, Parallel, USB, or Infrared
Interface Control

Prevents transfer of data through the
integrated serial, parallel, USB, or infrared
interface

From the Computer Setup (F10)
Utility menu
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Feature Purpose How it is established

Power-On Password Prevents use of the workstation until the
password is entered (applies to initial system
startup and restarts)

From the Computer Setup (F10)
Utility menu

Setup Password Prevents reconfiguration of the workstation
(use of the Setup utility) until the password is
entered

From the Computer Setup (F10)
Utility menu

Network Server Mode Provides unique security features for
workstations used as servers

From the Computer Setup (F10)
Utility menu

NOTE: For more information about the Computer Setup (F10) Utility, see The Computer Setup (F10) Utility menu
on page 25.

Password security
The power-on password prevents unauthorized use of the workstation by requiring entry of a password
to access applications or data when the workstation is powered on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override to the power-on password. When prompted for the power-on password, entering the setup
password instead enables access to the workstation.

You can establish a network-wide setup password to enable the system administrator to log in to all
network systems to perform maintenance without needing to know the power-on password.

NOTE: HP SSM and HP CMS enable remote management of setup passwords and other BIOS
settings in a networked environment. For more information, see http://www.hp.com/go/easydeploy.

Establishing a setup password using the Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
workstation (through the use of the Computer Setup (F10) Utility) until the password is entered.

To establish a setup password using the Computer Setup (F10) menu:

1. Power on or restart the workstation.

2. As soon as the computer is powered on, press and hold  F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation, and then press
and hold F10 again to access the utility.

If you are using a PS 2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Setup Password and then follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.

Establishing a power-on password using workstation setup

Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
workstation when power is connected, unless you specify the password. When a power-on password
is set, the Computer Setup (F10) Utility presents Password Options in the Security menu. The password
options include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, you must specify the password when the workstation is
powered on when the key icon appears on the monitor. When Password Prompt on Warm Boot
is enabled, you must enter the password must also be entered each time the workstation is rebooted.

Table 3-2   Security features overview (continued)
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When Network Server Mode is enabled, the password prompt is not presented during POST, but an
attached PS/2 keyboard remains locked until you enter the power-on password.

To enable Network Server Mode, you set a power-on password. The option to set this password is
available under Advanced>Password Options. This option enables the system to boot without requiring
the power-on password, but the keyboard and mouse are locked until you enter the password. The
keyboard LEDs rotate constantly when the system is in locked mode.

To establish a power-on password through the Computer (F10) menu:

1. Power on or restart the workstation.

2. As soon as your workstation is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation and then press
and hold F10 again to access the utility.

If you are using a PS 2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Power-On Password and then follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.

Entering a power-on password

1. Restart the workstation.

2. When the key icon appears on the monitor, enter the current password, and then press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you will enter the F10 setup screen with read-only permission. (See the Setup Browse Mode option
under the Power-On options.)

Entering a setup password

If a setup password has been established on the workstation, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.

To enter a setup password:

1. Restart the workstation.

2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation and press and
hold F10 again to access the utility.

If you are using a PS 2 keyboard, you might see a keyboard error message. Disregard it.

3. When the key icon appears on the monitor, enter the setup password, and press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.
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Changing a power-on or setup password

1. Restart the workstation.

2. To change the power-on password, go to step 4.

3. To change the setup password, as soon as the workstation is powered on, press and hold F10 until
you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the workstation, and then press
and hold the F10 key again to access the utility.

If you are using a PS 2 keyboard, you might see a keyboard error message. Disregard it.

4. When the key icon appears, enter the current password, a slash (/) or alternative delimiter
character, your new password, another slash (/) or alternative delimiter character, and your new
password again as shown: 

current password/new password/new password

For information about the alternative delimiter characters, see National keyboard delimiter
characters on page 40.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

5. Press Enter.

The new password takes effect the next time you power on the workstation.

The power-on and setup passwords can also be changed using the Security options in the Computer
Setup (F10) Utility.

Deleting a power-on or setup password

1. Power on or restart the workstation.

2. Choose from the following:

● To delete the power-on password, go to step 4.

● To delete the setup password, as soon as the workstation is powered on, press and hold
F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen,
if necessary.

If you do not press F10 at the appropriate time, you must restart the computer and then press
and hold F10 again to access the utility.

Use the appropriate operating system shutdown process.

3. When the key icon appears, enter your current password followed by a slash (/) or alternative
delimiter character: current password/.

For information about the alternative delimiter characters see National keyboard delimiter
characters on page 40.

4. Press Enter.

National keyboard delimiter characters

Each keyboard meets country-specific requirements. The syntax and keys you use for changing or
deleting passwords depend on the keyboard included with your workstation.
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Table 3-3  National keyboard delimiter characters

Language Delimiter Language Delimiter Language Delimiter

Arabic / Greek - Russian /

Belgian = Hebrew . Slovakian -

BHCSY* - Hungarian - Spanish -

Brazilian / Italian - Swedish/Finnish /

Chinese / Japanese / Swiss -

Czech - Korean / Taiwanese /

Danish - Latin American - Thai /

French ! Norwegian - Turkish .

French
Canadian

é Polish - U.K. English /

German - Portuguese - U.S. English /

NOTE: * Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

Clearing passwords

If you forget your password, you cannot access the workstation. For instructions about clearing
passwords, see Resetting the password jumper on page 152.

DriveLock
WARNING! Enabling DriveLock can render a hard drive permanently inaccessible if the master
password is lost or forgotten. No method exists to recover the password or access the data.

DriveLock uses an industry-standard security feature that prevents unauthorized access to data on an
ATA hard drive. DriveLock has been implemented as an extension to Computer Setup (F10) functions.
It is only available when hard drives that support the ATA security command set are detected. On HP
workstations, it is not available when the SATA emulation mode is RAID+AHCI or RAID.

DriveLock is for HP customers for whom data security is a paramount concern. For such customers, the
cost of a hard drive and the loss of the data stored on it is inconsequential when compared to the damage
that could result from unauthorized access to its contents.

To balance this level of security with the need to address the issue of a forgotten password, the HP
implementation of DriveLock employs a two-password security scheme. One password is intended to
be set and used by a system administrator, while the other is typically set and used by the user.

No "back door" can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is most
safely used when the data contained on the hard drive is replicated on a corporate information system
or is regularly backed up.

If both DriveLock passwords are lost, the hard drive is rendered unusable. For users who do not fit the
previously defined customer profile, this might not be acceptable. For users who fit this profile, it might
be a tolerable risk, given the nature of the data stored on the hard drive.

DriveLock applications

The most practical use of DriveLock is in a corporate environment. The system administrator would be
responsible for configuring the hard drive, which involves setting the DriveLock master password and
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a temporary user password. If you forget the user password or if the equipment is passed on to another
employee, the master password can be used to reset the user password and regain access to the hard
drive.

HP recommends that corporate system administrators who enable DriveLock also establish a corporate
policy for setting and maintaining master passwords. This should be done to prevent a situation where
an employee sets both DriveLock passwords before leaving the company. In such a scenario, the hard
drive is unusable and requires replacement. Likewise, by not setting a master password, system
administrators might find themselves locked out of a hard drive and unable to perform routine checks
for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users
in this category include personal users, or users who do not maintain sensitive data on their hard drives
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both
passwords is much greater than the value of the data DriveLock protects.

Access to Computer Setup (F10) and DriveLock can be restricted through the setup password. By
specifying a setup password and not giving it to users, system administrators can restrict users from
enabling DriveLock.

Using DriveLock

When hard drives that support the ATA security command set are detected, DriveLock appears under
the Security menu in the Computer Setup (F10) menu. You are presented with options to set the master
password and to enable DriveLock. You must provide a user password to enable DriveLock. Because
the initial configuration of DriveLock is typically performed by a system administrator, a master password
should be set first.

HP encourages system administrators to set a master password whether they plan to enable DriveLock
or not. This gives the administrator the ability to modify DriveLock settings if the drive is locked in the
future. After the master password is set, the system administrator can enable DriveLock or leave it
disabled.

If a locked hard drive is present, POST requires a password to unlock the device. If a power-on password
is set and it matches the device’s user password, POST does not prompt the user to re-enter the
password. Otherwise, the user is prompted to enter a DriveLock password.

For a cold boot, use the master or user password. For a warm boot, enter the same password used to
unlock the drive during the preceding cold boot.

Users have two attempts to enter a correct password. During cold boot, if neither attempt succeeds,
POST continues but the drive remains inaccessible. During a warm-boot or restart from Windows, if
neither attempt succeeds, POST halts and the user is instructed to cycle power.

To enable and set the DriveLock user password:

1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F!0 at the appropriate time, you must restart the workstation, and then press
and hold F10 again to access the utility.

If you are using a PS2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>DriveLock Security.

4. For each DriveLock-capable drive, select a drive by pressing F10 to accept.
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5. Under Enable/Disable DriveLock options, select Enable, and then press F10  to enable DriveLock
for a specific drive.

CAUTION: Forgetting the DriveLock password renders the drive unusable.

6. Enter a new user password, and then press F10 to accept. This password may be 1 to 32 characters
long.

7. Enter the password again in the Enter New Password Again field. If you forget this password, the
drive is rendered permanently disabled.

8. Select File>Save Changes and Exit, and then press F10. After you press F10, the system
performs a cold boot before invoking the DriveLock function.

You can also use this process to set the DriveLock master password by selecting Master in Step 5.

When the workstation starts, you are prompted to enter the DriveLock password for each DriveLock-
capable drive for which you have set a password. You have two attempts to enter the password correctly.
If the password is not entered correctly, the workstation attempts to boot anyway. However, the boot
process most likely fails because data from a locked drive cannot be accessed.

In a single drive workstation, if the drive has DriveLock enabled, the workstation might not be able to
boot to the operating system, and might try to boot from the network or from another storage device
(depending on the boot ordering options). Regardless of the outcome of the boot attempts, the drive-
locked drive remains inaccessible without the DriveLock password.

In a two-drive workstation that has a boot drive and a data drive, you can apply the DriveLock feature
to the data drive only. In this case, the workstation can always boot, but the data drive is accessible only
when the DriveLock password is entered.

Cold boots require that you enter DriveLock passwords. However, DriveLock passwords are also
required for warm boots. For example, if you boot to DOS and press Ctrl+Alt+Del, you must enter the
DriveLock password before the workstation completes the next boot cycle. This warm-boot behavior is
consistent with the DriveLock feature.

Hood Sensor (Smart Cover Sensor) (optional)
The optional Hood Sensor is a combination of hardware and software technology that can alert you
when the workstation side access panel has been removed (if the sensor has been configured in the
Computer Setup (F10) Utility). The three levels of Hood Sensor protection are shown in the following
table:

Table 3-4  Hood Sensor protection levels

Level Setting Description

Level 0 Disabled Hood Sensor* is disabled (default).

Level 1 Notify User When the workstation restarts, a message appears indicating that the
workstation side access panel has been removed.

Level 2 Setup Password When the workstation is restarted, a message appears indicating that the
workstation side access panel has been removed. You must enter the setup
password to continue.

* Hood Sensor settings can be changed using the Computer Setup (F10) Utility.
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Setting the Hood Sensor protection level

1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer,
and then press and hold the F10 key again to access the Computer Setup (F10) Utility.

If you are using a PS 2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Smart Cover>Cover Removal Sensor, and follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.

Cable lock (optional)
To prevent theft, the rear chassis panel of your workstation accommodates a keyed cable lock. This
cable lock attaches to the chassis and secures it to the work area.

Security lock (Padlock loop) (optional)
The rear chassis panel of your workstation provides a padlock loop. A padlock can be attached in this
loop to prevent workstation access panel removal.

Universal chassis clamp lock (optional)
The universal chassis clamp lock secures the access panel to the chassis using a screw-type
attachment. A built in key lock prevents access to the securing screw. In addition, you can add cables
to the universal chassis clamp lock to secure workstation peripherals, and to secure the workstation to
the work area.

Fault notification and recovery
Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.

If the workstation is connected to a network that is managed by HP CMS, the computer sends a fault
notice to the network management application. With HP CMS, you can also remotely schedule
diagnostics to run on managed PCs and create a summary report of failed tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into hard drives and is installed in select
HP workstations. The DPS helps diagnose problems that might result in unwarranted hard drive
replacement.

When HP workstations are built, each installed hard drive is tested using the DPS, and a permanent
record of key information is written onto each drive. Every time the DPS is run, test results are written
to the hard drive. The service provider can use this information to help diagnose conditions that required
you to run the DPS software.

ECC fault prediction
When the workstation encounters an excessive number of error checking and correcting (ECC) memory
errors, it displays a local alert message. This message contains information about the errant memory
module, enabling you to take action before you experience noncorrectable memory errors. ECC memory
modules are standard on the HP xw8600 Workstation.
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Thermal sensors
Several thermal sensors in your HP Workstation regulate workstation fans to maintain an acceptable,
efficient chassis temperature.

Dual-state power button
With ACPI enabled, the power button can function as an on/off switch or as a button. This feature does
not completely turn off power, but instead causes the workstation to enter a low-power standby state.
This enables you to go to standby without closing applications, and to return to the same operational
state without any data loss.

To change the power button configuration:

1. Select Start, and then select Control Panel>Power Options.

2. In Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Hibernate. 

Hibernate must be enabled in the Hibernate tab.

After configuring the power button to function as a button, you can press the power button to put the
system in a very low power state. Press the button again to bring the system out of this low power state
to full power state. To completely turn off power to the system, press and hold the power button for four
seconds.

CAUTION: Do not use the power button to power off the workstation unless the system is not
responding; turning off the power without operating system interaction can cause data loss.
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4 Removal and replacement procedures

This chapter describes the removal and replacement procedures for most internal workstation
components including the following topics:

● Warnings and cautions on page 47

● Service considerations on page 48

● Customer Self-Repair on page 52

● Predisassembly procedures on page 52

● System board components on page 52

● Removing and replacing components on page 53

● Product recycling on page 112

Warnings and cautions
WARNING!  Any surface or area of the equipment marked with this symbol indicates the presence
of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To reduce
the risk of injury from a hot component, enable the surface to cool before touching.

WARNING!  Any surface or area of the equipment marked with this symbol indicates the presence
of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any enclosed
area marked with this symbol.

WARNING! To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper
workstation setup, posture, health, and work habits for computer users, and provides important electrical
and mechanical safety information. This guide is located at http://www.hp.com/ergo and on the
documentation CD (if one is included with the product).

WARNING! If a product is shipped in packaging marked with this symbol, , the product must always
be lifted by two persons to avoid personal injury due to product weight.

CAUTION: Static electricity can damage the electronic components of the workstation. Before
beginning these procedures, be sure you discharge static electricity by briefly touching a grounded metal
object.
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CAUTION: Observe the following cautions when removing or replacing a processor:

— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller
or service provider to install the processor. If you plan to install the processor yourself, read all of the
instructions carefully before you begin.

— Failure to follow the workstation preparation instructions can result in an improperly installed
processor, causing extensive workstation damage.

— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor
in the socket.

CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body
to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap, and peripheral units to that piece of equipment.

NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested
for reliability and are manufactured to high quality standards.

Service considerations
The following sections describe service considerations that you should review and practice before
removing and replacing system components.

WARNING!  Do not use the front bezel as a handle or lifting point when lifting or moving the
workstation. Lifting the workstation from the front bezel, or lifting it incorrectly, could cause the
workstation to fall, causing possible injury to you and damage to the workstation. To properly and safely
lift the workstation, use the handles. If your workstation is not equipped with handles, lift from the bottom
of the workstation.

Cautions, warnings, and safety precautions
For your safety, review the cautions, warnings, and safety precautions before accessing the workstation
components. Also, review the Safety and Regulatory Guide that came with your workstation for more
information.

ESD information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often, the discharge is neither felt nor heard, but damage occurs nonetheless.
An electronic device exposed to ESD might not appear to be affected at all and can function normally
for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static
The following table shows that different activities generate different amounts of static electricity. Static
electricity increases as humidity decreases.
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Table 4-1  Static electricity

 Relative humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

7,500V

3,000V

400V

15,000V

5,000V

800V

35,000V

12,000V

6,000V

Removing bubble pack from PCB

Packing PCBs in foam-lined box

7,000V

5,000V

20,000V

11,000V

26,500V

21,000V

CAUTION: 700 volts can degrade a product.

Preventing ESD equipment damage
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories:

● Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand contact.

● Protect electrostatic parts and assemblies with nonconductive or approved containers or
packaging.

● Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from containers.

● When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Personal grounding methods and equipment
Use the following items to help prevent ESD damage to equipment:

● Wrist straps—These are flexible straps with a maximum of one megohm ± 10% resistance in the
ground cords. To provide a proper ground, wear the strap against bare skin. The ground cord must
be connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps, toe straps, and boot straps—These can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one megohm ± 10% resistance between the operator and
ground.

The following table shows protection levels available from static shielding materials.

Table 4-2  Static shielding protection levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

1,500V

7,500V
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Method Voltage

Metallized laminate 15,000V

Grounding the work area
To prevent static damage in your work area:

● Cover the work surface with approved static-dissipative material. Use a wrist strap connected to
the work surface, and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only in static-free work areas.

● Disconnect power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials, such as plastic assembly aids and Styrofoam.

● Use field service tools (such as cutters, screwdrivers, and vacuums) that are conductive.

Recommended ESD prevention materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with a ground cord of one megohm ± 10% resistance

● Static-dissipative table or floor mats with a hard-tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one megohm ± 10% resistance

● Material-handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Table 4-2  Static shielding protection levels (continued)
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Tools and software requirements
● Torx T-15 driver

● Flat blade and cross-tip screwdrivers

● Diagnostics software

Special handling of components
The components included in this section require special handling when servicing the workstation.

WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation.
Lifting the workstation from the front bezel, or lifting it incorrectly, could cause the workstation to fall,
causing possible injury to you and damage to the workstation. To properly and safely lift the workstation,
lift from the bottom of the workstation.

Cables and connectors
Handle cables with care to avoid damage. Apply only the tension required to seat or unseat cables
during insertion or removal from the connector. When possible, handle cables by the connector or pull-
strap. In all cases, avoid bending or twisting the cables, and be sure that the cables are routed in such
a way that they cannot be caught or snagged by parts being removed or replaced.

When servicing the workstation, be sure that cables are placed in their proper location during the
reassembly process. Improper cable placement can damage the workstation.

Hard drives
Hard drives are fragile, precision components. Avoid subjecting them to physical shock and vibration.
The following guidelines apply to all drives, including failed drives, replacement drives, and spares.

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are mounted in the workstation.

● Avoid dropping hard drives from any height.

● If you are inserting or removing a hard drive, power off the workstation. Do not remove a hard drive
while the workstation is powered on or in standby mode.

● Before handling a drive, be sure that you discharge static electricity. While handling a drive, avoid
touching the connector. For more information about preventing electrostatic damage, see ESD
information on page 48.

To prevent possible ESD damage when the drive is installed, connect the drive power cable before
connecting the data cable. This discharges accumulated static electricity through the drive power
cable to the workstation chassis.

● When inserting a drive, do not use excessive force.

● Avoid exposing a hard drive to liquids, temperature extremes, or products with magnetic fields such
as monitors or speakers.

Lithium coin cell battery
The battery included with the workstation provides power to the real-time clock and has a lifetime of
about three years.

For instructions on battery removal and replacement, see Battery on page 96.
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WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short the external contacts, dispose
of in water or fire, or expose the battery to temperatures higher than 60° Centigrade (140° Fahrenheit).

NOTE: Do not dispose of batteries, battery packs, and accumulators with general household waste.

Customer Self-Repair
Customer Self-Repair enables you to obtain replacement parts and install them on the workstation. For
more information, see http://www.hp.com/go/selfrepair/.

Predisassembly procedures
Perform the following steps before servicing a workstation:

1. Close all open software applications.

2. Remove all diskettes, CDs, and DVDs from the workstation.

3. Shut down the operating system.

4. Power off the workstation and all peripheral devices connected to it.

5. Remove or disengage security devices that prevent you from opening the workstation.

6. Disconnect the power cord from the electrical outlet and then from the workstation.

7. Disconnect peripheral device cables from the workstation.

System board components
The following figure shows the system board connectors and sockets on the HP xw8600 Workstation.

Figure 4-1  System board component identification
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Table 4-3  System board components

Item Component Item Component Item Component

1 Memory fan connector 15 SAS connectors 29 PCI Express x8 (4) slot**

2 Main power connector 16 Front USB connector 30 PCI Express x16 GEN2 slot*

3 Memory card sockets 17 Battery 31 PCI 32/33 slot

4 Primary processor (XU1) 18 HDD activity LED connector 32 Rear chassis fan connector

5 Processor power connector 19 Front control panel
connector

33 Audio jacks

6 Primary processor (XU1) fan
power

20 Internal USB connector 34 Memory power connector

7 Second processor (XU2) 21 Crisis recovery jumper 35 Network (ASF)/USB

8 Second processor (XU2) fan
power

22 Front 1394 connector 36 Network and USB

9 Diskette drive connector 23 Front audio connector 37 1394 connector

10 IDE (PATA) connector 24 Auxiliary audio connector 38 Serial connector

11 Clear CMOS button 25 PCI-X 133 slot 39 USB connector

12 SATA connectors 26 PCI Express x8 (4) slot** 40 Keyboard/mouse connector

13 Password jumper 27 PCI Express x8 (1,8) (GEN2
for x8) slot**

  

14 Front chassis fan connector 28 PCI Express x16 (16,8)
GEN2 slot

* Electrically x16 bandwidth
** Open-ended slot that allows installation of x16 card.

For related system architecture information, see System board architecture on page 2.

Removing and replacing components
This section provides procedures to remove and install hardware components on your workstation.

1. Before servicing your workstation, review the safety information and precautions in Service
considerations on page 48 and the Safety and Regulatory Information for your workstation.

2. Locate and clear a suitable work area.

3. Power down the workstation and disconnect power from the workstation.

4. Gather your tools.

5. Service the workstation.

6. Restore power to the workstation.

Disassembly order
Use the following table to determine the sequence in which to remove major workstation components.
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Table 4-4  Workstation component disassembly order

        

Predisassembly (Predisassembly procedures
on page 52)

Security lock (Security lock (Padlock loop) (optional)
on page 55

Cable lock (Cable lock (optional) on page 55     

Universal chassis clamp lock Universal chassis clamp lock (optional)
on page 56

   

Side access panel (Side access panel
on page 57)

 Hood Sensor (Hood Sensor (Smart Cover Sensor) (optional)
on page 58)

 

Front bezel (Front bezel
on page 59)

 

   Bezel blanks (Bezel blanks on page 60)   

Front panel I/O device assembly (Front panel I/O device assembly
on page 61)

Power button assembly (Power button assembly
on page 63)

Optical drives (Optical drive on page 64)

  System speaker (System speaker
on page 68)

   

  Power supply (Power supply
on page 69)

   

  System fan (System and memory fan assembly
on page 71)

  

  Memory (Memory on page 72)    

  SAS rear panel cable (SAS rear panel cable (optional)
on page 86)

  

  PCI card support (PCI card support
on page 90)

   

PCI Express card (PCI Express cards
on page 92)

 

   PCI card (PCI card
on page 95)

   

  Battery (Battery
on page 96)

    

  Hard drives (SAS hard drive on page 97), SATA hard
drive on page 101)

  

  Processor heatsink (Processor heatsink
on page 106)
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Processor (System processor
on page 108)

  

System board (System board
on page 110)

  

Security lock (Padlock loop) (optional)
If a security padlock is installed on your workstation, remove it before servicing the workstation.

Removing the security lock
To remove the padlock, unlock it and slide it out of the padlock loop as shown in the following figure.

Figure 4-2  Removing the security lock

Cable lock (optional)
If a cable lock is installed on your workstation, remove it before servicing the workstation.

Table 4-4  Workstation component disassembly order (continued)
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Removing the cable lock
To remove the cable lock, unlock it and pull it out of the cable lock slot as shown in the following figure.

Figure 4-3  Removing the cable lock

Universal chassis clamp lock (optional)
If a universal chassis clamp lock is installed on your workstation, remove it before servicing the
workstation.

Removing the chassis clamp lock
To remove the lock:

1. Unlock the device and remove the locking mechanism as shown in the following figure.

Figure 4-4  Unlocking the device
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2. Remove the screw attaching the lock to the chassis as shown in the following figure.

Figure 4-5  Removing the lock screws

Side access panel
Before accessing the internal components of the workstation, you must remove the side access panel.

This section describes how to remove and replace the side access panel.

Removing the side access panel
To remove the side access panel:

WARNING! Before removing the workstation side access panel, be sure that the workstation is
powered off and that the power cord is disconnected from the electrical outlet.

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Unlock locks that are present (such as security lock, cable lock, or universal chassis clamp lock).
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3. Pull up on the handle and rotate the cover off the chassis as shown in the following figure.

Figure 4-6  Removing the access panel

Replacing the side access panel
To replace the side access panel:

1. Align the bottom groove of the side panel with the bottom edge of the chassis.

2. Rotate the side panel toward the chassis and press firmly until the latch engages.

Hood Sensor (Smart Cover Sensor) (optional)
This section describes how to remove the Hood Sensor.

Removing the Hood Sensor
To remove the Hood Sensor:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Disconnect the hood sensor connector from the inline connector attached to the front panel
harness.
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4. Slide the hood sensor forward, push the hood sensor down, and then remove it from the chassis
(1) as shown in the following figure.

Figure 4-7  Removing the Hood Sensor

5. If desired, remove the hood sensor bracket, remove the two hood sensor bracket screws, and then
remove the bracket and sensor as a unit (2).

NOTE: To replace the Hood Sensor, reverse the previous steps.

Front bezel
This section describes how to remove and replace the front bezel.
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Removing the front bezel
To remove the front bezel:

1. Lift the three release snaps located on the front bezel (1) as shown in the following figure.

Figure 4-8  Removing the front bezel

2. Rotate the front bezel away from the chassis to remove the bezel (2).

Replacing the front bezel
To replace the front bezel, align the bezel hooks with the chassis holes, and then rotate in until it snaps
into place.

Bezel blanks
This section describes how to remove bezel blanks

Removing bezel blanks
To remove bezel blanks:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the front bezel (see Removing the front bezel on page 60).
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3. Gently squeeze in on the tabs (1), and push the bezel blanks out of the front bezel (2) as shown
in the following figure.

Figure 4-9  Removing the bezel blanks

A bezel blank has a hook on both sides. It is symmetric and can be installed upside down without issue.
To replace a blank, align its hook on one side with the slot in the bezel, then rotate it until it snaps into
place.

Front panel I/O device assembly
This section describes how to remove and install a front panel I/O device assembly.

Removing the front panel I/O device assembly
To remove the front panel I/O device assembly:

1. Disconnect power from the system (see Predisassembly procedures on page 52 ).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the front bezel (see Removing the front bezel on page 60).
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4. Unlatch the plastic snap that secures the cables inside the chassis (1) as shown in the following
figure.

Figure 4-10  Removing front panel I/O device cables

5. Disconnect the front panel I/O device assembly cables from the system board (2).

6. Using the following figure, remove the three smaller Torx screws that hold the front panel I/O device
assembly and bracket to the chassis (1).

Figure 4-11  Removing the front panel I/O device assembly

NOTE: Although not required, you can separate the mounting bracket from the front panel I/O
device assembly by removing the two larger Torx screws (2).

7. Pull the front panel I/O device assembly out about two inches from the chassis.

8. Pull the front panel cables through the chassis and through the front of the workstation.

You might need to slide the cables out one at a time.
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Installing the front panel I/O device assembly
To instal the front panel I/O device assembly:

1. Thread each front panel I/O device assembly cable through the same holes from which they were
removed.

2. Push the front panel I/O device assembly into the chassis. Using your fingers, orient the cables so
there is enough room for the front panel I/O device assembly to easily fit in its slot.

3. Loosely place the bracket on the front panel I/O device assembly and hook the bracket to the
chassis.

4. If the bracket was removed, screw the bracket to the front panel I/O device assembly, and then
screw the bracket to the chassis.

5. Using the following figure, complete the following:

a. Connect the front audio cable to the audio connector (1).

b. Connect the front 1394 cable to the control panel connector (2).

c. Connect the front USB cable to the USB connector (3).

Figure 4-12  Attaching the front panel I/O device assembly cables

Power button assembly
This section describes how to remove the power button assembly.

Removing the power button assembly
To remove the power button assembly:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the front bezel (see Removing the front bezel on page 60).

4. Remove the three screws from the front panel I/O device assembly and pull it slightly out from the
chassis (see Removing the front panel I/O device assembly on page 61).
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5. Disconnect the power button assembly cable from the system board as shown in the following
figure.

Figure 4-13  Removing the power button assembly cable

6. Disconnect the speaker wire and the hood sensor from the in-line connectors on the power button
assembly cable.

7. Remove the screw that secures the power button assembly to the chassis (1) as shown in the
following figure.

Figure 4-14  Removing the power button assembly

8. Pull the power button assembly away from the front of the chassis, and then rotate the assembly
out from the front of the chassis (2).

To replace the power button assembly, reverse the previous steps.

Optical drive
This section describes how to remove and install an optical disk drive.
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Removing an optical drive
1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your
body to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free
mat, static strap, and peripheral units to that piece of equipment.

3. Remove the front bezel (see Removing the front bezel on page 60).

4. Disconnect the data (1) and power (2) cables from the optical drive as shown in the following figure.

Figure 4-15  Disconnecting the optical drive cables
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5. Lift the green drive-lock release lever (1) and gently slide the drive out of the chassis (2) as shown
in the following figure.

Figure 4-16  Removing the optical drive from the chassis

6. If you are not installing another optical drive, add a bezel blank filler to the front bezel, and an EMI
filler to the optical drive slot.

Installing an optical drive
1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the front bezel (see Removing the front bezel on page 60).

4. If you are adding an additional drive, remove the blank filler and the EMI filler.

5. Lift the green drivelock release lever while sliding the optical drive into the bay. When the optical
drive is partially inserted, release the drivelock release lever and slide the drive completely into the
bay until the drive is secured.

CAUTION: Verify that the optical drive is secure in the workstation chassis by pulling on the drive
to see if it can be easily disengaged. Failure to properly secure the drive can damage the drive
when moving the workstation.

6. Replace the workstation front bezel.
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7. Connect the power and data cables to the drive and system board as shown in the following figure.

Figure 4-17  Connecting the optical drive cables

NOTE: The HP xw8600 Workstation BIOS Configuration Mode can be set to affect optical and
hard drives. The workstation is set to RAID+AHCI at shipment.

The following constraints apply when the Configuration Mode is set to:

Separate IDE controller—Only SATA ports 0, 1, 2, 3 are available.

Combined IDE controller—Only SATA ports 0, 1, 2, and 3 are available.

RAID + AHCI—System BIOS cannot be updated from the optical drive. In this mode, the option
ROM might not allow certain DOS drive letter access at this time.

Other than the reduction of available SATA ports, there are no limitations if your workstation is
running in IDE mode.
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8. For multiple optical drives, the following figure shows how to route the data cables.

Figure 4-18  Routing the optical drive cables

System speaker
This section describes how to remove the system speaker.

Removing the system speaker
To remove the system speaker:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Disconnect the speaker cable from the inline front panel I/O device assembly cable.
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4. Slide the speaker away from the three chassis flanges and remove it from the chassis as shown
in the following figure.

Figure 4-19  Removing the system speaker

To replace the speaker, reverse the previous steps.

Power supply
This section describes how to remove the power supply.

Removing the power supply
To remove the power supply:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. If your workstation includes a memory riser, remove it from the chassis (see Removing a memory
riser assembly on page 78).

4. If your workstation is equipped with high performance heatsinks, they must be removed before you
can remove the power supply. Follow the instructions in the Removing the processor heatsink
on page 106 section to remove the high performance heatsinks.

5. To ease installation of the power supply, write down the numbers on the cables so you can easily
reconnect the cables to the correct devices.

6. Disconnect power supply cables from the system board, drives, and cards.

TIP: If your workstation does not include a memory riser, lift the memory fan to disconnect the
memory power connector on the motherboard.
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7. Remove the four screws from the back panel (1) as shown in the following figure.

Figure 4-20  Removing the power supply

8. Slide the power supply toward the front  of the chassis, and then lift it out of the chassis (2).

Installing the power supply
To replace the power supply, reverse the steps in the previous section.

If you have removed high performance processor heatsinks, follow the instructions in the Installing the
processor heatsink on page 107 section to reinstall the heatsinks.
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Power connections to system components
For help with identifying power cables, see the following figure and table. Ensure that all cables are
routed or tied so they cannot interfere with the processor heatsink fans.

Figure 4-21  Identifying the workstation power connectors for a typical configuration

Table 4-5  Workstation power connector description

Item Description Item Description

A Power supply I Optical drive

B Main power J Optical drive

C Memory power K Diskette drive

D Processor power L Hard drive

E PCI Express auxiliary power M Hard drive

F PCI Express auxiliary power N Hard drive

G Memory riser* O Hard drive

H Optical drive P Hard drive

* This connector is included only on workstations with the 1050-watt power supply.

System and memory fan assembly
This section describes how to remove the system and memory fan assembly.
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Removing the system and memory fan assembly
To remove the system and memory fan assembly:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Disconnect the system fan (1) and the memory fan (2) wire connectors from the system board as
shown in the following figure.

Figure 4-22  Removing the system and memory fan assembly

4. Press the green tab at the base of the memory fan and lift it up (3).

5. Press down on the ribbed portion of the system fan housing (4), rotate the fan housing down, and
lift the assembly out of the chassis.

To install the system fan assembly, reverse these steps.

Memory
This section presents memory configuration information and removal/installation procedures.

Memory general information
This section describes supported memory modules and configurations.

System board memory module requirements

● Install only HP approved, Fully Buffered DIMMs.

CAUTION: HP only ships DIMMs that are electrically and thermally compatible with this
workstation. Because third-party DIMMs might not be electrically or thermally compatible, they are
not supported by HP.

● DIMMs and their sockets are keyed for proper installation. Ensure these guides line up when
installing DIMMs.
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● If multiple DIMMs are installed in a workstation, install them in pairs of the same rank, DRAM
technology, speed and capacity in each channel.

● DDR2-667 and DDR2-800 DIMMs cannot be mixed in the same system.

DDR2-667 Fully Buffered DIMM support

The HP xw8600 Workstation supports the following DDR2-667 Fully Buffered DIMMs:

● Double Data Rate 2-667 MHz (DDR2-667), Fully Buffered DIMMs (FBD)

● PC2-5300F FBD, Error Checking and Correcting (ECC) (72-bit ECC)

● 512-MB, 1-GB, 2-GB, 4-GB and 8-GB DIMMs

● Cannot be used with 1600-MHz Front Side Bus (FSB) processors

● Cannot be intermixed with DDR2-800 Fully Buffered DIMMs

NOTE: The 8-GB DDR2-667 DIMM is not supported on the system board.

DDR2-800 Fully Buffered DIMM support

The HP xw8600 Workstation supports the following DDR2-800 Fully Buffered DIMMs:

● Double Data Rate 2-800 MHz (DDR2-800), Fully Buffered DIMMs (FBD)

● PC2-6400F FBD, Error Checking and Correcting (ECC) (72-bit ECC)

● 1-GB, 2-GB, and 4-GB DIMMs

● Must be used only with 1600-MHz Front Sided Bus (FSB) processors

● Cannot be intermixed with DDR2-667 Fully Buffered DIMMs

NOTE: The 4-GB DDR2-800 DIMM is not supported on the system board.

Supported system board DIMM configurations

The HP xw8600 Workstation supports the following Dual Inline Memory Module (DIMM) configurations
on the system board:

● Eight DIMM slots

● Configurable for Single Channel (one DIMM), Dual Channel (two DIMMs), or Quad Channel (sets
of four DIMMs)

● No support for mirroring

● No support for DIMM sparing

Supported memory riser DIMM configurations

The HP xw8600 Workstation supports the following memory module configurations with memory risers:

● Four memory riser cards with four slots each (maximum of 16 DIMMs)

● Loaded in pairs only

● No support for mirroring

● No support for DIMM sparing

Further details on supported memory module configurations are given in the following sections.
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BIOS errors and warnings

The BIOS generates warnings/errors on invalid memory configurations:

● If the BIOS can find a valid memory configuration by disabling plugged-in memory, it does so and
reports a warning during POST. The system can still be booted. The warning will indicate the
location of the failed DIMM on the system board or memory riser.

● If there is no way for the BIOS to obtain a valid memory configuration by disabling plugged-in
memory, the BIOS halts with a diagnostics 2006 code for memory error (five beeps and blinks).

System board memory
This section presents system board memory information, including removal and installation procedures.

Removing a memory module

This section describes how to remove a system board memory module.

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

CAUTION: To ensure that memory modules are not damaged during removal or installation,
power off the workstation and unplug the power cord from the AC power outlet. If you do not unplug
the power cord before installing memory, the modules might be damaged and the system will not
recognize the memory changes.

3. Press the green tab at the base of the memory fan (1) and lift it up to expose the memory modules
(2) as shown in the following figure.

Figure 4-23  Rotating the memory fan
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4. Push gently outward on the socket levers (1) as shown in the following figure.

Figure 4-24  Removing a memory module

5. Lift the DIMM straight up and out of the socket (2), then store the DIMM in an antistatic bag.

Installing a memory module

This section presents system board memory module installation information.

DIM slot identification

The following illustration identifies the system board memory slots:

Figure 4-25  Identifying DIMM slots

Required system board DIMM installation order

Use the figure below as a guide for installing memory:

● If installing only one DIMM, install it in socket 1.

● If installing only two DIMMs, install them in socket pair: 1/5.
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● If installing four DIMMs, install them in socket pairs: 1/3 and 5/7.

● If installing six DIMMs, install them in socket pairs: 1/3, 5/7, and 2/4.

● If installing eight DIMMS, install them in socket pairs: 1/3, 5/7, 2/4, and 6/8.

Each pair must be matched in rank, DRAM technology, speed, and capacity.

NOTE: If adding DIMMs to a system that originally contained only two DIMMs, move the DIMM from
socket five to socket three to maintain proper pairing.

TIP: For best performance, load the largest DIMM pairs in the black slots.

Installing a system board memory module

To install a memory module:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Press the green tab at the base of the memory fan (1) and lift it up to expose the memory modules
(2) as shown in the following figure.

Figure 4-26  Rotating the memory fan
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4. Push gently outward on the socket levers as shown in the following figure.

Figure 4-27  Opening the DIMM socket levers

5. Align the DIMM connector key with the DIMM socket key, and then seat the DIMM firmly in the
socket (1) as shown in the following figure.

NOTE: Note the keyed slot about midway across the bottom of the DIMM in the figure below.

Figure 4-28  Installing a memory module

6. Secure the socket levers (2).

7. Lower the memory fan until it snaps into place.

NOTE: Ensure that all cables are clear of the fan housing when you lower the fan.

Memory riser assembly
This section presents configuration and removal/installation information for the memory riser assembly.
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Removing a memory riser assembly

The following steps describe how to remove a memory riser assembly.

1. Remove the memory duct assembly by loosening the assembly thumb screws (1), and then
removing the assembly from the chassis (2) as shown in the following figure.

Figure 4-29  Removing the memory duct assembly

2. Disconnect the memory card power cable from the power connector on each memory card as
shown in the following figure.

TIP: Push in on the latch, and then pull up on the connector.

Figure 4-30  Disconnecting the riser card power cables

3. Remove the memory riser cards from the card cage by grasping each card at its corners and pulling
straight up.

There is no need to unlatch the system board connectors when removing the riser cards.

78 Chapter 4   Removal and replacement procedures ENWW



4. Pull up on the card guide to remove it from the chassis as shown in the following figure.

Figure 4-31  Removing the riser card guide

5. Disconnect the memory riser cable from power supply cable P18 as shown in the following figure.

Figure 4-32  Disconnecting the memory riser cable from the power supply cable

Installing a memory riser assembly

ENWW Removing and replacing components 79



Memory riser DIMM installation order

DIMMs can be added to memory risers on the HP xw8600 Workstation in this manner:

● DIMMS must be added in pairs, in the order shown in the figure below.

Figure 4-33  Memory riser DIMM installation order

● Each pair must be matched in rank, DRAM technology, speed, and capacity.

TIP: For best performance, load the largest capacity DIMM pairs closest to the system board.

Installing a memory riser assembly and DIMMs

The following steps describe how to install memory riser DIMMs and a memory riser assembly.

CAUTION: To use a memory riser assembly, your workstation must be equipped with a 1050W power
supply and two high performance processor heatsinks.
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NOTE: All four memory risers must be present with card cage and memory duct assembly properly
installed during operation.

1. Connect the memory riser cable to power supply cable P18 as shown in the following figure.

Figure 4-34  Connecting the memory riser cable to the power supply cable

2. Open all memory slot latches as shown in the following figure.

Figure 4-35  Opening the memory slot latches
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3. Install the memory riser card guide into memory slots 2, 4, 6, and 8 in the workstation chassis. Align
the card guide, and then press it securely into the slots as shown in the following figure.

Figure 4-36  Installing the riser card guide

4. Install the memory DIMMs in the memory riser cards as shown in the following figure.

Begin installing DIMMs in the lower-most slots, nearest the system board.

Figure 4-37  Installing DIMMs in the memory riser board

5. To assure proper airflow to the DIMMs, install blank memory riser fillers in all unused slots on the
riser board.
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6. Install the loaded memory riser cards in the riser card cage as shown in the following figure.

Figure 4-38  Installing memory riser cards in the card cage

7. Install the memory riser card power cable by connecting each memory card power cable connector
into the power connector on a memory card as shown.

Figure 4-39  Installing the riser card power cable
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8. Insert the memory riser card power cable into the notch on the riser card guide as shown in the
following figure.

Figure 4-40  Inserting the riser card cable into card the guide notch

9. As shown in the following figure, install the memory fan/duct assembly by placing the rear of the
assembly under the chassis lip, lowering it into the chassis (1), and then securing the assembly
thumbscrews (2).

Figure 4-41  Installing the memory fan duct assembly
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PCI card slots
The following figure illustrates the xw8600 Workstation PCI card slots.

Figure 4-42  Identifying PCI card slots

Table 4-6  PCI slots

Slot Type Slot power

(Maximum)

1 PCI 32/33 25W

2 PCI Express x16 GEN2* 75W

3 PCI Express x8 (x4) 25W

4 PCI Express x16 (x16, x8) GEN2** 75W

5 PCI Express x8 (1), Gen2 x8 (8) 25W

6 PCI Express x8 (x4) 25W

7 PCI-X 133 25W

* Primary graphics slot
** Secondary graphics slot

CAUTION: To prevent damage, the overall power consumption of the system (including I/O cards,
processor, and memory) must not exceed the maximum rating of the system power supply. For power
supply information, refer to Power supply specifications on page 8.

Slots three, five, and six use open-ended PCI Express connectors, so a PCI Express x16 card can be
plugged into them.

An x16 graphics card runs at the bandwidth (x1, x4, or x8) of the slot it is plugged into.

Graphics cards greater than 75 watts require the use of a graphics cable adapter.
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Slot lane redirection
The workstation BIOS enables you to determine lane allocation for slots four and five. In the F10 (Setup)
Utility, under Advanced>Chipset/Memory>PCIe Lane Allocation, you can select these lane allocations
for slots four and five:

● Auto—Automatic mode selection

● x16:x1—Slot 4 runs in x16 mode and slot 5 runs in x1 mode

● x8:x8—Slot 4 runs in x8 mode and slot 5 runs in x8 mode

This feature offers optimum throughput automatically to your cards. For automatic lane reallocation,
select Auto.

When this option is selected, the workstation automatically re-allocates eight lanes from slot four to slot
five when a PCI-Express card less than x16 is inserted in slot four.

Inserting an x16 card in Slot four configures Slot four to an x16 mode, and Slot five to an x1 mode

To review the specific BIOS selections, refer to the Advanced and Device Options settings in The
Computer Setup (F10) Utility menu on page 25.

Card configuration restrictions for power supplies
CAUTION: To prevent damage, the overall power consumption of the system (including I/O cards,
processor, and memory) must not exceed the maximum rating of the system power supply. For power
supply information, see Power supply specifications on page 8.

The maximum graphics configuration with an 800W power supply can include two 75-watt cards (one
in slot two, one in slot four), or one 175-watt card in slot two or slot four.

If a graphics card greater than 75 watts is used, leave the adjacent slot empty and follow any additional
workstation configuration restrictions.

The maximum graphics configuration with a 1050W power supply can include up to two 175-watt cards
in slots two and four.

If a graphics card greater than 75 watts is used, leave the adjacent slot empty. The maximum graphics
power is dependent on processor and memory selections. Follow any additional workstation
configuration restrictions.

SAS rear panel cable (optional)
This section describes how to install a SAS rear panel cable and the optional mounting bracket in your
workstation.

Refer to http://www.hp.com/accessories/workstationsfor information on approved, compatible cards.

Installing the SAS rear panel cable
To install the SAS rear panel cable:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).
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3. Locate the SAS connectors by reviewing the system board layout illustration on the service label
of your workstation access panel as shown next.

Figure 4-43  System board components

4. Attach the SAS cables of the SAS rear panel cable assembly to the SAS connectors (1) on the
system board as shown in the following figure.

NOTE: If all four connectors are not available because you already have SAS devices installed,
connect the cable assembly to the remaining free connectors. Bandwidth will be proportional to the
number of connectors attached.

Figure 4-44  Attaching SAS rear panel cables

5. Place the tab of the MiniSAS 4X connector into the chassis slot, and then use a mounting screw
(2) to attach the connector to the rear of the chassis.
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6. Adhere the external SAS label to the outside of the chassis near the connector as shown next.

Figure 4-45  Attaching the label

Installing the optional SAS mounting bracket
1. Depress the PCI retention clamp clips and lift the retention clamp (1). Remove the PCI slot cover

from PCI slot one (2) as shown in the following figure.

Figure 4-46  Removing the slot cover
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2. Place the tab of the MiniSAS 4X connector into the mounting bracket slot, and then attach the
connector to the SAS mounting bracket as shown in the following figure.

Figure 4-47  Attaching the connector to the bracket

3. Install the SAS mounting bracket in slot one of the workstation (1) as shown below.

Connect the SAS cables to the SAS connectors on the system board (2), or to an approved,
compatible plug in card.

Figure 4-48  Installing the bracket and the cables
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4. Adhere the external SAS label to the outside of the SAS mounting bracket as shown in the figure
below.

Figure 4-49  Attaching the label

PCI card support
To prevent card movement during shipping, a PCI card support is installed.

Removing a PCI card support
To remove a PCI card support:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).
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3. For short or tall cards, lift the PCI support arm (1) with one hand and press in on the support sides
(2) as shown in the following figure.

Figure 4-50  Removing a PCI card support

4. Rotate the support out of the chassis (3).

Installing a PCI card support
To install the PCI card support:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).
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3. For short or tall PCI cards, attach the hooks of the PCI support in the slots on the rear of the chassis
(1) as shown in the following figure.

Figure 4-51  Installing a PCI card support bracket

4. Rotate the card support down until the support arm supports the card (2).

PCI Express cards
PCI Express I/O slots can support other PCI Express cards with less bus bandwidth than what is
physically defined for the slot. Use the following table to determine PCI Express card compatibility.

Table 4-7  HP xw8600 Workstation PCI Express compatibility matrix

Slot Mechanical compatibility Electrical compatibility

Slots 2 and 4 x1, x4, x8, x16 cards x1, x4, x8, x16 modes

Slots 3 and 6 x1, x4, x8 and x16 cards x1, x4 modes

Slot 5* x1, x4, x8, x16 cards x1, x4, x8

* The x4 and x8 electrical compatibility modes apply to slot five only if it is set up as an x8 slot.

When configured as x8, slots two, four, and five are PCIe GEN2 slots.

A PCI Express x8 slot is open ended, so a PCI Express x16 card can be plugged into it.

Graphics cards greater than 75 watts require the use of a graphics cable adapter.

Removing a PCI Express card
To remove a PCI Express card:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the PCI card support (see PCI card support on page 90).

4. Remove any cables connected to the PCI Express card.
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5. Open the PCI card retention clamp. Press the retention clamp levers down to unsnap, and then
rotate them up (1) as shown in the following figure.

Figure 4-52  Removing a PCI Express card

6. If you are removing a PCI Express high performance graphics card from slot two or four, perform
the following steps:

a. Disconnect the auxiliary power cable (not illustrated).

b. Press in on the card slot release lever (2) to release the card.

c. Lift the card out of the chassis (3).

d. Store the card in an antistatic bag.

TIP:  When removing a long card, lift it slightly out of connector, then release the card guide latch
at the front.

7. If you are removing a PCI Express card without a release lever, lift the card out of the slot.

8. Install a PCI slot cover and close the PCI retention clamp.

If the PCI retention clamp levers do not close, ensure that all cards are properly seated, and then
try again.
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Installing a PCI Express card
CAUTION: To prevent overheating, your HP xw8600 Workstation might need a front PCI fan if:

— your workstation includes dual high performance* graphics cards.

— your workstation includes a single high performance graphics card and an adjacent IO card that is
located near the inlet of the high performance graphics card fan.

If your HP xw8600 Workstation includes dual high performance graphics cards and lacks a front PCI
fan, the BIOS detects an illegal cooling configuration at boot up and reports that the front PCI fan is
missing.

Visit http://www.hp.com/go/quickspecs to learn which graphics cards are supported in your workstation,
how much memory each graphics card includes, and graphics card power requirements.

* Graphics cards that have greater than 512 MB of video memory

To install a PCI Express card:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the PCI card support (see PCI card support on page 90), if installed.

4. Open the PCI card retention clamp by pressing the retention clamp levers down to unsnap, and
then rotating them up (1) as shown in the following figure.

Figure 4-53  Installing a PCI Express card

5. Remove the PCI slot cover (2).

6. Align the PCI card keyway with the slot key, and then firmly seat the card in the slot (3).

If required by the card, connect the auxiliary power cable to the card (not illustrated).

7. Close the PCI card retention clamp by rotating the clamp downward and pressing the two green
clamp levers from the rear panel of the chassis (4).

If the PCI retention clamp levers do not close, ensure that all cards are properly seated, and then
try again.
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PCI card
This section describes removing and installing a PCI card.

Removing a PCI card
To remove a PCI card:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the PCI card support bracket (see PCI card support on page 90).

4. Remove cables connected to the PCI card.

5. Open the PCI card retention clamp by pressing the retention clamp levers down to unsnap, and
then rotating them up (1) as shown in the following figure.

Figure 4-54  Removing a PCI card

6. Lift the PCI card out of the chassis (2) and store it in an antistatic bag.

7. Install a PCI slot cover and close the PCI retention clamp.

If the PCI retention clamp levers do not close, ensure that all cards are properly seated, and then
try again.

Installing a PCI card
To install a PCI card:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the PCI card support bracket (see PCI card support on page 90).
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4. Open the PCI card retention clamp by pressing the retention clamp levers down to unsnap, and
then rotating them up (1) as shown in the following figure.

Figure 4-55  Installing a PCI card

5. Remove the PCI slot cover (2).

6. Align the PCI card keyway with the slot key, and then firmly seat the card in the slot (3).

7. Close the PCI retention clamp by rotating it downward and pressing the two green clamp levers
from the rear panel of the chassis (4).

If the PCI retention clamp levers do not close, ensure that all cards are properly seated, and then
try again.

Battery
This section describes how to remove and install the battery.

The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.

WARNING!  This workstation includes a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 60°C (140°F).

CAUTION: Before removing the battery, back up the CMOS settings in case they are lost when the
battery is removed. To back up the CMOS settings, select the Save to Diskette option in the Computer
Setup (F10) Utility.

NOTE: Do not dispose of batteries, battery packs, and accumulators with general household waste.

Removing the battery
To remove the battery:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).
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3. On the system board, press the release tab of the battery holder.

4. Rotate the battery enough to get beyond the latch, and then lift it straight up.

Installing the battery
To install the battery:

1. Confirm the polarity (positive or negative) of the battery to position it correctly in the battery holder.

2. Place the battery edge under the plastic housing tab and press gently until it snaps into place as
shown in the following figure.

Figure 4-56  Removing the battery

SAS hard drive
This section describes how to remove and install a SAS hard drive.

Removing a SAS hard drive
1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your
body to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free
mat, static strap, and peripheral units to that piece of equipment.
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3. Disconnect the power (1) and data (2) cables from the hard drive as shown in the following figure.

Figure 4-57  Disconnecting SAS hard drive cables

4. Press the green drive-lock release tabs (1), and then slide the hard drive out of the chassis (2) as
shown in the following figure.

Figure 4-58  Removing a SAS hard drive

Installing a SAS hard drive
NOTE: The HP xw8600 Workstation chassis hard drive bays can be configured to hold small form
factor (SFF) hard drives.

For SFF hard drive installation information, refer to HP xw Workstation series - Small form factor bay
converter and hard drive installation at http://www.hp.com/support/x8600_manuals.

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).
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3. Select a drive bay in which to install the drive.

If you are installing more than one hard drive, use the hard drive order shown in the following figure.

Figure 4-59  Identifying hard drive order

4. Squeeze the green tabs, and slide the rails out of the empty bay.

5. Attach the rails to the hard drive by aligning the pins on the rails with the hard drive holes, and then
snapping the rails into place as shown in the following figure.

Figure 4-60  Attaching the rails to the hard drive
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6. Attach a SAS-to-SATA cable adapter to the connector on the SAS hard drive as shown in the
following figure.

Figure 4-61  Attaching the SAS-to-SATA adapter

7. Push the drive into the selected bay until it snaps into place (1) as shown in the following figure.

Figure 4-62  Installing the SAS hard drive

8. Attach a power cable (2) to the drive, and attach a data cable (3) from a SAS connector on the
system board to the SAS hard drive.

Use lower-numbered SAS connectors first on the system board. To identify SAS connectors, refer
to the workstation service label on the side access cover.

9. Replace the side access cover.
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SATA hard drive
For more information about SATA hard drives and SATA RAID configurations, see Configuring RAID
devices on page 145.

This section describes how to remove and install a SATA hard drive.

Removing a SATA hard drive
To remove a SATA hard drive:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your
body to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free
mat, static strap, and peripheral units to that piece of equipment.

3. Disconnect the data (1) and power (2) cables from the SATA hard drive as shown in the following
figure.

Figure 4-63   Disconnecting the SATA hard drive cables
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4. Lift the green drive-lock release tab (1) and slide the hard drive out of the chassis (2) as shown in
the following figure.

Figure 4-64  Removing the SATA hard drive

Installing a SATA hard drive
NOTE: The HP xw8600 Workstation chassis hard drive bays can be configured to hold small form
factor (SFF) hard drives.

For SFF hard drive installation information, refer to HP xw Workstation series - Small form factor bay
converter and hard drive installation at http://www.hp.com/support/x8600_manuals.

To install one or two SATA hard drives:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).
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3. Select a drive bay in which to install the drive. If you are installing more than one hard drive, use
the hard drive order shown in the following figure.

Figure 4-65  Identifying hard drive order

4. Squeeze the green tabs, and slide the rails out of the empty bay.

5. Attach the rails to the hard drive by aligning the pins on the rails with the hard drive holes, and then
snapping the rails into place as shown in the following figure.

Figure 4-66  Attaching the rails to the hard drive

ENWW Removing and replacing components 103



6. Push the drive into the selected bay until it snaps into place (1) as shown in the following figure.

Figure 4-67  Installing the SAS hard drive

7. Attach a power cable (2) to the hard drive, and attach a data cable (3) from a SATA connector on
the system board to the hard drive.

Connect data cables to lower-numbered SATA connectors first on the system board. To identify
SATA connectors, refer to the workstation service label on the side access panel.

8. Replace the side access cover.

Installing a fifth hard drive (optional)
1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).
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3. Place the workstation on its side and remove the three drive screws that are located on the bottom
of the chassis as shown in the following figure.

Figure 4-68  Removing the drive screws

4. Insert the drive into bay 5, and align the holes in the bottom of the hard drive with the screw holes
at the base of the chassis.

5. Insert the screws through the base, and tighten them to secure the hard drive to the chassis.

6. For a SAS hard drive, attach a SAS-to-SATA adapter to the connector on the hard drive before
connecting the data cable.

7. Attach a data cable from the appropriate connector on the system board to the hard drive as shown
below.

Figure 4-69  Connecting the data cable

8. Connect a power cable to the drive. The power cable is a separate cable with a single connector
located in a cable clip in front of the Power Supply.

9. Replace the side access panel.
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Processor heatsink
This section describes how to remove and install a processor heatsink.

NOTE: Not all heatsinks are the same. The heatsink shown in the following figures is an example of
what might be installed in your workstation.

Removing the processor heatsink
Tall heatsinks are used in workstation configurations that include a memory riser or 120-watt or greater
processors. All other workstation configurations use short heatsinks.

To remove a heatsink:

1. Power down the workstation (see Predisassembly procedures on page 52).

2. Disconnect power from the workstation (see Predisassembly procedures on page 52).

3. Remove the side access panel (see Removing the side access panel on page 57).

4. If a memory riser assembly is installed, remove the memory riser duct (see Removing a memory
riser assembly on page 78).

5. Slowly and evenly loosen one pair of diagonally opposite screws from the processor until the screw
shanks disengage from the system board (1), and then loosen the remaining pair (2). (Refer to the
figure below.)

CAUTION: Do not fully loosen one screw, and then move on to the next. Instead, loosen all
screws a little at a time, ensuring that the processor remains level.

NOTE: The figure below illustrates a high power processor heatsink. Your workstation may
include a low power heatsink.

Figure 4-70  Identifying the proper screw loosening sequence
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6. Disconnect the processor heatsink fan cable  from the system board (1) as shown in the following
figure.

Figure 4-71  Removing the processor heatsink

7. Before lifting the heatsink, gently twist the heatsink to break the thermal compound between the
processor and the heatsink.

8. Lift the processor heatsink out of the chassis (2).

9. Use alcohol and a soft cloth to clean the thermal interface residue from the processor and the
heatsink, allowing the alcohol on the processor and processor heatsink to dry completely.

Installing the processor heatsink
To install a heatsink:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the processor heatsink (see Removing the processor heatsink on page 106).

4. Perform one of the following tasks:

● If you are reusing the original heatsink, apply thermal compound to the center of the processor
top surface.

● If you are using a new processor heatsink, do not apply thermal compound to the processor
because the new heatsink already has thermal compound applied to the heatsink surface.
Instead, remove the thermal compound protective liner from the bottom of the new heatsink.

5. Align the four mounting screws with the mounting holes in the system board and carefully place
the heatsink on the processor.

Ensure that the heatsink is placed properly with the fans positioned toward the front.

If there is no heatsink holding the board in place, ensure that the system board standoffs are all
properly engaged. Also, ensure that the board is slid to the rear so that the heatsink holes in the
system board align with the standoffs under the board.
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CAUTION: If a second heatsink is installed, do not pinch the processor 1 heatsink fan wire under
the processor 2 heatsink.

Do not overtighten the heatsink screws. If you overtighten them, you might strip the threads in the
system board tray.

Do not fully tighten one screw and then move on to the next. Instead, tighten all screws a little at
a time, ensuring that the processor remains level.

6. Tighten all screws partially so the processor heatsink remains level.

7. Tighten each set of diagonally opposed screws a little at a time to 6 in.-lbs. of torque as shown in
the following illustration.

Figure 4-72  Identifying the proper screw tightening sequence

8. Connect the processor heatsink fan connector to the system board.

9. Replace the memory riser duct, if necessary, and then replace the side access cover.

System processor
This section describes how to remove and install a system processor.

Removing a system processor
1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the processor heatsink (see Removing the processor heatsink on page 106).
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4. Raise the processor socket lever (1) and open the cover (2) as shown in the following figure.

Figure 4-73  Removing the system processor

CAUTION: Do not touch the processor socket contacts or the gold pads underneath the
processor. Use extreme care and handle the processor only by the edges.

5. Pull the processor straight out of the socket (3), and store the processor in a static free container
in a safe place where it cannot be damaged

Installing a system processor
NOTE: If installing a second processor, it must be of the same type as the first processor.

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. Remove the processor heatsink (see Removing the processor heatsink on page 106).

4. Remove the processor (see Removing a system processor on page 108).

5. Using extreme care, fully raise the processor socket lever and cover.

CAUTION: The processor socket contacts are delicate. To avoid bending the contacts, use
extreme care when installing the processor in the socket.

6. If you are adding a second processor to a single-processor system:

● Remove the plastic cover from the second processor socket.
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● If there is a plastic plug in the second processor heatsink hole, ensure that the processor
socket handle is raised (1), and remove the plug (2), as shown next.

Figure 4-74  Removing the plastic plug

7. Align the notches in the processor base with the tabs on the socket as shown in the figure below.

Seat the processor into the socket. Ensure that the underside of the processor is level with the top
of the processor socket.

Figure 4-75  Seating the processor

8. Close the processor cover plate by lightly pressing down on the processor cover plate while closing
the socket lever.

9. Replace the processor heatsink, and then close the side access cover.

System board
This section describes removing and installing the system board.
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Removing the system board
To remove the system board:

1. Disconnect power from the system (see Predisassembly procedures on page 52).

2. Remove the side access panel (see Removing the side access panel on page 57).

3. If a memory riser is installed, remove it (see Removing a memory riser assembly on page 78).

4. Remove expansion boards and graphics cards (see Removing a PCI Express card on page 92,
Removing a PCI card on page 95), and then remove the processor heatsink (see Removing the
processor heatsink on page 106).

5. If an airflow duct is installed, remove the system and memory fan assembly (see System and
memory fan assembly on page 71).

TIP: Make a note of the cable connections before disconnecting them from the system board.
For more information, refer to Power connections to system components on page 71.

6. Disconnect all cabling from the system board.

7. To disengage the metal mounting standoffs from the chassis (1), slide the system board forward
as shown in the following figure.

Figure 4-76  Removing the system board

8. Lift the system board out of the chassis, being careful not to damage the cables and rear panel
connectors (2).
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Installing the system board
To install the system board:

1. Insert the system board straight down, ensuring that all system board standoffs engage with the
keyholes in the chassis.

Ensure the system board connectors engage correctly with the rear I/O panel.

2. Push back on the board while maintaining downward pressure on the board, so all standoffs remain
engaged.

3. Reinstall all removed components and cables. (Refer to Power connections to system
components on page 71 to identify power cables.)

Product recycling
The Planet Partners recycling service provides an easy way to recycle computer equipment,
rechargeable batteries, or HP printing supplies. HP processes ensure that unwanted hardware or empty
HP printing supplies are recycled responsibly.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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5 System diagnostics and
troubleshooting

This chapter describes the tools available for diagnosing and troubleshooting system issues, and
includes these topics:

● Customer Self Help on page 113

● Troubleshooting checklist on page 134

● LED color definitions on page 134

● HP Insight Diagnostics Offline Edition on page 134

● POST error messages on page 138

Customer Self Help

Help and Support Center
The HP Help and Support Center (HSC) provides online access to technical support information,
software updates and downloads, diagnostic tools, and HP support contact information.

To open the online HSC from your desktop, select Start>Help and Support.

HSC contains the following support areas:

● HP Product Information (requires Internet access)—Links to the HP Technical Support website for
your product. You can access all related documentation, downloads and updates, tools, and more.

● HP Software and Driver Downloads (requires Internet access)—Links to software downloads and
updates for specific HP products.

● HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by
HP Instant Support Professional Edition.

● Contact HP for Support (does not require Internet access)—Provides two options:

◦ Chat with an expert online (requires Internet access)—Provides a tool to communicate with
a support specialist online through Active Chat.

◦ Call a support agent—Provides hardware details about your workstation and HP support
phone numbers worldwide.

HP SoftPaq Download Manager
The HP SoftPaq Download Manager enables you to download software updates for your workstation
from the HP support site. You can download the HP Softpaq Manager from http://h20331.www2.hp.com/
Hpsub/cache/509658-0-0-225-121.html and install it on your workstation.
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With the HP SoftPaq Download Manager installed, you can use it to download software updates for your
workstation:

1. When download manager software is installed, run the application and go to
http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html.

2. Select your workstation model, operating system, and language, and then click Find Available
SoftPaqs.

All available SoftPaqs matching the selected criteria are displayed.

3. Select the updates you want to download.

4. Select Download.

Diagnostic LED codes
Workstation beeps are emitted from the chassis speaker. The flashing lights and beeps repeat for five
cycles. After five cycles, only the flashing lights repeat.

Table 5-1  Diagnostic LED codes

Chassis indicator LEDs 

Power LED and sound
activity

Diagnosis and service action

None Workstation does not power on. Press the power button. If the hard drive LED is green,
then perform the following:

OR

1. Locate a faulty device by removing all devices one at a time:

a. Disconnect AC power to the workstation.

b. Remove the device.

c. Reconnect AC power and attempt power-on.

2. Remove the graphics card last.

3. Replace the device causing the failure.

4. If a faulty device cannot be found, replace the system board.

1. Verify that the workstation is plugged into a working AC outlet.

2. Open the access panel and verify that the power button harness is connected to
the inline front panel I/O device assembly connector.

3. Verify that the power supply cables are connected to the system board.

4. Verify power supply functionality.

a. Disconnect AC power.

b. Remove internal power supply cables from the system board.

c. Plug in AC power.

◦ If the power supply fan spins and the LED illuminates (see Testing power
supply on page 118), the power supply is good. Replace the system board.

◦ If the power supply fan does not spin or the LED does not illuminate (see
Testing power supply on page 118), replace the power supply.
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Chassis indicator LEDs 

Power LED and sound
activity

Diagnosis and service action

Blinks red 2 times (once per
second), then a 2–second
pause, and then 2 beeps

Thermal shutdown has occurred. Perform the following:

1. Ensure that the workstation air vents are not blocked.

2. Open the access panel and press the workstation power button.

3. Verify that the system fan is running.

4. Verify that the processor heatsink fan spins. If it does not spin, ensure that the fan
cable is plugged into the system board connector. Ensure that the heatsink is
properly seated.

5. Replace the processor heatsink.

Blinks red 3 times (once per
second), then a 2-second
pause, and then 3 beeps

Processor is not installed. Perform the following:

1. Install the processor.

2. Reseat the processor.

3. If the problem persists, replace the processor.

Blinks red 4 times (once per
second), then a 2-second
pause, and then 4 beeps

Power failure. Perform the following:

1. Perform the power supply self-test.

2. Open the access panel and verify that the necessary power supply cables are
connected to the system board.

3. Locate a faulty device by removing all devices, and then reinstalling them one at
a time until the workstation fails:

a. Disconnect AC power to the workstation.

b. Remove all devices.

c. Reinstall a device

d. Reconnect AC power.

4. Replace the device causing the failure.

5. Continue adding devices to ensure all are functioning properly.

6. Verify power supply functionality. Perform the following:

a. Disconnect AC power.

b. Remove all internal power supply cables from the system board.

c. Plug in AC power.

● If the power supply fan spins and the LED illuminates (see Testing
power supply on page 118), the power supply is good. Replace the
system board.

● If the power supply fan does not spin or the LED does not illuminate
(see Testing power supply on page 118), replace the power supply.

Blinks red 5 times (once per
second), then a 2-second
pause, and then 5 beeps

Pre-video memory error

1. Ensure that the memory modules are loaded correctly (Required system board
DIMM installation order on page 75).

2. Reseat memory modules.

3. Replace memory modules one at a time to find the faulty module.

Table 5-1  Diagnostic LED codes (continued)

ENWW Customer Self Help 115



Chassis indicator LEDs 

Power LED and sound
activity

Diagnosis and service action

4. Replace third-party modules with HP memory.

5. If necessary, replace the system board.

Blinks red 6 times (once per
second), then a 2-second
pause, and then 6 beeps

Pre-video graphic card error. Perform the following:

1. Reseat the graphic card and then power on the workstation.

2. Replace the graphics card.

3. If necessary, replace the system board.

Blinks red 7 times (once per
second), then a 2-second
pause, and then 7 beeps

System board failure (ROM detected a failure before video).

1. Reflash the system ROM (see ROM Flash on page 36.).

2. If necessary, replace the system board.

Blinks red 8 times (once per
second), then a 2-second
pause, and then 8 beeps

Invalid system ROM based on bad checksum. Workstation enters FailSafe (Boot Block)
recovery mode. Perform the following:

1. Reflash the system ROM (see FailSafe Boot Block ROM on page 36.).

2. If necessary, replace the system board.

Blinks red 9 times (once per
second), then a 2-second
pause, and then 9 beeps

System power is on, but workstation is unable to boot.

1. Replace the system board.

2. If necessary, replace the processor.

Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible
solutions for each.

NOTE: For Linux troubleshooting information, refer to the HP Workstations for Linux User Manual
at http://www.hp.com/support/xw8600_manuals.

Solving minor problems
Table 5-2  Minor problems

Problem Cause Possible Solution

Workstation appears frozen
and does not shut down when
the power button is pressed.

Software control of the power
switch is not functional.

1. Press and hold the power button for at least four
seconds until the workstation shuts down.

2. Disconnect the electrical plug from the outlet.

3. Restart the workstation.

Workstation seems to be
frozen.

Program in use has stopped
responding to commands.

1. If possible, use the Windows Task Manager to isolate
and terminate the offending process.

2. Attempt the normal Windows shutdown procedure.

3. Restart the workstation using the power button.

Workstation date and time
display is incorrect.

Real-time clock (RTC) battery
might need replacement.

1. Reset the date and time in the Control Panel.

2. Replace the RTC battery.

Table 5-1  Diagnostic LED codes (continued)
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Problem Cause Possible Solution

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use the Computer Setup
(F10) Utility or the Microsoft Windows Device Manager to
disable the network controller.

Cursor does not move using
the arrow keys on the keypad.

The Num Lock key might be on. Press Num Lock. The Num Lock key can be disabled or
enabled in the Computer Setup (F10) Utility.

Poor performance is
experienced.

Processor is hot. 1. Verify that airflow to the workstation is not blocked.

2. Verify that chassis fans are connected and working
properly. Some fans operate only when needed.

3. Verify that the processor heatsink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Workstation powered off
automatically and the Power
LED flashes red 2 times (once
every second), followed by a 2-
second pause, and then two
simultaneous beeps sounded.

Processor thermal protection is
activated.

A fan might be blocked or not
turning.

OR

The processor heatsink is not
properly attached to
the processor.

1. Verify that the workstation air vents are not blocked.

2. Open the access panel and press the workstation
power button.

3. Verify that the system fan is running.

4. Verify that the processor heatsink fan spins. If the fan
is not spinning, verify that the heatsink fan cable is
plugged into the system board connector and that the
heatsink is properly seated.

5. Replace the processor heatsink.

System does not power on,
and the LEDs on the front of
the workstation are not
flashing.

System cannot power on. Press and hold the power button for less than four seconds.
If the hard drive LED turns green, then perform the following
steps.

OR

1. To find a faulty device, remove all devices one at a time:

a. Disconnect AC power to the workstation.

b. Remove a device.

c. Reconnect AC power and power on the
workstation.

2. Repeat this process until the faulty device is identified.
Remove the graphics card last. Replace the faulty
device.

3. If no faulty device is found, replace the system board.

1. Press and hold the power button for less than four
seconds. If the hard drive LED does not illuminate, then
perform the following step:

2. Press and hold the power button for less than four
seconds. If the hard drive LED does not illuminate, then
perform the following tasks:

a. Verify that the workstation is plugged into a
working AC outlet.

b. Verify that the power button harness is connected
to the inline front panel I/O device assembly
connector.

Table 5-2  Minor problems (continued)
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Problem Cause Possible Solution

3. Verify that the power supply cables are connected to
the system board.

4. Verify power supply functionality:

a. Disconnect AC power.

b. Remove internal power supply cables from the
system board.

c. Plug in AC power.

● If the power supply fan spins and the BIST
LED illuminates (see Testing power supply
on page 118), the power supply is good.
Replace the system board.

● If the power supply fan does not spin or the
LED does not illuminate (see Testing power
supply on page 118), replace the power
supply.

Solving power supply problems
This section presents power supply troubleshooting scenarios.

Testing power supply

Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply
still works.

Table 5-2  Minor problems (continued)
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To test the power supply:

1. Unplug the AC power.

2. Disconnect internal power supply cables from the system board.

3. Plug in AC power and verify the following:

● If the green LED (illustrated below) on the rear of the workstation is illuminated and the fan is
spinning, the power supply is functional.

● If the green LED is not illuminated or the fan is not spinning, replace the power supply.

Figure 5-1  Testing power supply with LED

Table 5-3  Power supply problems

Problem Cause Solution

Power supply shuts down
intermittently.

Power supply fault. Replace the power supply.

Workstation powers off and the
Power LED flashes red 2 times
(once every second), followed by a
2-second pause.

Processor thermal protection
is activated.

A fan might be blocked or not
turning.

OR

The processor heatsink fan
assembly is not properly
attached to the processor.

1. Ensure that the workstation air vents are not blocked.

2. Open the access panel and press the workstation
power button.

3. Verify that the system fan is running.

4. Verify that the processor heatsink fan spins.

If the heatsink fan is not spinning, verify that the fan
cable is plugged into the system board connector.
Verify that the fan is properly seated.

5. Replace the processor heatsink.

Power LED flashes red (once every
2 seconds).

Power failure (power supply is
overloaded).

1. Determine whether a device is causing the problem
by performing the following:

a. Disconnect AC power.

b. Remove all attached devices.

c. Power on the workstation.

If the system enters the POST, perform the following:
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Problem Cause Solution

a. Power off the workstation.

b. Replace one device at a time and repeat this
procedure until a failure occurs.

c. Replace the device causing the failure

d. Continue adding devices one at a time to verify
that all devices are functioning.

2. Verify power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from
the system board.

c. Plug in AC power.

● If the power supply fan spins and the LED
illuminates (see Testing power supply
on page 118), the power supply is good.
Replace the system board.

● If the power supply fan does not spin or the
LED does not illuminate (see Testing
power supply on page 118), replace the
power supply.

Solving diskette problems
Table 5-4  Diskette problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged.
1. Right-click Start, select Explore, and then select a

drive.

2. Select File>Properties>Tools.

3. Under Error-checking, select Check Now.

Diskette is incorrectly inserted. Remove and reinsert diskette.

Files on the diskette are
damaged.

Verify the program diskettes.

Drive cable is not properly
connected.

Reconnect the power cable and verify that all four pins
are connected.

Drive not found. Cable is loose. Reseat the diskette drive data and power cables.

Removable drive is not seated
properly.

Reseat the drive.

Table 5-3  Power supply problems (continued)
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Problem Cause Solution

Diskette drive cannot write to a
diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.

Writing to the wrong drive. Verify the drive letter in the path statement.

There is not enough space on
the diskette.

Use another diskette.

Diskette write-control is
enabled.

Use the Computer Setup (F10) Utility to verify the storage
security feature disabled settings.

Diskette is damaged. Replace the damaged disk.

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, you might need to
specify diskette capacity.

For example, to format a 1.44-MB diskette, enter the
following command at the MS-DOS prompt: FORMAT
A: /F:1440

A problem has occurred with a disk
transaction.

The directory structure is bad,
or there is a problem with a file.

1. Right-click Start, select Explore, and then select a
drive.

2. Select File>Properties>Tools.

3. Under Error-checking, select Check Now.

Diskette drive cannot read
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong
diskette type for the drive type.

Verify the type of drive that you are using and use the
correct diskette type.

You are reading the wrong
drive.

Verify the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

Invalid system disk is displayed. A diskette that does not contain
the system files needed to start
the workstation has been
inserted into the drive.

When drive activity stops, remove the diskette and press
the Spacebar. The workstation attempts to boot from the
next device in the boot order.

Diskette error has occurred. Restart the workstation by pressing the power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been
disabled in Computer Setup.

Run the Computer Setup (F10) Utility and enable diskette
boot in Storage>Boot Order.

Removable media boot has
been disabled in Computer
Setup.

Run the Computer Setup (F10) Utility and enable
Removable Media Boot in Storage>Storage Options.

Diskette MBR validation is
enabled.

Run the Computer Setup (F10) Utility and disable
Diskette MBR Validation in Storage>Storage Options.

Table 5-4  Diskette problems (continued)
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Solving hard drive problems
Table 5-5  Hard drive problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad sectors or
has failed.

Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

If the drive is detected by the BIOS, run DPS Self-test.

Disk transaction problem. The directory structure is bad,
or there is a problem with a file.

1. Right-click Start, select Explore, and select a drive.

2. Select File>Properties>Tools.

3. Under Error-checking, select Check Now.

Drive not found (identified). Loose cable. Verify cable connections.

The system might not have
automatically recognized a
newly installed device.

1. Run the Computer Setup (F10) Utility.

2. If the system does not recognize the new device,
verify that the device is listed in the Computer Setup
(F10) Utility.

If it is listed, the probable cause is a driver problem. If
it is not listed, the probable cause is a hardware
problem.

3. If this drive is newly installed, enter Setup and try
adding a POST delay under Advanced>Power-On.

Drive responds slowly
immediately after power-up.

Run the Computer Setup (F10 utility, and increase the
POST Delay in Advanced>Power-On Options.

Nonsystem disk or NTLDR missing
message.

System is trying to start from a
nonbootable diskette.

Remove the diskette from the drive.

System is trying to start from a
damaged hard drive.

1. Insert a bootable diskette into the drive and restart the
workstation.

2. If the hard drive is still inaccessible and MBR Security
is enabled, try restoring the previously saved
MBR image by entering Setup and selecting
Security>Restore Master Boot Record.

System files missing or not
properly installed.

1. Insert a bootable system diskette and restart.

2. Verify that the hard drive is partitioned and formatted.

3. Install the system files for the appropriate operating
system, if necessary.

Hard drive boot disabled in
Computer Setup.

Run the Computer Setup (F10) Utility and enable the hard
drive entry in the Storage>Boot Order list.

Workstation will not start. Hard drive is damaged. Replace the hard drive.
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Solving display problems
Table 5-6  Display problems

Problem Cause Solution

Blank screen (no video). The cable connections are not
correct.

Verify the cable connections from the monitor to the
workstation and to a working electrical outlet.

The monitor is off. Turn the monitor on (LED is on). You might need to refer
to the monitor manual for an explanation of LED signals.

Screen blanking utility installed
or energy saver features
enabled.

Press a key or the mouse button and, if set, enter your
password.

System ROM is bad; system is
running in FailSafe Boot Block
mode (indicated by 8 beeps).

Reflash the ROM using a SoftPaq. (See ROM Flash
on page 36.)

Fixed-sync monitor does not
sync at the resolution
specified.

Verify that the monitor can accept the same horizontal scan
rate as the resolution specified.

Computer is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Workstation monitor settings
are not compatible with the
monitor.

1. When you see Press F8 in the bottom-right corner of
the screen, restart the workstation and press F8
during startup.

2. Using the keyboard arrow keys, select Enable VGA
Mode and then press Enter.

3. For Windows, double-click the Display icon in the
Control Panel and then select the Settings tab.

4. Use the sliding control to reset the resolution.

The display works properly during
the POST but goes blank when the
operating system starts.

The display settings in the
operating system are
incompatible with your
graphics card and monitor.

1. For Windows, restart your workstation in VGA mode.

2. After the operating system starts, change the display
settings to match those supported by your graphics
card and monitor.

3. Refer to your operating system and graphics card
documentation for information about changing display
settings.

Power LED flashes red 6 times
(once every second), followed by a
2–second pause, and then the
workstation beeps 6 times.

Prevideo graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

Monitor does not function when
used with Energy Saver features.

Monitor without Energy Saver
capabilities is being used with
Energy Saver features
enabled.

Disable the monitor Energy Saver feature.

Dim characters The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is connected to the graphics
card and the monitor.
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Problem Cause Solution

Blurry video or requested
resolution cannot be set.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit, or
download and install the latest drivers for your graphics
card from http://welcome.hp.com/country/us/en/
support.html.

Monitor cannot display
requested resolution.

Change the requested resolution.

The picture is broken up, rolls,
jitters, or flashes.

The monitor connections might
be faulty, or the monitor might
be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
workstation.

2. In a multiple CRT monitor system, ensure that the
monitors' electromagnetic fields are not interfering
with each other . Move them apart if necessary.

3. Move fluorescent lights or fans that are too close to
the CRT monitor.

Monitor must be degaussed. Degauss the monitor.

Vibrating or rattling noise coming
from inside a CRT monitor when
powered on.

Monitor degaussing coil has
been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a
CRT monitor.

Electronic relays have been
activated inside the monitor.

None. It is normal for some monitors to make a clicking
noise when turned on and off, when going in and out of
Standby mode, and when changing resolutions.

High pitched noise coming from
inside a flat-panel monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting,
or shadowing effects; horizontal
scrolling lines; faint vertical bars; or
unable to center the picture on the
screen (flat-panel monitors using
an analog VGA input connection
only.)

Flat-panel monitor’s internal
digital conversion circuits
might be unable to correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s onscreen display menu.

2. Manually synchronize the Clock and Clock Phase
onscreen display functions.

3. Download SoftPaq SP20930 or SP22333 (depending
on the monitor) to assist with the synchronization).

Some typed symbols do not appear
correctly.

The font you are using does
not support that symbol.

Use the Character Map to locate and select the appropriate
symbol.

Select Start>All Programs> Accessories>System
Tools>Character Map. You can copy the symbol from the
Character Map into a document.

Table 5-6  Display problems (continued)
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Solving audio problems
Table 5-7  Audio problems

Problem Cause Solution

Sound does not come out of the
speaker or headphones.

Software volume control is
turned down.

Double-click the Speaker icon on the taskbar and use the
volume slider to adjust the volume.

The external speakers are not
turned on.

Turn on the external speakers.

External speakers plugged into
the wrong audio jack.

See your sound card documentation for proper speaker
connection.

Digital CD audio is
not enabled.

Enable digital CD audio:

1. From the Control Panel, select System.

2. On the Hardware tab, select the Device Manager
button.

3. Right-click the CD/DVD device and select
Properties.

4. On the Properties tab, select Enable digital CD audio
for this CD-ROM device.

Headphones or devices
connected to the line-out
connector have muted the
internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external
speakers.

Volume is muted. 1. From the Control Panel, select Sound, Speech and
Audio Devices, and then select Sounds and Audio
Devices.

2. Deselect the Mute checkbox.

Computer is in Standby mode. Press the power button to resume from Standby mode.

Noise or no sound comes out of the
speakers or headphones.

1. If you are using digital speakers that have a stereo
jack and you want the system to autoswitch to digital,
use a stereo-to-mono adapter to engage the auto
sense feature, or use multimedia device properties
to switch the audio signal from analog to digital.

2. If the headphones have a mono jack, use the
multimedia device properties to switch the system to
analog out.

NOTE: If you set digital as the Output Mode, the
internal speaker and external analog speakers no
longer output audio until you switch back to an auto
sense or analog mode.

If you set analog as the Output Mode, external digital
speakers do not function until you change the output
mode back to an auto-sense or digital mode.

Sound occurs intermittently. Processor resources are being
used by other open
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked
up while recording audio.

The hard disk might be full. 1. Before recording, be sure there is enough free space
on the hard disk.

2. Try recording the audio file in a compressed format.
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Solving printer problems
Table 5-8  Printer problems

Problem Cause Solution

Printer does not print. Printer is not turned on and
online.

Turn the printer on and be sure it is online.

The correct printer driver for
the application is not installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\> [printer port]

Replace printer port with the address of the printer
used. If the printer works, reload the printer driver.

If you are on a network, you
might not have made a
connection to the printer.

Make the proper network connection to the printer.

Printer might have failed. Run printer self-test.

Printer does not turn on. The cables might not be
connected properly.

Reconnect all cables.

Printer prints garbled information. The correct printer driver is not
installed.

Install the correct printer driver for the application.

The cables might not be
connected properly.

Reconnect all cables.

Printer memory might be
overloaded.

Reset the printer by turning it off for one minute, then turn
it back on.

Printer is offline. The printer might be out of
paper.

1. Verify that the paper tray and refill it if it is empty.

2. Select Online.

Solving keyboard and mouse problems
Table 5-9  Keyboard and mouse problems

Problem Cause Solution

Keyboard commands and typing
are not recognized by the
workstation.

Keyboard connector is not
properly connected.

1. Power off the workstation.

2. Reconnect the keyboard to the back of the
workstation and restart the workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the mouse, and then
restart the workstation.

Keyboard is defective. Replace the keyboard.

Keyboard key is stuck. Remove debris from the keyboard.

Workstation is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be
on.

Press Num Lock. The Num Lock light should not be on
if you want to use the arrow keys. The Num Lock key can
be disabled or enabled in the Computer Setup (F10) Utility.
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Problem Cause Solution

Mouse does not respond to
movement or is too slow.

Mouse connector is
not properly plugged into the
back of the workstation.

1. Shut down the workstation using the keyboard.

2. Plug the mouse connector into the PS/2 mouse
connector slot in the workstation, and then restart the
workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the keyboard and then
restart the workstation.

Mouse is defective. Replace the mouse.

Workstation is in Standby
mode.

Press the power button to resume from Standby mode.

Mouse only moved vertically or
horizontally, or the movement is
jerky.

Mouse rollerball is dirty. Remove the rollerball cover from the bottom of the mouse,
clean it, and then replace cover.

Solving front panel component problems
If you are experiencing problems with a front panel port, you might be able to try your device in the
corresponding port on the back side of the computer. If this does not fix the problem, or you if must use
the front panel ports, continue troubleshooting.

Table 5-10  Front panel component problems

Problem Cause Solution

A USB device, headphone, or
microphone is not recognized by
the workstation.

The device is not properly
connected.

1. Power off the workstation.

2. Reconnect the device to the front of the workstation
and restart the workstation.

The device does not have
power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not
installed.

1. Install the correct driver for the device.

2. Reboot the workstation if required by the device
driver.

The cable from the device to
the computer does not work.

1. If possible, replace the cable.

2. Reboot the workstation.

The device is not working. 1. Replace the device.

2. Reboot the workstation.

A USB, audio, or IEEE-1394 device
is not working.

The internal cables might not
be connected to the system
board or the PCI card.

1. Power off the workstation.

2. Connect the cables correctly.

3. Reboot the workstation.

Table 5-9  Keyboard and mouse problems (continued)
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Problem Cause Solution

A device in the IEEE-1394 port is
not responsive.

Cables of the external device
are loose, or power cables are
unplugged.

Verify that all cables are properly connected.

The power switch on the
device is not turned on.

Power off the workstation, power on the external device,
then power on the workstation to integrate the device
with the workstation system.

The IEEE-1394 port is not active. The port is not there because it
was not purchased with the
system.

Obtain an IEEE 1394 PCI adapter card. Contact HP sales.

Solving hardware installation problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional
diskette drive. If you install a Plug and Play (PnP) device, the operating system recognizes the device
and configures the workstation. If you install a nonPnP device, you must reconfigure the workstation
after installing the new hardware.

Table 5-11  Hardware installation problems

Problem Cause Solution

A new device is not recognized as
part of the system.

Device is not seated or
connected properly.

Verify that the device is properly and securely connected
and that pins in the connector are not bent.

Cables of the new device are
loose, or power cables are
unplugged.

Verify that all cables are properly and securely connected
and that pins in the cable or connector are not bent.

Power switch of the new device
is not turned on.

Power off the workstation, power on the device, and then
power on the workstation to integrate the device into the
workstation system.

When the system advises you
about changes to the
configuration, you do not
accept them.

Reboot the workstation and follow the instructions for
accepting the changes.

A PnP board might not
configure when added if the
default configuration conflicts
with other devices.

Use Windows XP Device Manager to deselect the
automatic settings for the board and choose a basic
configuration that does not cause a resource conflict.

You can also use the Computer Setup (F10) Utility to
reconfigure or disable devices to resolve the resource
conflict.

Device hardware is not
properly jumpered or
otherwise configured.

Read the device-specific configuration information and
check for incorrect settings or conflicts with other devices
installed in the system.

Table 5-10  Front panel component problems (continued)
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Problem Cause Solution

Workstation does not start. Wrong memory modules were
used in the upgrade, or
memory modules were
installed in the wrong location.

1. Review the documentation that came with the system
to determine if you are using the correct memory
modules and to verify the proper installation.

2. Observe the beeps and LEDs on the front of the
workstation. To determine possible causes. see
POST error messages on page 138.

PCI Express power cable
might be plugged into the
wrong connector on the
system board.

Connect the auxiliary PCI Express power cable to the PCI
Express card.

Solving network problems
The following table provides repair suggestions for common network problems.

Table 5-12  Network problems

Problem Cause Solution

Wake-on-LAN feature is not
functioning.

Wake-on-LAN is not enabled. Use the network control application to enable Wake-on-
LAN.

Network driver does not detect
network controller.

Network controller is disabled. Run the Computer Setup (F10) Utility to enable network
controller.

Incorrect network driver. Obtain the latest driver from http://welcome.hp.com/
country/us/en/support.html.

Network status link light does not
illuminate or never flashes.

The network status light does not
flash when there is network
activity.

No active network is detected. Verify cabling and network equipment for proper
connection.

Network controller is not set up
properly.

Use the network control application to verify that the
device is working properly.

Network driver is not properly
loaded.

Reinstall network drivers.

System cannot auto-sense the
network.

Disable auto sensing capabilities and force the system
into the correct operating mode.

Diagnostics reports a failure. The cable is not securely
connected.

Be sure that both ends of the data cable are securely
connected.

The cable is attached to the
incorrect connector.

Be sure that the cable is attached to the correct connector.

There is a problem with the cable
or a device at the other end of the
cable.

Be sure that the cable and device at the other end are
operating correctly.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup (F10) Utility Advanced  menu,
change the resource settings for the board.

The network controller
is defective.

Replace the Network Interface Controller, or replace the
system board if using an onboard NIC.

Table 5-11  Hardware installation problems (continued)
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Problem Cause Solution

Diagnostics passes, but the
workstation does not
communicate with the network.

Network drivers are not loaded, or
driver parameters do not match
current configuration.

1. Verify that the network drivers are loaded and that
the driver parameters match the configuration of the
network controller.

2. Verify that the correct network client and protocol is
installed.

The network controller is not
configured for this workstation.

Double-click the Network icon in the Control Panel and
configure the network controller.

Network controller stopped
working when an expansion
board was added to the
workstation.

Network controller interrupt is
shared with an expansion board.

In the Computer Setup (F10) Utility Advanced menu,
change the resource settings for the board.

The network controller requires
drivers.

Verify that the drivers were not accidentally deleted when
the drivers for the expansion board were installed.

The expansion board installed is a
network card and conflicts with the
embedded network card.

Under the Computer Setup (F10) Advanced menu,
change the resource settings for the board.

Network controller stops working
without apparent cause.

The files containing the network
drivers are corrupted.

Reinstall the network drivers using the Restore Plus! CD,
or download and install the latest drivers from
http://welcome.hp.com/country/us/en/support.html.

The cable is not securely
connected.

Be sure that both ends of the cable are securely attached
to the correct devices.

The network controller is
defective.

Replace the Network Interface Controller, or replace the
system board when using an onboard NIC.

New network card does not boot. New network card might be
defective or might not meet
industry-standard specifications.

Install a working, industry-standard Network Interface
Controller, or change the boot sequence to boot from
another source.

Cannot connect to network
server when attempting remote
system installation.

The network controller is not
configured properly.

Verify that:

● Network connectivity is functioning

● A DHCP server is present

● Remote System Installation Server contains the
Network Interface Controller drivers for your NIC

Computer Setup (F10) Utility
reports unprogrammed
EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Solving memory problems
CAUTION: For systems that support ECC memory, HP does not support mixing ECC and nonECC
memory. The operating system does not boot with mixed-ECC memory.

Table 5-13  Memory problems

Problem Cause Solution

System does not boot (or does not
function) after installing additional
memory modules.

A memory module is not the
correct type or speed, or the
new memory module is not
seated properly.

Replace the module with the correct, industry-standard
device for the workstation.

On some models, ECC and nonECC memory modules
cannot be mixed.

Table 5-12  Network problems (continued)
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Problem Cause Solution

Out of memory error. Memory configuration might
not be set up correctly.

Verify proper workstation memory configuration. (See
Memory on page 72.)

You have run out of memory to
run the application.

Review the application documentation to determine the
memory requirements.

Memory count during POST is
wrong.

The memory modules might
not be installed correctly.

Verify that the memory modules are installed correctly and
that proper modules are used.

Insufficient memory error during
operation.

Too many Terminate and Stay
Resident (TSR) programs are
installed.

Delete TSRs that you do not need.

You have run out of memory
for the application.

Verify the memory requirements for the application or add
more memory to the workstation.

Power LED flashes red 5 times
(once every second), followed by a
2-second pause, and then the
workstation beeps 5 times.

Memory is installed incorrectly
or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving processor problems
Table 5-14  Processor problems

Problem Cause Solution

Poor performance is experienced. Processor is hot. 1. Be sure the airflow to the workstation is not blocked.

2. Be sure the fans are connected and working properly.
Some fans only operate when needed.

3. Be sure the processor heatsink is installed properly.

Power LED is red and stays on. Processor is not seated
properly or is not installed.

1. Verify that the processor is present.

2. Reseat the processor.

Solving DVD problems
Table 5-15  DVD problems

Problem Cause Solution

System does not boot from DVD
drive.

The DVD boot is not enabled
through the Computer Setup
(F10) Utility.

Run the Computer Setup (F10) Utility and enable booting
to removable media and verify boot order settings.

Nonbootable CD in drive. Try a bootable DVD in the drive.

DVD devices are not detected or
the driver is not loaded.

Drive is not connected properly
or not properly configured.

1. Reconnect power and data cables to the drive.

2. Install correct device driver.

Table 5-13  Memory problems (continued)
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Problem Cause Solution

Movie does not play in the DVD
drive.

Movie might be regionalized
for a different country.

See the documentation included with the DVD drive.

Decoder software is not
installed.

Install decoder software.

Cannot eject DVD (tray-load unit). Disc not properly seated in the
drive.

1. Power off the workstation and insert a thin metal rod
(such as a paper clip) into the emergency eject hole
and push firmly.

2. Slowly pull the tray out from the drive until the tray is
fully extended, and then remove the disc.

Optical drive cannot read a disc
or takes too long to start.

The DVD has been inserted
upside down.

Reinsert the DVD with the label facing up.

The optical drive takes longer
to start because it has to
determine the type of media
played, such as audio or video.

Wait at least 30 seconds to let the optical drive determine
the type of media being played. If the disc still does not
start, read the other solutions listed for this topic.

The DVD is dirty. Clean the DVD with a cleaning kit.

Windows does not detect the
optical drive.

1. Use Device Manager to remove or uninstall the
device.

2. Restart the workstation and allow Windows to detect
the device.

Recording audio DVDs is difficult or
impossible.

Wrong or poor-quality media
type.

1. Use a slower recording speed.

2. Verify that you are using the correct media for the
drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Table 5-15  DVD problems (continued)
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Solving Internet access problems
Table 5-16  Internet access problems

Problem Cause Solution

Unable to connect to the Internet. Internet Service Provider (ISP)
account is not set up properly.

Verify Internet settings or contact the ISP for assistance.

Modem is not set up properly. Reconnect the modem and use the quick setup
documentation to verify the connections are correct .

Web browser is not set up
properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/ DSL modem is not
plugged in.

Plug in cable/DSL modem. When properly connected, the
power LED on the front of the cable/DSL modem should be
illuminated.

Cable or DSL service is not
available or has been
interrupted because of bad
weather.

Try connecting to the Internet at a later time, or contact your
ISP. If the cable/DSL service is connected, the cable LED
light on the front of the cable/DSL modem is on.

The CAT5 10/100/1000 cable
is disconnected.

Connect the CAT5 10/100/1000 cable between the cable
modem and the workstations RJ-45 connector.

If the connection is good, the LED on the front of the cable/
DSL modem is on.

IP address is not configured
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted. 1. Select Start>Control Panel.

2. Double-click Internet Options.

3. On the General tab, select the Delete Cookies button.

Cannot automatically launch
Internet programs.

You must log on to the ISP
before some programs will
start.

Log on to the ISP and launch the desired program.

Internet takes too long to download
web sites.

Modem is not set up properly. 1. Select Start>Control Panel.

2. Double-click System, and then select the Hardware
tab.

3. In the Device Manager area, select the Device
Manager button.

4. Double-click Ports (COM & LPT).

5. Right-click the COM port that your modem uses, and
then select Properties.

6. Under Device status, verify that the modem is working
properly.

7. Under Device usage, verify that the modem is
enabled.

8. If there are further problems, select the
Troubleshoot button and follow the onscreen
instructions.
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Troubleshooting checklist
Before running diagnostic utilities, use the following checklist to find possible solutions for workstation
or software problems.

● Is the workstation and monitor connected to a working electrical outlet?

● Is the workstation powered on?

● Is the green power light illuminated?

● Is the monitor on?

● Is the green monitor light illuminated?

● If the monitor is dim, adjust the monitor brightness and contrast controls.

● Press and hold any key. If the system beeps, the keyboard is operating correctly.

● Check cables for loose or improper connections.

● After installing a non-PnP expansion board or other option (such as a diskette drive), reconfigure
the workstation.

● Are all necessary device drivers installed?

● Have all printer drivers been installed for each application?

● Have you removed diskettes and CDs from the drives before you power on the workstation?

● Are you running the latest version of BIOS, drivers, and software?

LED color definitions
The following table describes what each LED light on your workstation front panel signifies.

Table 5-17  LED color definitions

LED state LED color System status

Solid Green System is on.

Flashing Green System is in Standby.

Solid or flashing Red System has experienced an error. See Diagnostic LED
codes on page 114.

None No light System is in Hibernate, or is off.

HP Insight Diagnostics Offline Edition
The diagnostics utility enables you to perform testing and to view critical computer hardware and
software configuration information from various sources. This utility enables you to:

● Run diagnostics

● View the hardware configuration of the system
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Key features and benefits
The HP Insight Diagnostics Offline Edition simplifies the process of identifying, diagnosing, and isolating
hardware issues.

The HP Insight Diagnostics Offline Edition offers these functions:

● Testing and diagnosing apparent hardware failures

● Documenting system configurations for upgrade planning, standardization, inventory tracking,
disaster recovery, and maintenance

● Sending configuration information to another location for more in-depth analysis

Theory of operation
Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running
and software information from the system is not available to the utility.

Offline Survey is available to display the current system configuration.

The Insight Diagnostics Test feature provides the capability to test functionality of all major hardware
components in the system. The Test feature is designed with flexibility to enable you to customize test
selections by specifying different modes and types of testing.

A Quick Test provides a predetermined script where a sample of each hardware component is tested
and requires no user intervention.

A Complete Test provides a predetermined script during which each hardware component is fully tested.
You can select Interactive or Unattended tests. This changes the devices tested during the Complete
Test. More tests are available in the interactive mode, but these require user intervention.

A Custom Test provides the most flexibility in controlling the testing of a system. The Custom Test mode
enables you to specifically select which devices, tests, and test parameters are run. You can select tests
that do not require user interaction through the Interactive and Unattended tests modes.

Diagnostic utility on CD
HP Insight Diagnostics is available on the Documentation Library CD included with your workstation.

To start the diagnostic utility on the Documentation Library CD:

1. Enter the Computer Setup (F10) Utility by powering on power on your workstation and pressing
F10 during the initial boot process.

2. Select your language from the list and press Enter.

Four headings are displayed in the Computer Setup Utilities menu: File, Storage, Security, and
Advanced. There might be other headings, depending on your workstation.

3. Use the right arrow key to select Storage.

4. Use the down arrow key to select Boot Order, and then press Enter.

5. Select CD-ROM Drive, and then press F5 to enable it as a bootable device.

If the CD drive is not enabled, pressing F5 again disables it. The default setting is Enabled.

6. Set the optical drive at the top of the boot order by selecting CD-ROM, pressing the Enter key, and
then using the up arrow to move it to the top of the boot order.

7. To apply and save changes, press F10, and then select File>Save Changes and exit.
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8. Insert the Documentation Library CD into the workstation.

9. Restart your system and HP Insight Diagnostics launches automatically.

Downloading the latest diagnostic utility
1. Go to http://www.hp.com.

2. Select the Support & Drivers link.

3. Select the Download driver and software radio button.

4. Enter your product number (for example, xw8600) in the text box, and then press Enter.

5. Select your operating system.

6. Select the Diagnostic link.

7. Locate HP Insight Diagnostics Offline and select Download.

8. After the .iso file is downloaded, use CD-ROM burning software to copy the .iso file to an optical
medium.

User Interface

Navigation
The Insight Diagnostics home page contains these tabs: Survey, Test, Status, Log, and Help. These
tabs categorize the major functions of Insight Diagnostics.

Survey tab
When you select the Survey tab, the Survey menu is displayed. It enables you to view important system
configuration information.

The Summary view limits the amount of data displayed, while the Advanced view shows the data in the
selected category. Regardless of whether you choose Advanced or Summary, the following categories
of information are available on the Survey menu:

● Overview—Provides a list of general information about the computer.

● All—Provides a list of all information about the computer.

● Architecture—Displays the workstation bus type and BIOS information. In addition, if the bus is
PCI, it also displays information about the PCI configuration.

● Asset Control—Displays the serial number of the computer and provides processor information.

● Communication—Displays information about the computer parallel (LPT) and serial (COM) port
settings, USB, and network controller information.

● Graphics—Displays information about the graphics subsystem of the computer.

● Input Devices—Displays information about the type of keyboard and mouse.

● Memory—Displays information about memory in the computer, including memory on the board
and memory modules.

● Miscellaneous—Displays information obtained from the computer configuration memory (CMOS),
BIOS data area, Interrupt Vector table, and diagnostics component information.
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● Storage—Displays information about storage media connected to the computer, including fixed
disks, diskette drives, and optical drives.

● System—Displays product type, processor type and speed, coprocessor information, and
information about ROMs in the computer.

Test tab
The Insight Diagnostics utility provides the capability to test major hardware components in the
workstation. You can select from several types of tests:

● Quick Test—Provides a script that samples most hardware components and requires no user
intervention.

● Complete Test—Provides a script during which most hardware components are tested. You can
select Interactive or Unattended tests. This changes the devices tested during the Complete Test.
More tests are available in interactive mode, but these require user intervention.

● Custom Test—Provides the most flexibility in controlling the testing of a system. This mode
enables you to select which devices, tests, and test parameters to run. You can select tests that
do not require user interaction through the Interactive and Unattended test modes. More tests are
available in interactive mode, but these tests require user intervention.

To begin diagnostics testing:

1. Select the Test tab.

2. Select Type of Test to perform, select Test Mode, and then select Interactive or Unattended.

3. Choose how you want the test to be executed, either Number of Loops or Total Test Time.

● To run the test over a specified number of loops, enter the number of loops to perform.

● To run the diagnostic test for a specified time, enter the amount of time in minutes.

4. To start the test, select Begin Testing in the lower right corner of the display.

While tests are performed, you can monitor the progress by viewing the Status tab. Errors detected are
summarized in the Error Log. Select Save to save the report to a diskette or a USB key drive (if attached).

If the diagnostics utility detects an error during a test, the user can mouse-over the failed text in the
Status tab to display information about the type of error and the error code.

To view all test failure information, select Error Log.

To view the status of all testing that has been performed, select the Log tab.

Status tab
The Status tab displays the status of selected tests. The type of test executed (for example, Quick,
Complete, or Custom) is displayed. The main progress bar displays the percentage of completion of the
current set of tests. While testing is in progress, the Cancel Testing button is displayed. Select this to
cancel the test.

After testing is complete, the Cancel Testing button is replaced with the Select New Tests and Retest
buttons. Select New Teststo go back to the previous test selection page and select a new set of tests.
Select Retest to retest the last set of tests executed. This enables you to rerun a set of tests without
going back to the test selection page.
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The Status page also shows:

● Devices being tested

● Tests currently running

● Overall test time

● Individual test times

● Condition status of each test

Log tab
The Log tab consists of the following views.

Test Log—Displays all tests that have been executed, the number of times a test was executed, the
number of times a test failed, and the time it took to complete the test.

The Clear Test Log button clears the contents of the Test Log.

Error Log—Displays the tests that have failed during diagnostic testing. In addition to displaying the
device and test, this section might also include error details. The description section describes the error
that the diagnostic test found. The Recommended Repair section gives a recommended action you
should perform to resolve the hardware problem. The error count is the number of times the test has
failed. The Clear Error Log button clears the contents of the Error Log.

Help tab
The Help tab provides these views:

● HP Insight Diagnostics—Provides introductory and detailed information about Insight Field
Diagnostics.

● Error Codes—Provides error code listings, including devices tested, messages, and
recommended repair information.

● Test Components—Reloads and refreshes all components and displays component details after
the refresh.

POST error messages
Power On Self Test (POST) is a program run at startup that initializes and runs tests on installed
hardware. An audible and/or visual message appears if the POST encounters a problem. POST checks
the following items to ensure that the workstation system is functioning properly:

NOTE: If the power-on password is set, a key icon appears on the screen while POST is running. You
must enter the password before continuing.

Table 5-18  POST error messages 

Screen message Probable cause Recommended action

101—Option ROM Error System ROM checksum. Verify the correct ROM:

1. Flash the ROM, if needed.

2. If an expansion card was recently added, remove
it to find out if the problem remains.
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Screen message Probable cause Recommended action

3. Clear CMOS. If the message disappears, there
might be a problem with the expansion card

4. Replace the system board.

102—System Board Failure DMA, timers, and so forth, might be set
improperly or might be defective.

1. Clear the CMOS.

2. Remove the expansion boards.

3. Replace the system board.

110—Out of Memory for
Option ROMs

Option ROM for a device could not run
because of memory constraints.

Run the Computer Setup (F10) Utility to disable
unneeded option ROMs, and to enable ACP0/USB
Buffers at Top of Memory under the Advanced>Power-
On options.

163—Time and Date Not Set ● Invalid time or date in
configuration memory.

● RTC battery might need
replacement.

● CMOS jumper might not be
properly installed.

1. Set the date and time from the Control Panel or in
the Computer Setup (F10) Utility (depending on
the operating system).

2. If the problem persists, replace the RTC battery.

164—Memory Size Error Memory configuration is incorrect. 1. Run the Computer Setup (F10) Utility or the
Windows utilities.

2. Verify that the memory modules are installed
properly.

3. If third-party memory has been added, test the
memory configuration using HP memory.

4. Verify the memory module type.

201—Memory Error RAM failure. 1. Run the Computer Setup (F10) utiltiy or the
Windows utilities.

2. Be sure that memory and continuity modules are
installed correctly.

3. Verify the memory module type.

4. Remove and replace memory modules one at a
time to isolate faulty modules.

5. Replace faulty memory modules.

6. If the error persists after replacing memory
modules, replace the system board.

202—Memory Type Mismatch Memory modules do not match. Replace the memory modules with matched sets.

203—Memory module failed
self-test and failing rank was
disabled

Defective memory module. Replace the memory module.

204—Memory loaded
incorrectly

Improper module load. Reseat the memory module correctly.

205—Memory high
temperature detected

Insufficient memory module cooling. Verify that a memory module cooling fan is installed and
operating.

206—Memory setup invalid Memory configured incorrectly. Reconfigure the memory modules in the proper slots.

Table 5-18  POST error messages  (continued)
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Screen message Probable cause Recommended action

207—Incompatible memory
modules detected

Single-bit ECC error. 1. Verify the memory module type.

2. Insert the DIMM in another memory socket.

3. Replace the memory module if the problem
persists.

208—Two-DIMM
configurations use slots one
and five

DIMMs are loaded in incorrect slots for
a two-DIMM configuration.

Verify that the two DIMMs are installed in slots one and
five only.

209—Incompatible memory
(FBDs) detected

Incorrect memory module type in use. Verify that the memory modules are compatible with
workstation requirements.

210—Mismatched memory
(AMBs) detected

Different memory module types are
matched.

Verify that compatible memory module types are used
in matched pairs.

211—Memory warning
condition detected

Improper or defective memory module. Replace the memory module.

212—Failed Processor Processor has failed to initialize. 1. Reseat the processor in its socket.

2. If the processor does not respond, replace it.

213—Incompatible Memory
Modules

A memory module in the memory
socket identified in the error message
is missing critical SPD information, or
is incompatible with the chipset.

1. Verify the memory module type.

2. Insert the DIMM in another memory socket.

3. Replace the module with a DIM conforming to the
SPD standard.

214—DIMM Configuration
Warning

DIMMs are not installed correctly (not
paired correctly).

See the service label on the workstation access panel
for the correct memory configurations, and reseat the
DIMMs accordingly.

216—Memory Size Exceeds
Maximum Supported

The amount of memory installed
exceeds that supported by the
hardware.

1. Verify how much memory your system supports.

2. Remove the excess memory.

301—Keyboard Error Keyboard failure. 1. Reconnect the keyboard with the workstation
powered off.

2. Check the connector for bent or missing pins.

3. Be sure that none of the keys are pressed.

4. Replace the keyboard.

303—Keyboard Controller
Error

I/O board keyboard controller is
defective or is not set properly.

1. Reconnect the keyboard with the workstation
powered  off.

2. Replace the system board.

304—Keyboard or System
Unit Error

Keyboard failure. 1. Reconnect the keyboard with the workstation
powered off.

2. Be sure that none of the keys are pressed.

3. Replace keyboard.

4. Replace system board.

510—Splash Screen image
corrupted

Splash Screen image has errors. Update system BIOS.

Table 5-18  POST error messages  (continued)
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Screen message Probable cause Recommended action

511—CPU. CPU A, or CPU B
Fan not detected

Fan is not connected or is defective. 1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.

512—Chassis, rear chassis, or
front chassis fan not detected

Fan is not connected or it might be
defective.

1. Reseat the chassis, rear chassis, or front chassis
fan cable.

2. Reseat the chassis, rear chassis, or front
chassis fan.

3. Replace the chassis, rear chassis, or front
chassis fan.

513—Memory fan not
detected

Missing or disconnected memory fan. 1. Ensure the memory fan is installed.

2. Ensure proper memory fan connections.

514—CPU or Chassis Fan not
detected

CPU or chassis fan is missing, is not
connected, or is defective.

1. Verify that the processor or chassis fan is installed
and connected properly.

2. Replace the processor fan or the chassis fan.

515—CPU Overtemp ocurrred Insufficient processor cooling or
processor defect.

1. If necessary, add a heatsink to the processor and
ensure proper operation.

2. Replace the processor.

516—PCI fan not detected Missing PCI fan or disconnected fan
cable.

● Add a PCI fan if necessary.

● Verify proper PCI fan cable connection and
operation.

517—Low power CPU
heatsink(s) detected for high
power CPUs

Inadequate heatsink is installed. Replace the low power heatsink with a high power
heatsink.

518—Power supply wattage
insufficient for hardware
configuration

Workstation configuration requires
more power than the power supply can
provide.

● Reduce the workstation power consumption.

● Replace the power supply with a high output
power supply.

601—Diskette Controller Error Diskette controller circuitry or diskette
drive circuitry incorrect.

1. Run the Computer Setup (F10) utility.

2. Verify cabling and replace defective cables if
necessary.

3. Clear CMOS.

4. Replace the diskette drive.

5. Replace the system board.

605—Diskette Drive Type
Error

Mismatch in drive type. 1. Run the Computer Setup (F10) Utility.

2. Disconnect any other diskette controller devices
(tape drives).

3. Clear the CMOS.

610—External Storage Device
Failure

External storage device is not
detected, is improperly connected, or
is defective.

1. Verify that the external device is present and
connected properly.

2. Replace the external device.

Table 5-18  POST error messages  (continued)
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Screen message Probable cause Recommended action

912—Computer Cover Has
Been Removed Since Last
System Start Up

N/A No action required.

914— Hood Lock Coil is not
Connected

Mechanism is missing or is not
connected.

1. Reconnect or replace the missing mechanism.

2. Reseat or replace the missing mechanism cable.

917—Front Audio Not
Connected

Mechanism is missing or is not
connected.

1. Reconnect or replace the missing mechanism.

2. Reseat or replace the missing mechanism cable.

918—Front USB Not
Connected

Mechanism is missing or is not
connected.

1. Reconnect or replace the missing mechanism.

2. Reseat or replace the missing mechanism cable.

919—Multi-Bay Riser Not
Connected

Mechanism is missing or is not
connected.

1. Reconnect or replace the missing mechanism.

2. Reseat or replace the missing mechanism cable.

921—Device in PCI Express
Slot failed to initialize

Missing, improperly seated, or
defective card.

1. Verify that the card is installed.

2. Reseat the card.

3. Replace the card.

922—Fatal error in slot # Fatal error occurred in the designated
slot.

Move the card to a different slot. If the problem persists,
replace the card.

923—Non fatal uncorrectable
PCI error in slot #

A PCI or PCIe nonfatal error occurred
for the card in the designated slot.

Move the card to a different slot. If the problem persists,
replace the card.

924—Non fatal correctable
PCI error

A PCI or PCIe nonfatal error occurred
for the card in the designated slot.

Contact HP support.

925—Non fatal uncorrectable
ESI error

Nonfatal, uncorrectable ESI error on
slot # occurred.

Contact HP support.

926—Non fatal correctable
ESI error

Nonfatal, correctable ESI error on slot
# occurred.

Contact HP support.

927—Non fatal FSB error Nonfatal FSB error on FSB # occurred. Contact HP support.

928—Non fatal uncorrectable
FBD error

Nonfatal, uncorrectable FBD error on
DIMM # occurred.

Contact HP support.

929–Non fatal correctable
FBD error

Nonfatal, correctable FBD error on
(DIMM is identified).

Contact HP support.

930–Non fatal internal
Northbridge error

Nonfatal, Internal Northbridge error. Contact HP support.

1720—SMART Hard Drive
Detect Imminent Failure

Hard drive is about to fail. (Some hard
drives have a firmware patch that fixes
erroneous error messages.)

1. Determine if the hard drive is giving a correct error
message.

2. Run the Drive Protection System test (if
applicable).

3. Apply firmware patch (if applicable).
See  http://www.hp.com/support.

4. Back up contents and replace the hard drive.

1783—Fixed Disk 0/1 locked Hard disk drive failure. Diagnose the hard drive, and replace it if necessary.

Table 5-18  POST error messages  (continued)
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Screen message Probable cause Recommended action

1794—Inaccessible devices
attached to SATA 1 and/or
SATA 3

Missing or improperly attached cable. Verify that a cable is attached. Reattach the cable.

1796—SATA Cabling Error Missing or improperly attached cable. Verify that a cable is attached. Reattach the cable.

1801—Microcode Patch Error Processor not supported by ROM
BIOS.

Upgrade BIOS to proper version.

1802—Processor Not
Supported

The system board does not support the
processor.

Replace the processor with a compatible one.

ERROR: An unsupported
processor is installed. System
halted

Unsupported processor detected. Replace the processor.

ERROR: A processor requiring
too much power is installed.
System halted

Unsupported processor detected. Replace the processor.

ERROR: Mixing processors
with different power
requirements. This is not
supported. System halted.

Mixed type processors detected. Replace the processors with matched processors.

Invalid electronic serial
number

Incorrect serial number registered in
the system.

Use the Computer Setup (F10) Utility to reset the serial
number.

Mixing processors with
different power requirements.
This is not supported. System
halted.

Mixed type processors detected. Replace the processors with matched processors.

Mixing Two Different
Processor Types MP and DP!!!

Mixed type processors detected. Replace the processors with matched processors.

Network Server Mode Active
and No Keyboard Attached

Keyboard not detected. Verify that a functioning keyboard is attached to the
workstation.

Processor initialization fails!!! Processor defective. Replace the processor.

The installed CPUs have
different voltage requirements.
This is not supported. System
halted.

Mixed type processors detected. Replace processors with matched processors.

Two processors do not have
the same frequency operating
ranges!!!

Mixed type processors detected. Replace processors with matched processors.

Table 5-18  POST error messages  (continued)
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6 Configuring RAID devices

This chapter describes how to configure SAS and SATA RAID devices:

● Configuring SAS RAID devices on page 145

● Configuring SATA RAID devices on page 147

For additional information about configuring RAIDs, see http://www.hp.com/support/RAID_FAQs. For
information about preparing your workstation for RAID configuration, see http://www.hp.com/support/
workstation_manuals.

Configuring SAS RAID devices

Supported configurations
The following RAID configurations are supported on HP xw8600 Workstations:

NOTE:  This section does not apply to configuring SAS RAID in the Linux environment. For Linux SAS
RAID information, including supported configurations, refer to Installing and Configuring SAS Hardware
RAID on HP Linux Workstations at http://www.hp.com/support/xw8600_manuals.

● Up to five internal SAS hard disk drives

● SAS-to-SATA data and power converter

● LSI MegaRAID Storage Manager (MSM) for Windows

The following RAID configurations are supported on HP xw8600 Workstations:

● RAID 0 – Striped disk array

◦ Two drive minimum

◦ Improved I/O performance

◦ No fault tolerance

● RAID 1 — Mirrored disk array

◦ Two drives

◦ 100% redundancy

◦ Can recover from single drive failure

◦ Improved read performance

● RAID 1E

◦ Two drives minimum

◦ Can be an odd number of drives

◦ Can always recover from a single drive failure and, in some cases, can recover from two drive
failures
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SAS RAID 0 configuration
Use the following procedure configure an Integrated Striped (IS) volume with the BIOS-based
configuration utility. The procedure assumes that the system has the required disks and disk controllers.

1. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

2. Press Enter to go to the Adapter Properties screen.

3. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and press
Enter to go to the RAID Properties screen.

4. In the RAID Properties screen, use the arrow keys to select the first disk for the IS volume. Then
use the arrow keys to move to the Array Disk column for this disk, and press Space and + or - to
select Yes as the value for this column.

If partitions are defined on the selected disk, a message appears warning you that data on the disk
will be lost when the striped volume is created.

5. Press M to migrate, or D to delete the data on the drive.

6. To select up to three more disks for the striped volume, repeat the previous steps.

7. After you choose all drives, press C to create the array once, and then press Esc and select
Save. 

SAS RAID 1 configuration
Use the following procedure to configure an Integrated Mirroring (IM) volume with the BIOS-based
configuration utility. The procedure assumes that the system has the required disks and disk controllers.

1. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

2. Press Enter to go to the Adapter Properties screen.

3. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and then
press Enter to go to the RAID Properties screen

4. Configure a two-disk mirrored volume with an optional hot spare disk:

a. In the RAID Properties screen, use the arrow keys to select the primary disk for the IM volume
(the disk with the data you want to mirror.)

b. Use the arrow keys to move to the Array Disk column for this disk and press Space to
select Yes as the value.

If partitions are defined on the selected disk, a message appears warning you that data on
the disk will be lost when the striped volume is created.

c. Press M to migrate or D to delete the data on the drive.

d. When the Keep Data/Erase Disk message appears, press F3 to keep the data on this disk.

The value in the Array Disk column changes to Primary.

e. Use the arrow keys to select the secondary (mirrored) disk for the IM volume, and then
select Yes as the value for the Array Disk column.

If partitions are defined on this disk, a message warns that data on the disk will be lost when
the mirrored volume is created.

f. Press Delete to confirm erasing data from the disk, or press any other key to deselect the
disk.
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SAS RAID 1E configuration
Use the following procedure to configure an Integrated Mirroring Extended (IME) volume with the BIOS-
based configuration utility. The procedure assumes that the system has the required disk and disk
controllers.

1. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

2. Press Enter to go to the Adapter Properties screen.

3. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and then
press Enter to go to the RAID Properties screen.

4. To configure a mirrored volume with three to six disks, or three to five disks with an optional hot
spare disk, do the following:

a. In the RAID Properties screen, use the arrow keys to select the first disk for the IME volume.

b. Use the arrow keys to move to the Array Disk column for this disk, and then use the + or -
keys to select Yes as the value.

c. When the Keep Data/Erase Disk message appears, press Delete to erase the disk.

d. Use the arrow keys to select the next disk for the IME volume, and then select Yes as the
value for the Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk.

e. Repeat the previous steps to select up to four more disks for the IME volume.

If you want to configure a hot spare disk for the volume, you can only select up to three more
disks.

5. (Optional) Use the arrow keys to select a hot spare disk for the IME volume, and then select Yes
as the value for the Hot Spare column.

6. After you select all disks for the IME volume, press Esc and select Save changes, then exit this
menu.

The IME volume exists when you save the changes. The RAID Properties screen displays the IME
volume properties and status.

7. If you do not want to create the IME volume, select Discard changes, then exit this menu.

Configuring SATA RAID devices
This section describes how to use the Intel Matrix Storage Manager option ROM Configuration utility to
set up and manage SATA RAID volumes.

The following SATA RAID configurations are supported on HP xw8600 Workstations:

● Up to five internal SATA hard disk drives

● Up to two eSATA drives if you use an optional eSATA cable

● Intel Matrix Storage Manager (MSM) for Windows

If only a single HDD is attached, the Intel Matrix Storage Manager option ROM does not execute.
Associated messages are not displayed.
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The Intel SATA AHCI BIOS executes when you select RAID/AHCI for the SATA emulation mode. This
BIOS is only used to support serial-attached optical drives.

This section does not apply to configuring SATA RAID in the Linux environment. For Linux SATA RAID,
refer to the Software RAID in Linux Workstations section in the HP Workstations for Linux User Guide
at http://www.hp.com/support/linux_user_manual.

Attaching SATA HDDs
Attach the required minimum number of SATA hard drives for the desired RAID level:

● RAID 0: two hard drives

● RAID 1: two hard drives

● RAID 5: three hard drives

● RAID 10: four hard drives

Configuring system BIOS
Configure the system BIOS to enable embedded SATA RAID functionality.

1. To enter the system BIOS setup, press F10.

2. Use the arrow keys to highlight the desired language, and then press Enter.

3. Use the arrows to highlight Storage>Storage Options, and then press Enter.

4. Use the up or down arrow key to highlight SATA Emulation.

5. Use the left or right arrow key to select RAID/AHCI.

6. To accept the new setting, press F10.

7. Use the arrows to highlight Advanced>Power-On Options, and then press Enter.

8. Use the up or down arrow key to highlight POST Messages.

9. Use the left or right arrow key to select Enable.

10. To accept the new setting, press F10.

11. Use the arrow keys to highlight Advanced>Device Options, and then press Enter.

12. Use the up or down arrow key to highlight SATA RAID Option ROM Download, and then press
Enter.

13. Use the left or right arrow key to select Enable.

14. To accept the new setting, press F10.

15. Use the arrows to highlight File>Save Changes and Exit, and then press Enter.

16. Press F10 when prompted.
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Creating RAID volumes
To create RAID volumes, use the Intel Matrix Storage Manager option ROM Configuration utility.

1. To enter the Intel Matrix Storage Manager option ROM Configuration utility, press Ctrl+l when
prompted

2. If required, see Deleting RAID volumes on page 149 to make enough physical drives available to
create the RAID volume.

3. Use the up or down arrow key to highlight 1. Create RAID Volume, and then press Enter.

4. Type the desired RAID volume name in the “Name:” field, and then press Tab.

5. Use the up or down arrow key to select the RAID level in the RAID Level: field, and then press
Tab.

6. To display the Select Disks dialog, press Enter.

7. Use the up and down arrow keys and Space to mark individual physical disks as members of the
volume.

8. To exit the Select Disks dialog and return to the Create Volume Menu dialog, press Enter.

9. If appropriate, use the up or down arrow key to select the Strip Size in the Strip Size: field, and
then press Tab.

10. Enter the desired volume size in the Capacity: field, and then press Tab.

11. Press Enter to initiate volume creation.

12. When prompted, press Y to acknowledge the warning message and create the volume.

13. Return to step 3 to create additional RAID volumes, or use the up or down arrow key to highlight
4. Exit, and then press Enter.

14. Press Y when prompted to confirm the exit.

Deleting RAID volumes
Use the Intel Matrix Storage Manager option ROM Configuration utility to delete RAID volumes.

1. Use the up or down arrow key to highlight 2. Delete RAID Volume, and then press Enter.

2. Use the up or down arrow key to highlight the RAID volume to be deleted, and then press
Delete.

3. When prompted, press Y to confirm the deletion of the selected RAID volume.

4. Choose one of the following actions:

● Return to Step 1 to delete additional RAID volumes.

● To create RAID volumes, see Creating RAID volumes on page 149.

● Use the up or down arrow key to highlight 4. Exit, and then press Enter.

● Use the up or down arrow key to highlight 3. Reset Disks to Non-RAID, and then press
Enter.

5. Use the up and down arrow keys and Space to mark individual physical disks to be reset.

6. Press Enter to complete the selection.
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7. When prompted, press Y to confirm the reset action.

8. Choose one of the following actions:

● To delete additional RAID volumes, return to Step 1.

● To create RAID volumes, see Creating RAID volumes on page 149.

● Use the up or down arrow key to highlight 4. Exit, and then press Enter.
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7 Configuring password security and
resetting CMOS

This chapter describes how to configure password security and to reset CMOS, and includes these
topics:

● Preparing to configure passwords on page 151

● Resetting the password jumper on page 152

● Clearing and Resetting the CMOS on page 152

Preparing to configure passwords
The Computer Setup (F10) Utility enables you to create setup and power-on passwords.

There are three possibilities for setting passwords:

● Define a setup password only

● Define a power-on password only

● Define both

When defining a setup password only, you cannot enter the setup utility without the password.

No password is needed to boot from power-on.

When defining a power-on password only, the power-on password is needed to enter F10 Setup
or to boot from power-on.

When defining both, the setup password is needed to enter F10 setup and can be used to boot
from power-on.

The power-on password cannot be used to enter the F10 Setup Utility, but it can be used to boot
from power-on.

One of the passwords will be required to boot from power on.

After you create both passwords, you can use the setup password in place of the power-on password
as an override to log into the workstation (a useful feature for a network administrator).

NOTE: You can only clear the passwords with the password jumper. Clearing CMOS does not clear
the passwords.

CAUTION: Before pressing the Clear CMOS button, back up your workstation CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized
information, including passwords, asset numbers, and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to Diskette from
the File menu.
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Resetting the password jumper
Use the following procedure to disable the power-on or setup password features and clear the power-
on and setup passwords.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to
disconnect the power cord from the wall outlet and allow the internal system components to cool before
touching.

CAUTION: When the workstation is plugged in, the power supply has voltage applied to the system
board, even when the workstation is turned off. Failure to disconnect the power cord can result in
damage to the system.

CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Shut down the operating system, power off the workstation and external devices, and disconnect
the workstation power cord and external devices from power outlets.

2. Disconnect the keyboard, monitor, and other external devices that are connected to the
workstation.

3. Remove the access panel.

4. Locate the password header and jumper.

The password header is E49.

5. Verify that the AC power cord is disconnected from the power outlet.

The password jumper is green so it can be easily identified.

6. Remove the jumper from pins 1 and 2, then replace it.

NOTE: You have to reboot to at least the point where you get video before you can shut down
again and replace the jumper to clear the passwords.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Connect AC power to the workstation, power on the workstation, and then boot to the F10 (Setup)
Utility.

10. To create new passwords, repeat steps 1 through 8, and then create the new passwords using the
F10 (Setup) Utility.

Clearing and Resetting the CMOS
This section describes the steps necessary to successfully clear and reset the CMOS. The CMOS of
the workstation stores password information and information about the workstation configuration.

Using the CMOS Button
To clear CMOS using the Clear CMOS button, use the following procedure:

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.
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CAUTION: When the workstation is plugged in, the power supply has voltage applied to the system
board, even when the workstation is powered off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the workstation or optional equipment. Before
beginning these procedures, be sure that you are discharged of static electricity by briefly touching a
grounded metal object.

1. Shut down the operating system, power off the workstation and any external devices, and then
disconnect the workstation power cord and external devices from power outlets.

2. Disconnect the keyboard, monitor, and other external devices that are connected to the
workstation.

3. Remove the access panel.

CAUTION: Before pressing the Clear CMOS button, back up your workstation CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized
information, including passwords, asset numbers, and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to
Diskette from the File menu.

4. Locate, press, and hold the CMOS button for five seconds.

NOTE: Verify that the AC power cord is disconnected from the power outlet.

The CMOS button does not clear CMOS if the power cord is connected.

For assistance locating the CMOS button and other system board components, see System board
components on page 52.

5. Replace the access panel.

6. Reconnect external devices.

7. Plug in and power on the workstation.

8. Reset the workstation passwords and configuration information, such as the system date and time.

The workstation powers up for three to five seconds, then powers down.

Using the Computer Setup (F10) Utility to Reset CMOS
1. Access the Computer Setup (F10) Utility menu.

2. When the Computer Setup message appears in the lower-right corner of the screen, press F10,
and then press Enter to bypass the title screen, if necessary.

If you do not press F10 while the message is displayed, the workstation must be rebooted to access
this utility.

3. From the Computer Setup (F10) Utility menu, select File>Default Setup.

This restores the settings that include boot sequence order and other factory settings. However, it
does not force hardware rediscovery.

4. Choose Restore Factory Settings as Default, and the press F10 to accept.

5. Select File->Apply Defaults and Exit, and then press F10 to accept.

6. Reset the workstation passwords and configuration information, such as the system date and time.
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NOTE: This step does not clear the passwords.
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A Appendix A—Connector pins

Connector pin descriptions
Not all of these connectors might be installed in your workstation.

Rear panel PS2 keyboard connector Pin Signal

1

2

3

4

5

6

Data

Unused

Ground

+5 VDC

Clock

Unused

 

Rear panel PS2 mouse connector Pin Signal

1

2

3

4

5

6

Data

Unused

Ground

+5 VDC

Clock

Unused

 

Rear panel RJ45 Ethernet connector Pin 10/100-Mb Signal 1000-Mb signal

1

2

3

4

5

6

7

8

(+) Transmit Data

(-) Transmit Data

(+) Receive Data

Unused

Unused

(-) Receive Data

Unused

Unused

TX/RX

TX/RX

TX/RX

TX/RX

TX/RX

TX/RX

TX/RX

TX/RX

0

0

1

2

2

1

3

3

+

-

+

+

-

-

+

-
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Rear panel RS-232 serial connector Pin Signal

1

2

3

4

5

6

7

8

9

Carrier Detect

Receive Data

Transmit Data

Data Terminal Ready

Signal Ground

Data Set Ready

Request to Send

Clear to Send

Ring Indicator

 

Front/rear panel (internal Type A) USB connector Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

Ground

Front/rear IEEE 1394a connector Pin Signal

1

2

3

4

5

6

Power

GND

TPB-

TPB+

TPA-

TPA+

Internal IEEE 1394b connector Pin Signal

1

2

3

4

5

6

7

8

TPB-

TPB+

TPA-

TPA+

TPA (R)

VG

SC

VP
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9 TPB (R)

Front/rear panel microphone cable connector (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio Left/Power

Audio Right/Power

Ground

Front panel headphone cable connector (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio Left

Audio Right

Ground

Rear panel line-in audio cable connector (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio In Left

Audio In Right

Ground

Rear panel line-out audio cable connector (1/8 inch) Pin Signal

1 (Tip)

2 (Ring)

3 (Shield)

Audio Out Left

Audio Out Right

Ground

SATA drive connector

Data Cable Power Cable Power Cable

Pin Signal Pin Signal Pin Signal

S1

S2*

S3*

S4

Ground

A+

A-

Ground

P1

P2

P3

P4

3.3V power

3.3V power

3.3V power

Ground

P8

P9

P10

P11

5V power

5V power

Ground

Reserved
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SATA drive connector

Data Cable Power Cable Power Cable

Pin Signal Pin Signal Pin Signal

S5**

S6**

S7

B-

B+

Ground

P5

P6

P7

Ground

Ground

5V power

P12

P13

P14

P15

Ground

12V power

12V power

12V power

* S2 and S3 differential signal pair

**S5 and S6 differential signal pair

SAS drive connector

Segment Pin Backplane receptacle Plug and cable receptacles

Primary signal segment S1

S2

S3

S4

S5

S6

S7

SIGNAL GND

TP+

TP-

SIGNAL GND

RP-

RP+

SIGNAL GND

SIGNAL GND

RP+

RP-

SIGNAL GND

TP-

TP+

SIGNAL GND

Secondary signal segment S8

S9

S10

S11

S12

S13

S14

SIGNAL GND

TS+

TS-

SIGNAL GND

RS-

RS+

SIGNAL GND

SIGNAL GND

RS+

RS-

SIGNAL GND

TS-

TS+

SIGNAL GND

Power segment P1

P2

P3

P4

V33
c

V33
c

V33
c precharge c

GROUND
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SAS drive connector

Segment Pin Backplane receptacle Plug and cable receptacles

P5

P6

P7

P8

P9

P10

P11

P12

P13

P14

P15

GROUND

GROUND

V5
c precharge c

V5
c

V5
c

GROUND

READY LED d

GROUND

V12 precharge c

V12
c

V12
c

VGA connector

Pin Signal Pin Signal Pin Signal

1

2

3

4

5

Red Analog

Green Analog

Blue Analog

Monitor ID

GND

6

7

8

9

10

GND

GND

GND

+5 VDC

GND

11

12

13

14

15

Monitor ID

DDC Serial Data

Horizontal Sync

Vertical Sync

DDC Serial Clock

 

DVI-I cable connector

Pin Signal Pin Signal

1 T.M.D.S DATA 2- 16 HOT PLUG DETECT
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DVI-I cable connector

2

3

4

5

6

7

8

9

10

11

12

13

14

15

T.M.D.S DATA 2+

T.M.D.S DATA 2/4 SHIELD

T.M.D.S DATA 4-

T.M.D.S DATA 4+ 2

DDC CLOCK

DDC DATA

ANALOG VERT. SYNC

T.M.D.S DATA 1-

T.M.D.S DATA 1+

T.M.D.S DATA 1/3 SHIELD

T.M.D.S DATA 3-

T.M.D.S DATA 3+

+5V POWER

GND

17

18

19

20

21

22

23

24

C1

C2

C3

C4

C5

T.M.D.S DATA 0-

T.M.D.S DATA 0+

T.M.D.S DATA 0/5 SHIELD

T.M.D.S DATA 5-

T.M.D.S DATA 5+

T.M.D.S CLOCK SHIELD

T.M.D.S CLOCK+

T.M.D.S CLOCK-

ANALOG RED

ANALOG GREEN

ANALOG BLUE

ANALOG HORZ SYNC

ANALOG GROUND

P1 Main power 24-pin system board connector

Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

6

+3.3V

+3.3V

GND

No load

GND

+5V

7

8

9

10

11

12

GND

POK

+5 VSB

+12 V-B

+12 V-B

No load

13

14

15

16

17

18

+3.3V

-12V

GND

PS_ON_L

GND

No load

19

20

21

22

23

24

GND

PS_ID*

+5V

+5V

No load

GND

* GND on 1050W power supply; unused on 800W power supply.
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P18 Memory riser power 10–pin cable connector*

Pin Color Signal Pin Color Signal

1

2

3

4

5

Black

Black

Black with purple stripe

Black

Black

GND

GND

5 VSB

GND

GND

6

7

8

9

10

Black with yellow stripe

Black with yellow stripe

Black with purple stripe

Black with yellow stripe

Black with yellow stripe

V 12-D

V 12-R

V 5SB

V 12-R

V 12-R

* Used with 1050–watt power supply only.

P3 CPU power 8-pin system board connector Pin Signal

1

2

3

4

5

6

7

8

GND

GND

GND

GND

V12-CPU0

V12-CPU0

V12-CPU1

V12-CPU1

P2 Memory power 6-pin system board connector Pin Signal

1

2

3

4

5

6

V12-D

GND

GND

V12-M

GND

V12-M
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PCI Express auxiliary power 6-pin cable connector Pin Color 800W
P16
P17

1050W P16 1050W P17

1

2

3

4

5

6

Yellow

Yellow

Yellow

Black

Black

Black

12 V-G

12 V-G

12 V-G

GND

GND

GND

12 V-G1

12 V-G1

12 V-G1

GND

GND

GND

12 V-G2

12 V-G2

12 V-G2

GND

GND

GND

Verify that you can differentiate between the power cable that
connects to the PCI Express x16 card, and the power cable that
connects to the system board.

These two cables have different pin counts and different colors. The
PCI Express power cable has a 6-pin black connector, and the system
board power cable has a 4-pin white connector.

When power is present, never connect the PCI Express power cable
to the system board or the system board can be damaged.

For proper PCI card installation information, see PCI Express cards
on page 92.

     

CPU fan system board connector Pin Signal

1

2

3

4

5

GND

+12V

Tach 1

PWM

Tach 2

PCI, memory, and rear chassis fan power system board
connector

Pin Signal

1

2

3

4

Ground

+12V

Tach

PWM

AUX IN system board connector Pin Signal

1

2

3

AUX LEFT

AGND

AGND
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AUX IN system board connector Pin Signal

4 AUX RIGHT

Front USB system board 2x5 connector Pin Signal

1

2

3

4

5

6

7

8

9

10

+5V

+5V

USB6-

USB7-

USB6+

USB7+

GND

GND

Key (no pin)

Connector Present Detect

CAUTION:  The 2x5 system board connector can be mated to a wide 2x5 option cable connector or a narrow 1x5 option cable
connector.

To prevent damage to connectors, connect a narrow 1x5 option cable connector to pins 1,3,5, and 7 only of the 2x5 system
board connector. (Pin 9 is not keyed on the system board connector.)

P25 Internal USB, CPU heatsink power system board 1x5
connector

Pin Signal

1

2

3

4

5

+5V

USB3-

USB3+

GND

Key (no pin)

FDD system board connector Pin Signal Pin Signal

1

2

3

4

5

6

7

Ground

FLP_LOWDEN#

Key (no pin)

FLP_WDO

Key (no pin)

Unused

Ground

18

19

20

21

22

23

24

FLP_DIR#

Ground

FLP_STEP#

Ground

FLP_WDATA#

Ground

FLP_WRTEN#

ENWW Connector pin descriptions 163



FDD system board connector Pin Signal Pin Signal

8

9

10

11

12

13

14

15

16

17

FLP_INDEX#

Ground

FLP_MOTOR#

Ground

Unused

Ground

FLP_SEL_A#

Ground

Unused

Ground

25

26

27

28

29

30

31

32

33

34

Ground

FLP_TRACK#

Ground

FLP_WP#

Ground

FLP_RD_D#

Ground

FLP_HD_SEL#

Ground

FLP_DSKCHG#

MiniSAS 4i cable connector

Pin 1 Pin 2 Pin 3 Pin 4 Signal

A2 A2 A2 A2 Rx 0+

A3 A3 A3 A3 Rx 0–

N/C* A5 A5 A5 Rx 1+

N/C A6 A6 A6 Rx 1–

A8 A8 A8 A8 Sideband 7

A9 A9 A9 A9 Sideband 3

A10 A10 A10 A10 Sideband 4

A11 A11 A11 A11 Sideband 5

N/C N/C A13 A13 Rx 2+

N/C N/C A14 A14 Rx 2-

N/C N/C N/C A16 Rx 3+

N/C N/C N/C A17 Rx 3-

B2 B2 B2 B2 Tx 0+

B3 B3 B3 B3 Tx 0-

N/C B5 B5 B5 Tx 1+

N/C B6 B6 B6 Tx 1-
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MiniSAS 4i cable connector

B8 B8 B8 B8 Sideband 0

B9 B9 B9 B9 Sideband 1

B10 B10 B10 B10 Sideband 2

B11 B11 B11 B11 Sideband 6

N/C N/C B13 B13 Tx 2+

N/C N/C B14 B14 Tx 2-

N/C N/C N/C B16 Tx 3+

N/C N/C N/C B17 Tx 3-

A1, A4, A7, A12, A15, A18, B1, B4, B7, B12, B15, B18 SIG GND

* N/C = not connected

MiniSAS 4x cable connector

Pin 1 Pin 2 Pin 3 Pin 4 Signal

S1 S1 S1 S1 Rx 0+

S2 S2 S2 S2 Rx 0-

N/C S3 S3 S3 Rx 1+

N/C S4 S4 S4 Rx 1-

N/C N/C S5 S5 Rx 2+

N/C N/C S6 S6 Rx 2-

N/C N/C N/C S7 Rx 3+

N/C N/C N/C S8 Rx 3-

N/C N/C N/C S9 Tx 3-

N/C N/C N/C S10 Tx 3+

N/C N/C S11 S11 Tx 2-

N/C N/C S12 S12 Tx 2+

N/C S13 S13 S13 Tx 1-

N/C S14 S14 S14 Tx 1+

S15 S15 S15 S15 Tx 0-
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MiniSAS 4x cable connector

S16 S16 S16 S16 Tx 0+

G1 - G9 SIG GND

Housing CHASSIS GND

* N/C = not connected

eSATA cable connector

Name Type Description Cable Usage Backplane Usage

S1 GND 1st mate 2nd mate

S2 A+
Differential signal pair A

2nd mate 3rd mate

S3 A- 2nd mate 3rd mate

S4 GND 1st mate 2nd mate

S5 B-
Differential signal pair B

2nd mate 3rd mate

S6 B+ 2nd mate 3rd mate

S7 GND 1st mate 2nd mate
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B Appendix B—System board
designators

This appendix lists the system board designators for this system.

Designator Silk screen Component

MTG1-MTG10 N/A Mounting holes

E15 E15 Crisis recovery header/jumper

E49 E49 Clear password header/jumper

J20 J20 SLOT1 PCI PCI-32 33-MHz slot

J21 J21 SLOT7 PCI-X 133 PCI-X 133-MHz slot

J31 J31 SLOT3 PCIe x8(4) PCIe Express slot

J32 J32 SLOT4 PCIe2 x16(16,8) 75W + 75W PCIe2 Express slot

J33 J33SLOT5 PCIe x8(1), PCIe2 x8 PCIe Express slot

J34 J34 SLOT6 PCIe x8(4) PCIe Express slot

J41 J41 SLOT2 PCIe2 x16 75W + 75W PCIe2 Express slot

J68 J68 Stacked keyboard/mouse connector

J9 J9 Stacked RJ-45 / dual USB

J10 J10 Single rear USB

J11 J11 Stacked RJ-45 / dual USB

J12 J12 1394 Single rear 1394

J13 J13 FRONT 1394 Front 1394 header

J83 J83 Triple stacked audio jacks

J85 J85 Slot2 PCIe x16 retention clip

J86 J86 Slot4 PCIe x16 retention clip

SW50 SW50 CMOS Clear CMOS switch/push button

P1 P1 Power supply connector (24-pin)

P2 P2 Memory power connector (6-pin)

P3 P3 Processor power connector (8-pin)

P5 P5 Power button / HDD LED / Power LED / Hood
switch / Temperature header

P8 P8 PCI FAN PCI fan header

P10 P10 FDD Diskette drive connector
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Designator Silk screen Component

P11 P11 AUX IN Auxiliary audio connector

P12 P12 MCH fan header

P20 P20 IDE IDE connector

P23 P23 FRONT AUDIO Front panel audio header

P24 P24 Front panel USB header

P25 P25 Internal USB header

P29 P29 HDD LED connector

P53 P53 Serial port connector

P60-P63 SATA0 - SATA3 SATA Connectors

P66-P67 SATA4 - SATA5 SATA Connectors

P70 P70 Primary processor fan header

P71 P71 CPU1 FAN Second processor fan header

P80-P87 SAS0 - SAS7 SAS/SATA connectors

P124 P124 Hood lock header

P130 P130 PCI FAN System fan header

P131 P131 Memory fan header

XBT2 XBT2 BAT Battery socket

XMM1 – XMM8 XMM1 – XMM8

DIMM1 – DIMM8

Memory slots

U1 U1 Primary processor socket

U2 U2 Second processor socket

168 Appendix B   Appendix B—System board designators ENWW



C Appendix C—Routine care

General cleaning safety precautions
● Never use solvents or flammable solutions to clean the workstation.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

● Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

● Always disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the workstation case
● Follow the service consideration (Service considerations on page 48) presented before cleaning

the workstation.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

● After cleaning, always wipe the workstation with a clean, lint-free cloth.

● Occasionally, clean the air vents on the workstation. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.

● Follow the safety precautions presented in Service considerations on page 48 before cleaning the
keyboard.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.

CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.
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● Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not
to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
● Follow the safety precautions presented in Service considerations on page 48 before cleaning the

monitor.

● To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or
a clean cloth moistened with water.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.

Cleaning the mouse
1. Follow the safety precautions presented in Service considerations on page 48 before cleaning the

mouse.

2. Remove the mouse ball from the housing by removing the retaining plate.

3. Clean the mouse ball.

4. Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5. Reassemble the mouse.
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